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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.1

B x

1. EHl 6

1.1 #4174 @ AR A 3k o A -9-
12 #3% -13-
121 #ERER -13
122 g#hfex Wiz & -13
1.2.3 #3 DMX 1z 5 &, -13
124 #RITH -14
1.25 #HR+ 74+ At L # #(Touch Wing) -14
126 Le#R -14
1.3 m A% & 54 -15-
131 262 7%% -15
132 HhBEER TR/ MBEAAZLEFO ST IEREG D -16
1.3.3 T A 3% #(Tools menu) -18
1.3.4 P & (Visualiser) -19
1.35 #4in 4 (HUD) -19
1.3.6 4&+% & (Key profiles) -20
1.3.7 #F undo/ £ & redo -20
1.3.8 “ £’ 1 4 #24&(Macro) -20
139 R A HERXLRIELAL -21
1.4 2 BU/6% 5 b A -22-
1.4.1 & # 1% 5 (Autosave) -22
142 F #4515 -22
15 @2 USB K & -22-
151 FHAFRE B THEUSB AKX E -22
16 F=i=46 -23-
1.7 B 3% zx v $4F & “classic” B2 X, -23-

2. &3 (PATCHING)

2.1 4] #(Create) -24
2.1.1 7 & #4F4a(handles) - 24
2.1.2 B % AT (dimmer) -25
2.1.3 fed% ¥ A% 47 (moving light fixture) - 26
2.1.4 8 BT AL % (Visualiser) -27

2.2 4% (Edit) -27-
2.2.1 % ITE 89 DMX ik -27
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AVOLITES PEARL EXPERT TITAN V.5 ¥ U315 % % F# P.2
222 %R ALAR -27
223 2 AITELBEE -28
224 &%/ DMX A% -28
2.2.5 ¥ JT E EedE (Fixture Exchange) - 28
2.2.6 FHEIT B U % H & (Personalities) -29

2.3 X #1/#& ) (Copy / Move) -29 -
2.3.1 B %I/ e B dgdT B -29
2.3.2 4% A 5 %1 04 4T B e
2.3.3 M H AT R -30

2.4 ZHB/ER -30-
2.4.1 & pan F= tilt -30
2.4.2 & v& & PE(Invert attributes) -31
243 AT A A i(Freeze fixtures or attributes) -31
2.4.4 Y 5T BB A -31

3. A F T AR IT

31 4l# -32-
3.1.1 #HIFITH kI 4 -33
312 g FEIT L B -33
3.1.3 /A kit i%(clearing) -34
3.1.4 Ritists 2B -34
3.1.5 FlfndE 7 #(Touch Wing)i% & & 1+ - 34
316 M#ELFHERBNK - 36
3.1.7 A 3 43 % M ITHe &A% 47 (Channel) - 36
318 AKX LHFITE -37
319 NEM A\ R R ELFITL -38
3.1.10 & 4(1PCGBE S-FX) -38
3.1.11 47 B 28(Group) -38
3.1.12 7 B 5 F= k7 B 48 4 Ky (Fixture Layout) -39
3113 AL HFHFITEL - 40
3.1.14 3 % ##69 )7 B (Highlighting) -40
3.1.15 =t 547 A (Align) -41
3.1.16 #1% (Flip)sh 4 -4l
3.1.17 &7 #FF(Fan)#t X, -4

3.2 &A A4k M 4 fh -4 -
3.2.1 i i 4% % v (Channel Grid) - 42

3.3 HE®M -43 -
3.3.1 ‘ML Menu’ iz 4% -43
332 ARAXMITEITE - 43
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.3

4. & # (Palettes)

4.1 R ZEEHM -44 -
4.1.1 7%k B Ak B B B M - 44
412 HE—NEM - 44
4.1.3 x4t Z (Touch Wing) & ik £k & & # o % -45
4.1.4 % F EM LA - 46
46

4.2 ExE# (Playback) -47 -
4.2.1 AR —AEM A - 47
422 EMT - 48
423 BABFITE Tk 4 -48
424 % E EMBITE -48

4.3 R EM -48 -
431 BERBRBEMAE -48
432 HEEMNE - 438
433 A EKAEX EHEM - 49

4.4 5 H o EH _49-
4.4.1 8 H\I35hF M -49
4.4.2 WThEH -50

4.5 % B HM -50 -
451 & E EAMFE AR -50
452 ZEeEMiERITEE S -0
453 #H EMEE - 50

5. RE&R (Shapes)

51 4lzM EAR -51-
5.1.1 gl N BAREMK -o1
5.1.2 %A N ERREG K ik - 52
5.1.3 % % MNITREARBRRE TG #% - 52
5.1.4 432 1% & wk 44 2 R (Pixel mapper) -53

5.2 %N ERE -95-
521 HiFiEATTH AN ERE - 99
5.22 BB BHMA D ENG A EXR -9
5.2.3 &% M B AR T LR =99
5.2.4 MM KR kT B - 56
5.2.5 if 4 ) B R -56
5.2.6 MR B R -56

53 M E KR SHLTR - 56 -
5.3.1 HfAFix4l M B AR H TR Tk B - 56
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P4

5.4 1% % wk 4% 49 4] F (Pixel mapper) - 56 -
541 MALHE] R - 56
542 MALHED] R -59
543 EILITHA B -61
5.4.4 HAuA BRI A -64
5.4.5 © AR )T AL Ak - 65
546 {2/4 B E 6945 - 67
5.4.7 ‘Spawn’#= ‘Pre-Spool’ -70

6. %% (Cues)

6.1 lEH= -73-
6.1.1 &R mA -73
6.1.2 | &HF -73
6.1.3 “‘Quick Build’ Heit 2 5.3 & -74
614 S AREAREHTE -74
6.1.5 Z iz X (Blind mode) -74

6.2 xR -75-
6.2.1 HTP #= LTP & i& -75
6.2.2 & 33 & (Cue) -75
6.2.3 %R RN -75
6.2.4 BT P 69 E K -76

6.3 %% - 76 -
631 #XAFHEHF - 76
6.3.2 T yx 4 0kF PTiE A 69 FAM R - 176
6.3.3 & & &z 4% % (Cue) -77
6.3.4 #,4‘Include’ 7 ¢ - 77
6.3.5 1% M ‘OFF "zh ae 5 ik % W &1k - 78

6.4 54~ #sh ~ EEFM LT -79-
6.4.1 & #1/#%5h3% % (Cue)fit 54z & -79
6.4.2 Ml &3 7 (Cue) -79

6.5 X E &% 0 - 80 -
6.5.1 XEHZFENE B E &R -80
6.5.2 {4 i *T B2k 5 (fixture order) -81
6.5.3 HEHF B RN B - 82

6.6 &% -82 -
6.6.1 Bz @At (Release mask) -82
6.6.2 i dfEAFIEH N EARR T/ E - 82
6.6.3 % (Curve) -83
6.6.4 344 7 (Handle Paging) - 83
6.6.5 & 4k A (Priority) - 83
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.5

6.6.6 Z 3742 X (Blind mode) - 83
6.6.7 4% & (Key Profile) -83

7. #%T (Chases)

7.1 Rl EIT -84 -
7.1.1 %% — A% )T7(Chase) -84
7.1.2 Heig 3 3 ¥ 47 (Quick Build) -84

7.2 & #3247 (Playback) -84 -
721 BAT— A3 )TAE X -84
7.2.2 H3E— /3 rT A X426 -85
7.2.3 & B #ITAE X B Ao 2 L% K (Crossfade) - 86
724 Fohiz 5380742 X F ], - 86
725 5EBITRXEE T G - 87
7.2.6 s )TA2 X F B - 87

7.3 REEIEIT - 87 -
7.3.1 FEEHITRE - 87
7.3.2 /A ‘Unfold’ & 7+ % 4% — A~ %47 (Chase) - 87

74 B4~ #%3h ~ XFAM s dT - 88 -
7.4.1 8 %\#% 3% & % +7(Chase)fit 44L& - 88
7.4.2 M k¥ IT - 88
7.4.3 M T (Chase) * Mtk — A5 - 88

7.5 1% F #IT R A - 88 -
7.5.1 34769 % 4k (Global)i A B 4] - 88
7.5.2 14 2 3,47 (Chase) A £ 4~ 3% = (Cue) i 7] -89
7.5.3 & IHT N 693 F B PE FE K B B )] -90

7.6 &4k - 9] -
7.6.1 & 3 1% 493 % (Cue)ik & (Loop) & 3~/(Stop) 4% 1k -91
7.6.2 & 7 (Forwards)/ v # (backwards)/ & = (bounce)/{£ & (random) -91
7.6.3 ¥ % B % (Cue linking) -91
764 EXHEHRT -91

8. 3475 %] (Cue List)

8.1 4| &#EBITF 7 -92 -
8.1.1 %4347 % 2| (Cue List) -92
8.1.2 & ARIIT)F 7| N 63 & 4 R -93
8.1.3 4T 5 % M 89 A E 2 (Autoload) - 94
8.1.4 475 7| ¥+ & 41—/~ % (Macro) -95

8.2 W HLIT)F 7 -95-
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.6

8.2.1 E4T304T 5 7] -95
8.2.2 4,k i&AT 43R AT 7 - %
8.3 mEIBIT)F 7] -96 -
8.3.1 1% A ‘Unfold’ & 7+ — 384T )5 7] 4a 45 - 96
8.3.2 I ITHF PIH P &G B F -97
8.3.3 I BT 49 IT )T 7] -97
8.3.4 mEIIT 7 7| B B 12 & - 98
84 B4~ #BHh ~ XBFM R BITHF T - 98 -
8.4.1 B #|/#% #3047 K |(Cue List)f 512 & - 98
8.4.2 M 3% 47 5 %) (Cue List) - 98
8.4.3 M 38475 #|(Cue List) ¥ Mtk — 43 % - 98
8.5 & B ITF 7| i A -99 -
8.5.1 & E 34T 5 7] N B ) -99
852 Yrikf kit £ 3 -99
8.5.3 HLUT - F B PE B K B B ] - 100
8.5.4 T B & & ‘Overlap’ - 100
8.5.5 EATHL 4T 7| 556 4] £5 (timecode) -101
8.6 = %L - 101 -
8.6.1 # 74 % (Release mask) -102
8.6.2 H Nk i 42 X (Fader mode) - 102
8.6.3 AT &2 T 4l & - 102
8.6.4 HHEILT - 102
8.6.5 A #h# A\ (Autoload) -102
8.6.6 % i 3% (Macro Links) - 102
8.6.7 4% & (Key Profile) - 102
8.6.8 M & (Shape) R /i & - 103
8.6.9 & yz(Tracking) -103

9. 47 # (Running the show)

9.1 & 2dz % -104 -
9.1.1 ZpiE s LM -104
9.12 & HE - 104
9.1.3 #1454 X (Run mode) - 104
9.1.4 ‘Flash’f=‘swop’ iz 4 - 104
9.1.5 & 24k J A (priority) - 104
9.1.6 Z 34 X (Blind mode) - 104
9.1.7 % B 1A 1% A % % 34 (“busking™) -104

92 MBE R L TR IR - 105 -
9.2.1 & & %k ¥%(View) - 105
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.7

93 AL fEF SRl TILE - 105 -
9.3.1 1# A # ) 2 & ‘Move’ - 105

9.4 MIDI %% DMX iz 42 fiz % - 105 -
9.4.1 % 3%TA2 Ak &R - 105
9.4.2 % 5 inAEMR K - 106
9.4.3 23z MIDI Ak & - 107

10. sz ¥ % (Remote Control)

10.1 72 s 3gAzd= #l - 108 -
10.1.1 ML T - 108
1012 =&%&%E - 108

10.2 1% & A2 3% -109 -
10.2.1 ¥4 & - 109
1022 MMEB % - 110
1023 4B % - 110
10.2.4 B H#Hx% - 110

10.3 # = &M - 110 -

11. R P& e ik 5

11.1 %% % & T4 X % o (Workspace) -111 -
11.1.1 # 2 % ¥ T4 R % v (Workspace windows) -111
1112 $ IR G o gERHE - 111
1113 55 €T R G -111
11.1.4 ## T4 R % v % +H(Compatibility view) -112
1115 BB 42 T =5 - 112

11.2 4%1% & (Key Profile) -113 -
1121 gl Aafs 42 B - 113
1122 #iF4%E - 114
11.2.3 &30k 24284 & - 114

11.3 % % % #(System Menu) -115 -
11.3.1 %4 % %.(Avotalk) -115
11.3.2 F %% & (Network Setting) - 115
11.3.3 Al P % & (User Setting) - 115
11.3.4 4% & (Key Profile) - 115
11.3.5 & % 4742 4 (Wipe) - 115
11.3.6 & =& & (Display Setup) - 115

11.4 DMX %y & ) 45 - 116 -
11.4.1 %% DMX %y - 116
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.8

11.5 w4, (Curves) -116 -

12. Personality Builder ¥7 & 4 & % 3% & -119 -
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.9

1.

BEde

AEELS  EBIWR> EHEDMXEF4E > VDUs LB HH &R EHAML TG > 55—
HEEHE L@ > mB ARG R E T o

AFMIEMAHHER 32" (Tian) 4l 6 o oo REM ML 28" (classic)d9 %%k + 7 -
R 2k 2008/ » 2004/2000 4z 4l & - ff1 5 & e (Titan)i2F 2 %8 L H O TR o

EE AP TS RER L (Titan)B@4E A 44453 “2 827 (classic)iB1FE X » h 5%
% 17 v

1.1 #ZH A& @RfEE o A

* LU |
H“ J L BIRE ARRRNRRENE BARRRAANEE

A2 RAMAT ~ RERAPZXBMARF 2 X 45 il Fo 0k A 4

jL = ﬁ V—q/\jﬂi/ﬁ; E.

— ~ & 42 3 A (Master faders) 4z 4] & N4z 4] & 69 4 1 R F o

= ~ TR & A7 (Preset Faders) & 2.3 #] 3 38 18 % M 4T (dimmen)fe @54 T8 R 2 E o A T @6y 2
N AE R AR e R IT R - XA&H%@T%&%&%ﬁﬁ&WMQ%ﬁ
(A P =T fi& % 3% % Cue ~ 3847 Chases #= ¥ 47 5 %| Cue List 7 78 £)

= ~ 72 X AT (layback faders)Fe 42 X &1 7 & & (rollers)ik A P 547 ot S BFAZ X R T » F BT
ARME4 A Ll 5K L A AAEA I REFIFHEZK -

W ~ A2 X % H] A= 1% T 4 4% (Programming and setup controls) $ B e 4 N $ Ml 4 32 H & o
H Bk H A @ AR
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.10

B 4AT

RXBMAUAR

CER T T & 4 47 (Preset faders / handles)

: L

--------------------

ARG l

NI e

V;‘ & ng‘;‘éﬁ ‘ﬁ',“\ ¥ 3 S R /?\P'
AR B iz st A 3 oM F B3 BERR st
TR M AR4E  Foiz 4t ST R B M
T B 47 (Preset Faders)f 5o 4% 4| % i@ i@ % 4T (dimmer) e & 15 4T 89 6 2 5 o fAF T @89 2

N R A EERABITE o &N ftan é’]&%a’fi%ﬁ’ﬁ“Handle”(%#ﬁ)

1% X 4% 5% & % (Mode select keyswitch) 1% B 3= %] & 693 4E 42 X o Program(% #2) Rl 7 % 48 0%
42 X, > Run(E47) A A EATE B 42X > System( A L) A AR ERH & o

Z A2 X E TR B (Page select roller) ik Bl P #3342 X R E | » st AT AR M 442 L@
B X LA o

%1% it #F(Master faders)dz #| ANz 4 6 694 - B F LER K 0912 F -

#2 X & 743 47 (Playback faders)f= & 42 3% 42(flash buttons).& i& 17 /% iF Bt » Al 5k & 74 & %% 4847
A2 X, o

% % 7 #(Main display) Z 4| 669 “FEFLZ > L RBFEHL - DRI TEHEHGE
F PR o

1z %) 4% 45 (Control wheels) 7| 751% B JT B 6942 % 808 » % FAZ X 69@ F A= uf 1] o

¥ ¥ 4z 42(Menu softkeys)(1z = ¥ & A- G) Al A L FEH LN o &425 L L RBFEMNY

FER o BANRAEG LN FHEHGEDTMAE c ERFMREGFEUATIHETOHBAE R
4= : A[Edit Times] ©

$ 42 4% R (Numeric keypad)Fe 2t 3z Hl 4242 Al A NGB An L T 32 4] & 6932 4] o
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.11

® JT B &3 W (Fixture Page)iz 42 { A #2442 R L7 » A 4 T » A3~ B 447 (Preset Faders) ) i
# o

® i &4 4 442(Command buttons) Al AMATH 6L » Bk GRX - R H o RERGEFF -
Lixsbipidik B L LED #7474 % o

® ITH B M 4542 (Attribute select buttons) A A AF AT L) B (Bl & ~ BE ~ KT~ A
%) > JR1% 38 1L 3z 4 4% 45 (Control wheels) 1z %] o 3242 18 TIT AR AR TR B 51 o |RIK
Togiredei » ZITANBAANTEECL ERA o

® iAEHEEMAMEARMETREREFBRERR -

Ak 4 & touch wing

MIDI 4z % MIDI 45 5 R A Sk 46 O ‘
Wrgw GREE A PN o x UsBign  FHEAISD

(k&)

DMX 12 5 iy 46 v 1.44MB 9 2 & VDU 8 &

% TR
USB fi & 46 0 =+ % REEE
TEES kA VDU 3 o
(&)
@iy LedEa

FiAEERTEENRAORKE - FFHLEE -

Panel Reset Swith(Z B iz 6 4%48) : EH B HEELE X @k » DMX M miZ i g o
2B #m o
USB reserve and switches(USB f &4 0 fe A X) : o RH 2z S AL R X A B » E 54 H
2| Avolites /% i 1R & & ] % 4.“ShowSafe” o
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.12

A& 4% & (Touch Wing)

IR AR 4

$EIHRE D

& A2 X R

IHERRAG XA
R f

IR G Ot

Macro 7 ¥z 4% IHREe RN E Bt B

VY1 g

AR AL T BRI 0 B AR B P — MRAIR B - RS BAITR G T
ZEE TR

® MPAIZIFRANIMRED - AP TRGHERT G ANEEREGAEFH LG > FET
AT ER X LG o K E o

fRiR A M it AT AR TR G e REREH o

I de R ok — LB e bzt » L RAT oAb EAMBERER -
EANBMEAAERRE/ R EEEFRME -

BHILITH LT aibies Bl  mBELETHLIAZTREEERMA -

B RORFERT SHEXMA RGOSR FH -
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.13

1.2 #%3#

1.2.1 H3E B
AP TG iie s s+ 756 H 455 &R~ 80V-260V & /% o

KA1 BB ET — & R A B &% UPS(uninterruptible power supply) » B 4o F iz # & 2 KB d, » T
fba & RE ﬁ B A REERNTREAE TR AN &3 R - UPS KR A P 65 H 3K
"J‘E‘ﬁ"j;r_a ’ }ﬂFHT]Eﬂ_\E %Jﬂj;r_a °

1.2.2 H3diR
Bk E R I E4T Windows 694RE A4 > BTVUAR P LMK EC RIEHAT R X H > &R X H
HE®R o
z izb#; (Start up) » J}s‘c’Fﬁﬂ%iﬁééﬁ]‘@Eﬂ\%ﬂ?%%  BEEL TR TREERESAGES
BEERERAL 0 REHANBEEE T o

% A4z & (Shutdown) » & THhBHIEZEEMN B AL WRA X c BH EBXERITEIMNT I - FHERLR
BARITTRR(BH ) REATREEHLBORLR -

o RIFE TRIEF XA > TIRARN @ADL CRA XS4 BHXES
AR A RABAESKOMELREFXRXAES > BAZXRZEHG XTI o

1.2.3 # XK DMX 1z 5 4
Bt R 6180 DMX512 2% > 4246 B+ 4 A~ DMX512 #ir sk v T A3 E 4T R R &R F A
JT9 32 7 24 &3 e 5] 12 A~ DMX512 4y 3t v » 47T 2 04 K W 2 £ 2 A K W 4 2L 3% 2 42 69 DMX
= %) & 4u/= Avolites DMX(ACDI) 4\~ A 4. i& 4% visualiser o
B HREH A%@ADMka%ﬁnoﬁm&hﬂﬁ’ﬁMk FHRIEMT— Nk o o 254
doRFEd A>B2Co D laFr e —hEieaaBHEehaRENTOLE W RAPAEEHE
v XA 0 REEE T KNE DMX 4t (55 11 17)

ANDMX 1z 5 mBdEH A @R 5 S FREIXLR)EHE - 25X EHELZXMHY

4 By DMX 3 5 %
#

+

a
<fu

&R
ZR

ga|lbh|lw [Nk
NG
b
<o

HUDMXB12 Ml o EE TITEZ AR A RBOITELRZEK — (1200 &k i 2 F» 34 W)
Rk o A P RTIed 8 DMX512 # b w4 5 8% 7 X, (Y-splits) & A » B 4 i 7T A 54, DMX 84 %t
I o
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124 BRI T E
W T4 464 @R VGA %54 VDU 37 % o

sh3: VDU &7 % ﬁu%&fﬂu&%%“disabled" s 5 b0 3] A 4ot X[System mode] » H ik F B %
i [Display Setup] » SR 1% 4% 4 4R § 1% 2 [External Display Disconnected]## 1k [External Display
Disconnected]# » #M4& VDU B = £ 4 E B L% #1% o

® IEVDU BB R B E G “disabled” » 53 5] £ 442 X [System mode] » i3 8
TR E [Dlsplay Setup] » 7*?&#%9]\*&]35_%‘ T [External Display Dlsconnected]@‘ﬁ1}\[External
Display Disconnected]# » #M4% VDU E =~ & 2@ & E¥ #1% o

@ WwRETLIXMANILITMHEXRE  AFLA®R S%Tﬁ;li “Tools” 4% “Control Panel” ~
“External Monitor” X4 ##FICH A P o9 VDU L 1 3 %50 69 AT E o

FEH— LR ENSEE BT o CEREH®RE ﬂ)b(; 5] 11.15 ) o

125 BB+ R4z 6+ A awdt € 7 3% (Touch Wing)
EW %k EmRSE 5 USBAM&EoicE » A 94t DVI 4 v A k& & Ax42 Z (Touch Wing) -

1.2.6 £E#&K
e RAAXHRE > AP AREREG B LA QS 5B > BT A Jess B4 A 0 Rk
#EESRDMMEZE LR o

4324 MIDI 3 > T A 2553535 6 MIDI B 18] 25 ;R 64 B 18] 25 4% 4] 2 408 3 o

R P T vA4E A 32 6 69 RI4A5 46 o 15 42 3] LAN & 3k M (local area network) » =T{¢ A P &1y % # 2] 7
—6REREHEI AN DMX AKXR AL o

BFEthAIRAE—AN34 XLRIEE TiERE 12V 4T o
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1.3 &R 5H

131 £#637%%
LRpPFEHETUNALANEFIEG L 5 L EMFEZHGTIR -

NELCD =%

1’;;; ’é\ E‘ U e - ES
Fayback Option

Set Legend

..FL FL FL FL

b7 BB MR R

=
c
a
=2
E
2
=
=)
o

olour Func Colour
A fe B i i sh it Bt

GODDK Filt.

Orange

%Ay 6y iF B R A ERIER A
P he 4t % % (Menu softkeys) 2 LCD & =& A& » 7|8 T A-GREARESE > ﬁﬂ%I At R %
—NBREIT o Ti¥E % L — R [Previous]#= F —H[Next]iz4e & & & % sh 4 5 3
% AT ¥ # % #(Current menu name)&yb“%%?&é—iii%ﬁ#f T C R TS RAPANBREEEN A
P T(MLMenu) ¥ £de4t “41” TEMMEEL > IHBRFLTHERBECT o
A fu B 5% 36 7 58 & £ (Wheel A/B attributes) £ 2 T A 69 R4 L » L R4 XAk > o RITR %
BETEBM » FATL R B METIE 4] » ”‘"\‘»"ﬁﬂ?"a FABITEANRERNE - W R A —
% yAFE(chase)d » A XBRFEZELILTARXE

)T BB M 5% B (Fixture intensities) & R iEAF o B IRE o — N2 B — N ABIEIT L6
Ao wRITERBRELITOETHK SHREETFLSUABSREERFL'E =

12 &% v (Information window) 2 2 L A& % L7 > LA XD RHAFE L o

DR EATEETAZLEBREAREE =

bt WAL EYES TV LR Gt
BERPATERGTH BL—ANBANTERE kB —AHEL BT A A B AL F
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132 S ES TR/ BEIRFLEEFNS ETMHRE D
TR ITRA  FHFEAFEAMELRA TR E 2 o

4%l E F AR

LB narimedie Coor DShee

ity G elbey

Telien 1. M

SRANFOTAERELARE S B G0 2x24 > 2R AP EE— AL ROWE -
TA—ANBORKREE s LTARKR S AEARB, o« 2T G E OB A0 LT
BhfomiEd o o Tl FTEL K| F/ILE o

WAL —EHIRT EEF 7 R & H v R+ FRE TR+
—EIHRGOARBRERGS  SHEBBLAEAREMORET L g DR ER
Ao E LATHELT o

IR E vgFR i

1% A 72 AR % % 69 % 3% [Open Workspace Window|45 4 > A mE IR F 2 T4kt o

7 “view menu” L B % # + A [Window Options| % 05454 A P TAK T G OfL e K] o fik
BEELRZEHEE > [MIN or MAX|Z #7535 Ao 2t R A 6w 52— K] » [Size and
Position] 72 7T 48 8912 B 4 #% 50 % 2 » [Select Window]JA % 0 % £ b b F A& 5 v » i
MBEIAZLALIERCHEAXRET OIS
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BoTAMBERNELRELRES > £4 65T 0 %R [Window Options] & # 75 7 & @
[Move Screen] > 4% ﬁ#ﬂ;é; 4 IAVO|d4a R g i 2
L Size/Position iz 4E o

R VDU 7% 0 AR fikdedn > TR R A4 & A6
BoRHIEA o

BENRERAFI-FIQ)AARBERSH IR E 25 (K
5 11.1.2 ) o

% 1 3% 42(Window shortcuts)

Hem A [View] > 26 A n B led &5k » B TA
LA M AFBAEIHT T o e

% [View] & # 45z [Patch] » 72 DMX % H & o o il
P [View| K% 4% £ 5% Cue L &3z 1B Cue 5 2 © Narrow Columns
1 [View] X # 4% [Macro] » #+ 2 (Macro)Z & 2 o
IR % 2% & (Workspace window options)
BIAAEHREFARNALE fx—THo A LA E[ild4 AP TRERERIFOR] o

& (<)

fit 7+ 5 ﬁlﬂ"ﬁ & % v (Saving workspaces)

AP Tiemit Lot R rBE NG TR TR G 0k G0 5240426 T & #fE47(Preset Faders)
T oG R e izia it Ao mkdide4a o 38 d & A [View] » K 1 4% T [Record Workspace] » & 1% Jil
FREIGREAREZE T AEédkekia RENIGRAARBBE—Mesaa LI 7 o

IHREHREET
IR FEAe ket F(HE 111 7)
e i% 12 & (Quick record)

28(Groups) > L4k [X (Workspaces) > % zt(Playbacks)#= FT & % #f (Palette) & & #f
APRRIEERDRE cRXBER P BICEMAE  RE—REMRA AHlzda o xamd
TR EPIRE > BT UM AN - AR A FH RARIBEAZ 205 5 R
E e}

e 3% 12 5k (Quick record) =T 1% F 4£1% & (Key profiles) 2t 7 tb.oh 48 (4 1 11.2.1 F7)
4r % #= B } 4 % (Legends and picture legends)

BT R RRAR A 4 AT T AR B L AR R RBE P Rl REEMBPE LT AR4E LS
H AR 12 o 15 3z [Set Legend]ixﬁéﬁﬁ » R E R B AR 0 BFXES
[Picture] § /4 » — N2 EH BT ANRIBELAR o
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R A A Tkt TRA > T AT AL & o A G
e R — R (2T ARG ALT o

A4 4 & b 69 & K (Max)/ 5 ) (Min) 3542 =] 20 K A= 4 <) Ak 4t

6 7 B

BRED T X4 XM AREEHE Urp Lo | depm Uep e
1% A %i}J(Man ) B #(Auto)dz 42 » T A4 €l T AR B e BRe _ 11s e

FHE| 2 a R XA HAAENET M4 209 AREAE T 2T R

—WERRF R 6% o S
HEZK XHARSR

1.3.3 T B ¥ ¥ (Tools menu)

F2 B % 3% Ak 4% E (Touch Wing) £ L /4 69 T B % % (Tools)i% & — &% o i
fe o Al do il BT (B30 A £ ) 0 42 4 @ AR (S22 AR AF) o 48k R E 3 0 e
B #hIz G m R RBATHAMAR)T o

E\Q Control Panel
About 32 4 & 8 B 8013 A A o _
Help iﬁ?jﬁbfi}'ﬂ %—ﬂﬂ‘ o _J Folders

Control Panel 4T F % #> T B A L7 Bk BAnt R4t 669 USB i oy =oim
A4z R xﬁl#}iéﬁﬁf’*%é}a LIT AL NG ORAA H S [E) sdavonaerograns
BRG RBRAF A ABRE o
Folders & 152X, & #7 U4 B 69 32 1E 304 - Al nestart sottware
Switch Task 7% a7 @ 692 /5 & @ 4= Ak & Z (Touch Wing) 5 9148 & = & & T .
IAER O 6g4e B o 3 & R AR A £ 69 (33 b # 1 X Switch
screen) B A% 7T 47 % 3 sk Sh 30 B R it AR Ao AR AR B 69 TAE & v o (-3 Centre) B 47 7T 42
waB AL E > (XM Close) iz £ TAFRw a o

. ‘:P NN * 5|
b Yo Centre  Close

Switch screen \

—

I,__ Switch Task

m Additional Programs |, rp Expert VDU

IP Pearl Fepert Pansl Server .1 Feta 11 12| [ 0
e Switch SnHwars

G_ Restart Software
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Additional Programs < vAi5 4T — S Wi42 5 » A BhIEAE A A B4 R R B PR E o

Switch Software %32 2%, “Titan” Fe 42 # 2 4 “Classic” 8 Z % o

Restart & Shutdown Software €3 2 #hfe x Ml R 32/I2 G A4 > BF R 2R EH AL AER
AR o

1.3.4 T HAEL B Visualiser

‘WisA AT

B zrERAE T (Visualiser)dT R I B » 5% A 3 RIT BB TAEBUIT B iE E AR # TR T %
BRAPEEE -

(Visualiser) }T #4231 & & -7 74 (Touch Wing) a2  fe b3 B = fF L6 T/ER & © A o (Window
Options) % 7 %7 » At (Move Screen)#% zh & @ £ L ft » TlITHAEN R AMBBER EIEL
TR E A

e & (Visualiser) T 242 4L 2 #4242 72 (Touch Wing)fg L E & F A 42 R 3% » XA B L TR AL L
A ERERFa Lo

@ (Visualiser){# F 480 R 6145 & X F M A » 15 % F(Visualiser) &g 5 #t -

Auto Patch B #4822 3 ¢

& #(Visualiser) T XM B hit » BB L AR LTI ANESCERBGITL - BN E S
VA [ 52 6 HE 7| ﬁﬁiﬁkﬁﬂ—ﬁi@ | TR GO A o 2B (Mode) XA “run” A PAZT 4z 4142
PERGITEA#ITHRAR o

Fixture selection 1% 4% 7 B
AL RERBRNEATE2AEEIRILT -

1.3.5 #4474 (HUD)
HUD)ALE S~ TARFEG LENEFIix400 FH o 645 cues 3% = ~ Chases ¥ /T ~ Fixtures
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1# % ¥7 ~ Dimmers % 3.7 ~ Palettes % #f #= Fixture Groups *T L 202 & o 4% /| legends 154
BT LR LR o

HUDAHF#A—AITHRE 2 » % T “View’ #4tiki% % #[Open Workspace Window] » & %
FEMEUD) AR T T o

Z(HUD) LR % o i Fixtures 4 < T 2 AR E &2 E B 70 4o R 0T B A& B A2 ok 2 P B 2005%
% & %5 o (HUD)T/E X % o 1472 (Touch Wing) g4 £ & % -

G

1.3.6 4£1% & (Key profiles)
LnERBEECE TR EHEIL AN ORIZED G > LE R KBEGIEAE o A P & 7T & (Touch Wing) ik
BE L RE—waEinad o A P Ti% B (Key profiles)421% B 4 2645 1 B 69 A P 3 v 38 5V 42 4
GO ERE o RHEANE 11.2 F)

1.3.7 #E undo/Z # redo

B P ST VAR Ao AR AE 5 35 20 /S 0 3242 AVO 1242 A4 542 8 T 5 & & £ 4 3~ (undo) %,
& 47 3k (redo) iz 4 o

1.3.8 £’ % #24%(Macro)

SITRARANERZER T SR ZE AP TILEFI At — Nzl X
2 s 5t (Macro)' 2T 4 A2 42

1> 45T 342 Macro(f2 A3 F42 %) o

2> 1%z T [Record] -

3> fx= B ik Flash &kiedd » FHIA4 > Rixda e TR IR F NG o
4> # TR P B EeFedesdF o -

5> 3% T Macro I 342 % k4l o

T & &) Flash 3242 & 00 P & 4169 Macro‘ £ )5 9|48 (F 7| W iz4E 5342 2 A R &K 3E R
Bt A]) o

% 3 B 4¢ A (Touch Wing) Ak Z it » Macro‘ £ 154 T &3 Ld@ey 10 MF A x4 » & T4
IR AT &L Macro' % ik 454k o AR 10 MEBHARSAERT IR LT
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1.3.9 4 & g4t

BHEO TS hie TAI4EE LoagkiEsizs o XL kyE4E L1 A Titan Mobile = Titan
Simulator = %] & 2L E 8455 A A o

F1 #% o 5] Kb Ctrl X FTLF

F2 BiEE Ctrl C #NLF

F3 AL/ RRME 7 CtrlV AW L F

Shift F3 T—A%w CtrlA BEA LT

F4 P AVECA Ctrl Z £ /% Undo

Shift F4 GAZEI R CtrlY % # Redo

F5 *HAEG 2 Alt C 74 Clear

Shift F5 XHPTA G AltR e ES 2

F6 FTAEKE AltA W1 # AVO (shift) 3 %
F7 ARG 2 AltL ¥T B % 4% Locate

F8 FTAAE o Alt P B 4T Patch

F9 THAREEME Alt ™D fis il LR FE S
F10 TALEEMEG 2 At S LW N

F11 HTTHAEE/EAEMNE O AltV Open/view ¥ %

F12 T E B & Alt G Go

Esc B2 AltD #l % Delete

Enter EIDN Alt 1t C # N Copy

Alt1 =& ReAE A Alt M #% 3 Move

Alt 2 =6 ks B Alt U # 7 Unfold

Alt 3 zE a4t C Alt 1 4% Include

Alt 4 EEHA4E D Alt ™R 7% Release

Alt5 2 & rest E Alt S M E 2R Shape

Alt 6 z & Eest F At T JTETZE /ML Menu
Alt7 BE&At G Alt B Z 3 Blind

Alt T F STRE o AltO Off

Alt T P wHME T AltF Fan

Alt ™M E@ua Alt1 O FMEE

Alt T G WE Alt T L C A

/ (num) Thro % Alt Al — /4T A Previous
* (num) @ Alt — #% — A7 A Next

- (num) Not %74 Alt 1 T ST A All

+ (num) And #» Alt | JTHE % % 2+~ Highlight

® 1t ArEZdx(E4E4 £ &y Shift dxzst
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.22
1.4 :B/AEEE L TH

P =T SR L6038k P06 5 B1 USB iededb 84z 6 A B » 4 R42 6 0 H B AR A 8

E& & R Titan 3284 R AT RA QK B TR Ak A Titan 232 A RS 4 TRz A o

1.4.1 A % fi% 5 (Autosave)
Titan £ RFLALF 30 083 F ARG EETHIAFREE > RS dRE AN RE T4
A2 o
R P eI AT R S ts 2 B S AR A B IA) o 72 R % 3% 7 D[Auto Save] » 3z HRB4E A LR B H AT A
RBGHRE » I B R TRGAIENE o KIMNBNBAEREN B BHREDEGE » FHiEE R
b E A E E A RAZ G R 0 127 0 X B B 4F B 42 Auto Save 13 7 0 [/ A € RGBT A
LSRBEHNERETRRYIF -
1.4.2 F a3t A58
R P T e fEATut B4 Rl e L AR RF L AR E RS R
1> 3T E#E42ULAE T A Disk) o
2> 1z T [Save Show] -
3> e R AL USB 12 5424 » de 242 64F “Removable
Disk” # AR ERE o
4> R (b sfrar|EEcaREL) -
5> 3% T [Enter] s [save] (/% &} T4 5 ) o
6> iz T [Exit] & [OK] & FF -
RPTEREREMEEREGEE TH -
15 ZpEERHEUSBAXE
HHETHEAEBNNERE  TNEHE R THBI SN USB Bt » A A — 46 T EF
B TR B ER GRIUE R TA e TR AFAL—THRL -
RAPARTUMERAEREEORELIAG LT RAR  RBFERABRATREFEN > L THRE o

¥ My Computer

1.51 & RAEEFEHEFHEIUSBAEE

1 A% Windows 2 &g £ #1 % & %4 5 O
USB 7 fif 8 1+ it § o v 8e

#  Files Stored on This Computer

/J Shared Documents ,J Adminisirator's Documents

Hard Disk Drives

System Tasks kS

1> AT EE2 L 2524 o
2> W #“Local Disk(C:) ” - :
3> ]l.i‘—“PrOgram Fi]es”iﬁ'—% o Other Places \;‘ Local Disk {C:) Lg

S My Network Places
() My Documents Devices with Removable Storage

4> 33 & “Avolites” SUHF & » AR 1% & “Titan” [ 5 swevom

O Control Penel H 4 Floppy (42) :L) DVDJCD-R Drive (D:)
I s FH“ShowData” U4 o -

Details

My Computer
System Falder
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1.6

5>VDU £ =R & 2T ORGGEE IHFHI L -
6> RHEE TR LEBBARZENGE R wRXRAPBERN S AN 242 LR IR/E Ctrl 42 »
Rtz —TEE X -

7> R I A4S g 0 RN X E F %35 Send to” o
%358 B USB 5k B AT 4T &1 AR AEG IR B U5 B 4 o
9> FRatdeig B X% %% CD-R > R % %% USB A fif &4+ L o

\

FEESE
L

LREEBH—AHEREBITRAE RINBNFEZEHNG T A RAERRIZEITEM S, » F5
TR RAPHRARNEKLE o

1> 3T EE42ULAE T A Disk) o
2> # TF[New Show] o

3> 3 T [OK]# A ©

4> T [Exit] & FF o

@ LI A — A ik iR Je sl 2 4% 3] [System] » %Efi:}g} H&J}%é}% E [Wipe] o 7 “classic” £ # A 4,
[System|] A A8 F] 6945 & Fn dz 4 47 L [Wipelid = 2 f

1.7 M2 2% 2w B4E & G “classic”#E X,

Bkt w4264 B A AE 4 %(Titan)“ & 327 f= (classic)“ 2 #1742 X, » & F# 4% 99 [tools menu] T £
% % M 69 [Switch Software| # 4 £ 44 » HEE R EHBFH BT FERK o

{) Help

k._% Control Pancl

_;__.II’I Folders
ilads Tenk

(Titan)“ % 32" fa(classic)“ £ s B 1F 42 X, E S
09 5% P e bt \E Additional Programs

.H Switch Sofhware

W

P ncstart Sottwarc

W

Shutdown Software I
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2. & B (PATCHING)

AFEOLS REFTAN -BRELEERIT - KREREITE L DMX 33k ~ MR LB EITE -
fe B & o

REIBRFTAP ERETHLES:
CREBMTBREVGITEEE

® JTHE FAiHpe) DMX Huhk
0 HHREINMEADMXAEE KEeaFREL4E5MBEE 2T KRBT 12 54%
® hiFAE P|IANANTRRIETF EAEA

BER P AR AAL T B0 DMX 363k - {2 P AYs £ 3B E 5426 L o A e AT
£ DMX ¥k » EIT R 526 R EEH o

B AP E B R BITE DMX 3uik 5354 & 69 Mok AR I & o
B RART L& R BT R A TIEAF o

2.1 4|7 (Create)

2.1.1 7 E‘ ’ﬁi *fﬁ (handles) handliﬁsﬁ;fj:;#faders)
AT M B KT R AT > F BT B AT K f
(Touch Wing)f 4% # 454 L o o d
MERFFRbE 6= AR ATREE  SAREAE: | it bbb saba
. ﬁwﬁwmm#uﬁ@h%+h&%% TRE | sl Libdali il

& Fek4MRBEIE

® k& in4t k44 G o k3% (Palettes) % At ~ (Groups) }T B 40
o Z-FP 45 B S e

1 F Aoz 4n — 2 448 4 (handles) T B 4745 o

(handles) 7 & I AF49 A 4 T o #1 T #4% pages of fixture 12 743 N Ffi42 & L7 » A P T4E4T 0

B #4780 T o“0--" A & 1-60 1 B #4450 “1--" T X & 101-160 7 & 4 47450 “2--" T X & 201-260

EEAHA 0 “3--" T K & 301-360 7l B i 4F4A o

*mmmm

e v |

. ““]llllllllilIlllllllllllllllllll

v, ummummm

il IIIIIIIIIIIIIIIIIIIII

AWT memrantamenn

T S

%1 T ¥ 4% pages of fixture
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7 (Touch Wing) £ Z A P =T Be 4% 47 £ 2| (Fixtures) T/F R & & o

4o R (Fixtures) T/f X & v & & &~ » 1% #%[View] > [Open Workspace Window] - [Fixtures] 7+ 5 %
T » 3 (Touch Wing)#xi2 € I ¢ [Fixtures]iz4Z o

(Fixtures) T/F R & v A flkdit 4z B = & T 6947

B AP T AESHERER ARG R @I |
B o B 3441 35 [Pages Show/Hide] 5 < /12 7, [N b B 47
MABX A LB RERAEET @G &8N | - - .
B AP THRBERAZERRNGITALT @ o i i e —— e

14

'z & : (Fixtures) T/ X % 2 & (handles)T & ' ' ' Dim
HeAFARITER TR » haEiz A & | N _ —
EZHABIAER » IAAEAREE R
18 R 6 15/ & T B AR 4% B B gt
B EEEAA S 1114 5 o

% #h % scroll bar

2 & ST R 6 W AE R K AT R E AT R A“Groups” > X AEAEF ARSI AP 2% &FE AL
A FOITER » RROGBRESANS °

2.1.2 Eei% % M IT(dimmer)
FAARBETREGE —NMEF L

1> 4% T [Patch] i 3 4% /X 1% 3% [Dimmers]

2> eik42 AlLine=] 2= A F TH 12 % DMX &% 645 > 40 248 & BB [A| R B — /N7
895 75 (1-12) & 2L 4% » [Address=xx| £ 7 Bp 14 2 f7 B 4% 69 DMX #udk o £ B FAE H4E Mt
3 T [Enter] 4% -

3> fuiE ¥ — % A AT(dimmer) > 4% % & 7 & 4242 (Preset buttom) &, (Fixtures) T/ X 4 @ R 69T &
AR i 4t o o BtdE % N(dimmer) > & F — > EeiE Bz {E (Preset) 5 & 71 B 342 » ¥R K
e 3% (dimmer) 5t B 2K % 42 T (Preset) I & 7 & 4% 4% > /£ (Touch Wing) A& & Jl P 69 F 45 7% & A
A4 AT B & 1% BodE(dimmer) e B R & F 45 B o VM fe B 69 % AIT(dimmer)DMX 353k
$ B Be b o

4> ik T 47T Bty (Preset) i & 7 & 3242 £ 6 LED 4T &4 # & o (Touch Wing)fk#: Z I ¢4
(Fixtures) TAER & 0 N 694T At et A Tk e L RITE L AR o

5> # 8 ¥ I 2 > BiE LA F MIT(dimmer) R 4% [EXIT] 4 £ -

® L% F DMX sbxbit{E Fl Hedk 4 Bo A P T% & DMX % (universe)#i A {line}.{DMX} » 4] 4=
N 2.56 AR AR BITEA 2 2% 56 DMX 3k | o
27 /% DMX i# i 69 Bt d% > %[ View|dz4Z & & [Fixture Patch] - 15 & 2.2.3 7
[User Number = xx|& & — /™ 7 € L8 % 5 A & AN(dimmer) F 347 3 (fixture) @, 4 4% K
FT oo AR B BRI E A o Bl P T A% 4R P % 5 4= (Repatch Fixture) X 4 o

® A pta% BiE % % (dimmer)F )T 2] — /~(handles) T & 44749 £ » Xy R A A 45 5| £ A
PRE—EES S L AR @A AT o B4R Z a0 RE B 9 (dimmer) 7 2
JTEE » dz T A8 Bl 69 Be 3% 5 dw4d » 4o RZA i N DMX 363k Fe 3 0 DMX 3b3bi% 8 5538 e 1 o
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.26

2.1.3 #e 4% ¥ A% XT(moving light fixture)

Bt 3% 4% sk ¥, /1% 4T (moving light fixture)1% & kb % 4T (dimmer)'i o RARMNAES0ENER
B o Bl KF s EAAREF > mEFAITRA R KRB EGEEIH o

%2k 17 6 1% Fl “personality” )T L B M XM A AR HIIT R R & » REITEBHEH& > AP A
ﬁ’—ﬂ%&“*ﬁﬁiﬂ'}f’“?‘* s CAS B BRI R G ASBIITR o

& RA K S XM 6)3% % Ak kT personality” B M X » BEREXHEHES CAMTEBET
)ﬂ ' AR e AT R Al o e RIFEE RNEA AP FRGITEBMEITAH o R P 7T L Avolites ] 55 T
BRI % Avolites Fo &SR ILH Z —NEB WXL A P o STEBE X F @it E 4] 12 % -

B 3% 3% Sk A ST A T IR

1> ;};_—F[Patch] Ea}%% ° Furolites Pear Expert

2> jg‘e __F [Fixtures] .H&%% 3 Select Finture kanufacturer

3> BHITEMNERF £ G zaddAfemFt] Ak
RIERDRAEEMNFEROLF IR -

4> HAFIT A5 (F £ G 248 MIT LF £ > A% A Heik i
RARAEL AT ER S FK

5> HAFHIT LB XM Pt st o

6> it B LN ARE R LT EO DMX He3k ok XA P A8
B2 AREWHE af DMX Hit > 24 AIDMX
line=xx|] /Al 4& & #r A\ 37 64 31 8 v 45> 3 Bladdress] % 37
8 % F DMX #u ik o 3% I [DMX line=xx] & & # A
[line].[address] » #] 4ot N 2.45 RAZREH 2 o 45
DMX M3k o

7> ¥k &7 B #5242 (Preset buttons) & (Fixtures) T/f X % 0
MG 4T B AR AT o

8> BeiE T 4T A 69 (Preset) ik & 71 & 4242 £ 69 LED T & H #&
7 o (Touch Wing)fiz 4% # F ¢ (Fixtures) T/F X & o A & 4T
AmpfEig et e LRI L LR -

9> FEVHTRZELSAMELAGITEL » JTHL DMX 3k 4
Ash > 7R AP REAEITERE € R Fixa -
o R A F fe g 47 £ 7z [EXIT] 4

Fizture Manufacturar

Selact

z
5
'
.
B
=
=
m
o

® NP hikibBuiE % BN Rl 4Rk wARST 0 Bodkh— AT
efz(Preset) i & 424t » RA BB RERBITLE
1% B ¥ T (Preset) I &, 711 & 454 » JTE & AATHED| B3 »
5 (dimmer) % #L47T B 48 B o
R P Ref BAkAE A 69 (handle) Tl B 344 £ o Bods 5] — B 42 Sk AR AT o
Yo R A P OB 69 4% Sk W A KT R S 38 R AR R — AN Rk 69 38 38 (5] 4= VLE) Rl P T B dE R R E
E 3| Fl—/~(handle) B4 L kA PREE Hda%] » IR ZAMBHOFALEH@RER) ©

® [Options]-[Preset Palettes]| 7l & % At % % & 4 “Enabled” it 2 % AS| Z R ENT L EM A &
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.27

(colour) » & % (gobo)F= 1% & (position) 5 % - 4 2 #|(handle) 7 & 34+ 1-30 £ > 4ok & 4
“Disabled” & & # e 47 L M 4| &

® [Options]-[Auto Groups] & # &% 20 % 1% & % “Enabled” it & & 4T L 0t & %K1\ A h 6| 2Z T A F
— XA YT A > 4% T 4 “Disabled” 1 B e JT LA 04| 2 o

1% View 1% 4% /X 1% % |[Fixture Patch] 7T & & 4T & DMX 33k » 44 2.2.3 ¥
WwREFITEABRIHEGI)ERE  FE2AHRET M E ok -

2.1.4 B 3h B IT AP S (Visualiser)

4o f B P RIS B FHIT XA Z (Visualiser) » 32 T [View]> [Open Workspace

window]=> [Visualiser| 7/ 2 & 1 o }T &4 3L £ (Visualiser)d o & 8 shfie L S Bz e BT B o A
P ¥ 2% (Visualiser) & 0 X /s » 4o A 3 3 (Touch Wing) Ak 4% & » {# | [View]|> [Window Options]
T vAje(Visualiser) % v £ B =i Skt L X A A5 o

46 LigiT B A A # & E(Visualiser)d 0 AR T 47 F X EF 2 STERAE BT 5 9 Mandz
BoITAEIRGLRE — L2 -
2.2 %#EEdit)

2.2.1 15347 R4 DMX 33k
R P T AR CEIEIT L DMX it fe s h & » TACRORELHZRE T R o

1> #[Patch] E#4¢ (o RA P AR LEARZEBEX)

2> }z[Repatch Fixtures] 5 20T L Bt o

3> ®AFM BEEREGITE » K% &[Select button] iz 4E o

4> 52X DMX 33k > Jz[Address] 4 A #7693k » K 1% 3z [Enter] o
5> 142 DMX # i 4% » 3 [DMX Line=x|# \#7 & % £ & 5 (1-12) »
6> #z[Enter] 3% [Repatch]# 1A 5 2 o

7> FEREVHI B 5 L MITR o

\

\

\Y

\

P RE95 A% A [Park] 2 48 o 3L T /A Tk DMX S A A G IT L - BT A G RBSRE Tk o

R EEHG DMX L2 A A —MNMTEEA 4608 7dEEkE
do B BIATAE » 58 6 JRAE A Hb 7 3k R A LA (A T 6 q
IR s A 11.3.3 ) o #3%[Select another address] T & =X, P L HE A+ R

GITE S TAREMITEGRBELREG 2R P FREA LR TR ERE — N2 R DMX
Wik > K& A B XAE R T o 4o £ 1832 [Always Park Conflicting Fixtures] & 2 72 8 ¢ = 47T
B BHEBXTL2EAABFTRGITERELER P (CTALR P& E EALER) o

2.2.2 #ELMR

AP TAAF—ANEREBBRITREAITZRELIR LHRELTA L T2 % (VDU) L f=(Touch Wing)
ARAR E L AGARIEAE A > A B A P AIRFIITR o
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.28

1> & % % % 3z[Set Legend] -
2> TP REBELARGITE

3> {E R4 EMALAR o
4> 4z|Enter] T s A ©

® AP hikits BITRE —Ae 1k B L AR 0 EUEF 4A(group) % 4% [Set Legend] °
LS AT ARBARA P TAXERE A5 EA P %5 > 18 M 2 [Set Legend] ¥ % £
RERA MANG—REITEAP RS ARNITEAA PR T2 AFHE 1 50 -

® % Jf[Set Legend] )t > [ E B ATIT A R L4k » L2 L 7~& LCD RHFF/NE L TR
(HUD) t -

223 2 HRITREE

AEEEG LORZBITETH & T8 axidlview|] B £ F
8k 0 A% % [Fixture Patch]| & & Gt 4T AL - LCD £ 7 & L
R EGEE —ANITE TR RN ATALIEE
BMNERVZRRFITE o TME R F TR ITE
i? 4: HFAIT LA ZETHEAF £6G LED & % o %38 Bodd 4T
W R [Edit|# N REE R KRB AR Bi#igHa 52
%#ﬁ{- 87 B > 3% T [Enter] % A% 2 FHF o
® HiEE o AEMAMEEXET
-7 & #4745 % 7% Handle Number: 7 {Page} . 15 %< {Index}
-¥ 3k DMX address: 47 & @ {Universe} . 3¢ 3k {Address}

® T AitdF T RS A o 4% [Columns] HF ik 3578 & 7]
BB R LT o

® JHpTaiddizéd bag kA k4t h ERARAE
backspace 15 2= F % DMX Ho ik o

2.2.4 2EFEDMXAE

LR Pt T A4k DMX i@ 38 A B A 0 2 [View] ~ ékfi:i
[Open Workspace Window] 5 # # [DMX] » DMX A% &47
7o AL & A DMX i@ 3 4k 2 i e gh fE o

FE kb B P s FR R 694 DMX & o &£ & v R
HETETELS DMX BHEE L -

2.2.5 R #47 B (Fixture Exchange)

RIITE A i SRS A RARR IR IITER RE EH
AR X RE fiﬁg-éﬁ%ﬁir?‘(ﬂ‘f@ » ] & 2 R shapes
Fa % A legends FE) XZEFARNLA P REE K
Bt o

Bl Bl P &G BAZF ¥ A — AN &% A MACS00s » {23 /&
R A VL6s > A P 1# X g ftde MACS00s & 3 %, VL6s » 2

1
2
3
4
5
6
7
8
9

[ S
- w ¥} =

= =
& =]
=8 o Cel e tedl o el e Rell i Vel el Re

F‘,J*ﬁ:‘[*& (E=) L 'F[J F1i5 © 852-2898 8666 (£ H! : 852-2558 1282  P»{fi-: www.dnein.com [T} : dne@dnein.com


jinni_lai
D&E


AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.29

Fb it s AR AERARAITATR Mk -
do ) P AE & (Palettes) sk 4] 2 3% & (Cues) > {& AITE X H B G R R R - Wiz E &
HEHGEREEROEAS > AFEEERE—ADFAE - HFRXHGBRANF 2
ZAHIA T &4 AL o

LIIT B A% JRA AR N A X 64 47 B 64 (Pan) ~ (Tilt)4= 18 & (dimmer) % # = 4 8% 4 49 éﬂ(gmups)
5% (cues) > 357 (chases) ~ 5T /% ) (cue lists) & R £ #°h1 » 1274 2% 4 dy 3457 & DMX i 38 R
Fl3] 2% &8 4524 TR F &4k o

RPITEAEFLERA P Lk pfasr X AP RERITELRA X A6 DMX i 18 65 M k&
ArGAL s SR P ARR R EERRRITEL > RAFEROE BT 2R o

1> # A3 Patch 42 X » 4% [Patch] -

2> BFEFRITELA o

3> T @FRIT R4 o

4> & 2% AR Pt EA4E A+ o 4z [Fixture Exchange] & 5 o
5> FRFH3 EHAMuIITE o

EE I RIBRITEAE LEM BB RARE  BFFTRELHCRAGEM B A -
RBEZEM o

2.2.6 FHE T B XA B 1 T4 E (Personalities)

Bt R PR E AR BITE B U TA > —RRFUTE S AR a7 LB TH - AT
LEHESAITLEEIFFTHENR » R EHNLECERIZEGITLE M T4 -

1> # A3 Patch 42 X » 4% [Patch] -

2> 1% T [Update Personality] & #7 %7 EL & P U #F o

3> =46 LCD &4 » JLAE R F T &3 B LAFagIT R o
4> FZTHI BT AP > REHGITR -

® FHWITERBHI 2B B A E FTRGITELEE I THER -
2.3 X #l/# 3 (Copy/Move)

2.3.1 R #/#&3h e BT R

R EHldx4a s AP TABE—AIA B EHTELI RS HE —MHFHogdzrsaat o AFFEH -/
BT R KA % NITH -

eh e BB H S LITRAERA A o

1>

#% T [Copy] £ &4z 4% o
2> #3579 48 [Copyl & [Move] » & & 1% [Copyldz 42 T yn % L3R ©
3> wHFRRH/HHIT Eipst R Amkizst o P T ldF S BIT R dd g s —MT A%
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.30

kit ARZBFBRBITALE > KB LIMBORETREAHLEFRKRITL -
4> & T R P AR FEAE G Qb o

® (X¥iz44i[MLMenu] > T REH ~Fsh - EXE > IHFTAE TR x4 ETHRSF
HEREBNKFHHEREF -
% 7 [Retain Layout]{% & # B4 & > [Bunch Up]| R & — Rl feiL & -
% 7 (Copy) & #1# X, T » & 7 [Copy Legends]4a 7] % #x & %] » [Don’t copy legends] & #| & #
e 27 NG % 7

® %7 (Move)fs#h4E X T » ¥ *7 [Swap Items if Required] X342 & » o 4 #6942 8 LA L4k
JITERSAESME S LRITE o

232 AR EREGIT R

STERE R ARIETAR » T AP F Rl — A E LB 3IT Lo > 1 F &g [patched] ) it %
BB RAFz[copylh At b iFIT B o EAZ EAR T ©

54 k69T B A DMX 33k » 33k 5] E R m“Parked”i%7 o Al 7 & %54 A DMX 33k A
AREGEA 2.2.1 7)

2.3.3 MM BiEIT L
AP TAREWMsdzE LR E 6 A ITAH IT o

1> # A fedE Patch 2 X, > 4% I &.4¢[Patch] -
1% % @4t [Delete] o
> BAER P M k6T EAede T K G dedE o
4>LED £ 7 AGMBITE » 3T & & as[AlRIT £ K &zt g

® FTHRBAZN QLIEMMIAIT L% E LMk > BRE TR R o
24 FHEZA

2.4.1 Z 3% Pan #= Tilt
X AR asiE A P de pan e tilt 424 & B4k 0 BT EM G BAERTE R A o

# A Beik Patch 2 X » 3% & & 4¢[Patch] -
1% B¢ [Edit Fixtures] 5 24T £ 2 & o

1
2
3
4
5}

\Y

\Y

\Y

#% 3 [Swap Pan and Tilt] 5 3 3 & o
B EMG R IT R L4t 0 X2 P A RAITRIF > [Swapped] I 3% = [Normal] £ % o
T [Exit] & # o

\Y

\Y
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.31

2.4.2 & #a & (Invert attributes)

BT ARARIT LAEAT B PE » o RIEF —ANIT R R £ A KT R0 AREARZARBETE
THREITEALE o

1> 3 A fedE Patch 42 X, » 3% I & 42[Patch] -

2> B [Edit Fixtures] 45 2 k7 £ 3 8 o

3> X [Invert Attribute] & 48 & 1% 7 &% o

4> BB ILF G Ay IT B K b o

5> R R AR & R4 0 B S = [Inverted] /X & R A8 o
6> 3% T [Exit]i& & o

\Y

® MPTABREAITA— ARG 2 RRABIITAT BRCERAM » FEET
[Inverted] °
& —WEMPITAZ R o

2.4.3 A 447 B Fa B PE(Freeze fixtures or attributes)
MAHFR P REITEANFNRITA B s AL R CERHNGEFAGITESZE FoR o

1> # A\ B Patch 2 X, » 4% & @& 4£[Patch] -

2> #% B [Edit Fixtures] 5 2 4T £ 5 & o

3> #t L [Freeze Fixture or Attribute] /4 4 47 B0 & 1 3 68

4> FELE A EIT B K w4 o

5> A% Fl o A AR i 35 I B AR R 4 R B EANIT R > A% B4 8~ (Frozen)F o
6> 4% T [Exit]z& i o

\Y

2.4.4 HiEIT L SUHB O TH
AR TR MITE B M R EERBR > TUAARS S LAERBITLE LKA o

1> }z[Patch]4Z -

2> Iz 7 fe4¢|Edit Fixtures] o

3> 1% 7 fe42[Edit Personality] -

4> S LED R 2 RATA QR BEITERA > b HFMIT ARV FRTRE o
5> %5 47 L& MEAZ X ‘Builder’ 47 7F » 1247 7T 48 %4 o

6> HERAGHITEBMETHR > RIEEREARETHITELAHNEHTH - 56
AT B R AL R B AT o

® JTH B M % 42 X ‘Personality Builder’ =] LA Avolites ™ 55 T #, o
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.32

3. BHIFEAITH B AR LT

AEEL  BEUEEXITARERIT » EHE A BEAEEM o

ﬁmF%Q*Aim%kﬁmﬂﬁ APELFHEHECRLIEAALIORE -LE - A&
o RRATRLARF S LT R AT A (Swop) Ik & st 0 KRB A B LB R
,} °

31 &l&

3.1.1 #IFITH REH
o AE B4 B0 B A% K AT S H AT AR R TR I B A (T A TRAR I T T) g £ b eddT R ands
AN > THBFLRR S MITE—ARBHE

A BTN T R F BT RMEL > BRITEGALBERE o

1> TR P BBREEGITER4E R AR » HBRIT R34 L6 LED 25 %
(R R LegmBdslrRtEe)-

2> BHPBF-AEEGITE I ERBF - LIT B4 R CE RBIT A4
(FRPiizstit Al T8 BATHELRA) o

T A — 3 H A6y A

® & {i[Locate]#x42(E#=H & & T At Eizdd)  WARITE LR G BB F o1z
B o kABHEAWT—% o [Locate] it R o

® o RRUHCWIFGITE  RF ExGFIT R R4 o

® fi(TouchWing)mEEZMA XL FTM P SATRFOITEEE -

® 5T [Locate| 4z 4 12 » 7 ik HUTEL?)'T%‘/% Mo B A% B FF SR A o B EUE 4T A A Ak dE # 4= HUD
IHEEUeRSUREEREL T ©

® iiz[Clear| 442 5L AT A AR LI 4T B » 5 4 1 F — ¥ [Clear|#2 42 % R -

® LAEFELHUD IHFuHNAREAKTALT IR TR

& @A LA TR E HEAF L6 LED X 2487 > LED %

BTAR PR EAXREGESM 1133 )

® A P T iiiidk 4 b @ dg(page fo fixtures)$T B 7 © s4a 2 0® 1 @
Fedt > BEURE W64 & ~ & 4 (Palettes) ~ 28 (groups)
Fo 5 AT B AT £ cues 5 o

Fobe 1200 Robe 1200 Fobe 1200 Rcbe 1200

® A fiE B (Touch Wing) Al 7 =T & 3| & % 6947 B iz Fodures
ﬁ% ’ @i}ﬂ ﬁli?éf = él]/x’{%ﬁ] éﬁ’i}%é}c/ﬁ _I:[Pages " Clrsp 1200 b Cirsp 1200 b Clrsp 1.

Show/Hide] £ /1% & T k% 4% 4 o I 7 ST g
® LFHBEMATALE C AR LITR 4 W& B LAa R

2B EHEAT L o o R — A2 100% 4

HMAAARFAL BT 2 ié‘lg"’ﬁ e Rz dldT L F

AT 12T EAAEHRAT A T 282
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.33

312 BRBFITEGER

[Locate] R {242 (= 6 4& T AL B & ixdt) O HRMITEBREAD R AL IMAI LA
/Jé‘ ]

B % ANHT B 3% T [Locate] 7T Heik #ude b7 L — A2 B fife A & K o 12 & A B4R P T 68 R A 2 AT
HITEBEAR B AL » R F{i[Locate]42/@ H — % F % ehikd% o

FERBALHGA P THR— L% E (m RREITHL » (2R T A5 F R &) » 4%{E[Locate]
#o 3% [Set Mask to Exclude AN HE /% 69 FT A Byt » A1 3545 6 & 4 B w4t » 4%42 LED 5 2K
AEBALE B o

[Auto Reset Mask] & 1+ & #h B A% 61,4 BT A A% 15 2069 & P o 3 7T 47 4 | [Remember Mask| 3R i p
Rk — R IGY By R AL o

[Clear/Don’t Clear Located Attributes] % & & & 8 4214 B 37 /4 M A BLEG 47 B

3.1.3 7F M it (clearing)

[Clear]/F Mz st (AR T2 B A D) £RAEMILA ERGAEF AR BT A BRI ITE o o R

R P Az [Clear] FThintt 2h & 5 45 54t ikd% -

® TUBRPFAFTHELBEHBl T ARG KE/&LEELCEEFR)IZ/E[Clear]/F Tk
T4t 4 3% B[Set Mask to Clear Nothing]|1Z 4 % A F& B » REAEA AL BERESRIE A
7 fe4E[Set Mask| L BUE F TR B » RAR B R B 2Fh -

[Clear Options| i it 37 » TAT /A —AFE 8 > Bkt —F 030 (iF LT LHRk) -

[Clear All Fixtures/Selected Fixtures| 7 F IR A T A /R BFT AL » RE R GINRARFTRATAIT
AEB > (BB T L are)—LITEFE o

® [Individual Attributes] 5| B » TTARBAZ N FRANF] B o 2 BT LR » 2R
B A% R P — /B E Rt A TR R B o

“Clear Options” F R A T X #:

® [Auto Reset Mask|4#:4% B #h £ 4% » 3 T[Clear]i%42 & shieBi A B tE B 4% o T A indn 4%
[Remember Mask] 124X 4&4f » J§ RIF0(E R K — RIFHRIEMHGEE o

® [Leave/Zero Preset Fader Levels]|/fz /&4 F R K F R B % 6 oML EREEF LR
b8 38 B KF o E R AR T [Clear]|d42 42 5 2 M kAT A 4ar > {2 R @ @K gk 4% B A fy
d o dw X A% T A [Zero Preset Fader Levels] 7 % #f F K K -F » A48 k38 18 2 8 K F
WA BB R o

® |[Freeze current values|/A %4 % a744 » &2 €A P 15269 LTP(FEFE LA # )R 18 T 40 o 4ok
& #[Freeze Current Values] LTP i@ & 2 k45 F P 691X & » 421X & 7 [Release To Playback
Values| B 2| © 344 » LTP @K © 2| B Al @K 69K F o Hl4e : A P A — A=K Cue 5%
R pA— W EITH B P BFGITE s FERALEITH » R A P dx[Clear] iz 42
B 3% % 4 [Freeze] /& 45 A8 4= &, 69 4T AR R R 2 7F 4 0 124w R 1% 3% 77 & [Release] A8 4T 58
Kw g e o

A P 7T vA4E A “Channel Grid window”# 845 0 X% F T LB EGEAH 3.2.1 F)

F‘,J“’“}*ﬁ["“& (BIF=) F L _F[J F1i5 © 852-2898 8666 (£ H! : 852-2558 1282  P»{fi-: www.dnein.com [T} : dne@dnein.com


jinni_lai
D&E


AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.34

3.14 AE#HKENT
“Attributes” & £ ZIT LG AE > oK~ F H G &8~ BB o
RPTNEREED % L6 inidhiF S g 24520 F12 A
AR R B AE Bl 45 40 kR B AUA o AR AR B PR B R AT B 6y
RA o FRBERF —NELEME o

AL e R A P42 A 69 % Touch Wing i € 45 M T —% o

HNBHEETENANBN 25 ALY RS LRS-

1> BFENEL - BT RGO BIEEME -

2> MR E R LCD L@ B 5% A 45 ) A 2k
Bl R RERTESNSRRETO L TRAITHE
lri o

> FRFHE AL MEN

FAuolites Pear Expert

— 3 34 5% A 6

@ LRLE—NEBMN > IRPT RO FTETAELA
BAMERE (B =8“Green” & 615 B A KL

@ ):ll ) ° Colour Func Colour
© EMLEALA P REALRRE AP LT AN I
l‘t Hl“Attribllte l;arll{s”:,f‘%J A ii j%&l lr ° - iUz

® JwRixT B4t LCD =444 L&A =B AR Deep Blue
RIGIT BT AR R AR B P o

® WwRERIETFLIFT—IHrk fa’i‘%‘@/\ﬂlﬁﬁ&'ﬁ
TIH o R T A4 T ik B id

® i P T AR R TR OE AT B dE 4T B0 kil a6 kg
R o

® FiBX FE A — /A “acceleration”” ik £ X 0 WA PRI T - :
Bl AT TRARK AP REHEBER  MELEBEHOR | E -

® {I[AVOldR4EF B 4% sh 4% 40 AN “Fast” iR AR X o AR X T — Nt L EES
W 8 AL AR 16 /L # AT o

® AP TRAHBENERRAET 0 kESATAQLE (B4 B %L HE%) 4[Show
workspace window] & 7% iz [Attribute Editor] o

® —LED ;Ebéhﬁﬁ—‘/\ﬁé»xi)‘ualﬁ s EAR LAY R E A K KT 0 £42 T RGB 4T
AREFRAREG R A% 5555 ST 3% ) a2k o

Calour Func Calour

3.1.5 AAdk E # #(Touch Wing)& & & %

SEEMRBEEL BMBEELEMNEORA ZANBRTEER > miEdl e LA R A ERER
L RE e

R LR R T BE(RE L E > REF)fibib Lo B o
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RP TR R Ee g Ri=6 6 LREREEFERNE > BER LBRERGIAEELT

R R
do R B AR o R P AR — A A

RATFTETRILFTHENERLTLAEER  RFTRSILITAT AR TMAENE - wB TR E
BHEWER s BB “Green” = ERESFALE -

P T AR R T B SR A B AR o o i 45 AR IR R IR S 0 AR AT RIS R B
1543 HE o

WREFRHBBELFFUER—AEEH K REABE ZNB
PETT A4 4 0 & A T MR B A R R A B B s
BHREBE O Effect Rot

AABRG B A RFEARAE BEARGoTARS ) .
R M6 o TEARM T — A 6545 RGB K CMY M &Re o
ToR B

1% [View] 3% 42 X 1% J% [Open Workspace [ b control

Window] - it #[Attribute Editor] 7+ 5 & 1+ % 45 5 I Caloar e
%O o fifkit BB IPCGBES 342nt » Tk . -
BN LT AW B Tt el —

ByPE) » T — AP RFRE S KX o Pan
WwREMAREFEETL <& VDU &7 E AP T

e s v e i R &L d[View] x4 -
[Window Options] ~ [Move Screen]# 3 & @ »
KE e AE 2 ) 6 L [AVO] 3% 42 R #4 4% “Touch
Wing”#zi2 # t [Size/Position] X /s /1% & {24t o
BPE R O A M AT R F AR TR o
WO R ERBMEA s AA B AR
BREEME et st sh R BRI TRS o
SHAPRR—NEE A EELETREE R
T%BMERE o R BRMBERME > ZENK
WG M AL o M Bk o

RN BEGIFA (e e i) et E o
FREZELT 2 BNE S Neito

d 75 B B Ve (S B SR 38 3 ) 1 He 43 AR 4R 442 4% §w ok Attribute Control
FRHE-RER P TASFH TG LR @aE T %G i

Dim
PEAE o ——

78.00%

“Active fixtures” 5 Ak wiE )T > BHAHE 0 LA THE B4 B oGt fdd » BHRRE S
sbf F 4% CITP F=“patch” Fed% 4T B &t #k [Active fixtures] % LK &, A& 4T o
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B MR o T A I R H] % SR & 8% 4T (keystoning) 4 7 5, (blades)#t & /(shutters) i 4z &9 B A » 7
T FHeh A RN Y RG KB AGHE o

Attribute Control (i

Colour Mix

Red

Groon

Blue
White

=

Focus
Digi Iris Sel

Global Iris

EE L CTRE AT A UM R XA Rt A BRI AE o

3.1.6 A5 %ERNE
AP T RSN ABEMAN—ANRFED BT o LAAERTEEREE
BB TN F -
N TR LN AT REBDEED KE XTI ARB &
(AL R AT R AR A B 7 B % AR 49 4= Gobo 5 » Deep Blue © 4o 5 Al P 4 A 4
BREEKXGBEE » 2H e EMBR LR ERL—ANELFT o
ALEBHEASAB I T > BN A &EE » AP THA—/8 5 A 0-100 69 F 4~k
HEHE e BB BEER S REE ARG AP EMAZEROEER Pl BF R e(h
ErAL@BERGERINE) AP ERMAIRE o

3.1.7 F#F %% % AIT4 485 47 (Channel)

E#%H%T’Wﬁﬁkz%?%ﬁm%%ﬁ’bT“i&%LW*HHﬂLL%%ﬁOkﬁ
XBRGRAPIARFTRGBIERIT A WEIT » 35T A%F42E £ L A6 |Fixture] 4z 42 3
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WE R MATF © %A P 4(Through L 5) ~ (And o) R@(E F4E T 7 09 R &424E) » A

FTHaEBARXEELTHEEK-

1% 1A oh 484 A 4 347 £ % 5 A (User Number /A P 5 %)~ (Handle Number 34T 5 23) 3% (DMX 3

HE) L o

(Thro # %)) ~ (And o) X@ 4% 47T 24 il it L FALH T 5 & &8 7 5k o ARAEHAT o

% {% A [Fixture] i i X ¥ Bf » ¥ [Menu Latch]4f{ X £ 548> T2 A P X & %8 8 X ¥ %035

Ao

® BB P— ITE AT I E[Enter| 42k o

® i %A— TR B[And[F A AT L 555 o 44w 4 X 1 [And] 2 [And] 5 [Enter] » 8
POLABIRTHRT 12 5ITH -

& THBF—ANEEGITE  #%[Thro]l A 2| o #l4e A 1 [Thro] 8 [Enter] > 7Rl F 2 LI T %
T1E28ITH-

® A RBEAREERILLEITR » #[Not] T £ o Fl4= 4y 1 [Thro] 5 [Not] 3 [Enter] » 78 7
PHRTHRFT1-~2-4-5ITEL > RE3ITL-

® [@EAHAXENTELFEALARTER Fl4eiy X 1[Thro] 8 [@] 5° K EAZLI 1 £ 8 JTE 50%
T > (BA“S” B 507K & 50% T & User Settings A P % B % & —F % bl 11.3.3 ) o 4o
R#[@]# #([Full] 5% 3 % & ~ [0%)] X H 7 L S [H-]38 e A % ) T A L B X R ©

® i P T Mg A AL 48 [Group] 42 3 4T3 BT B o 48] 42 %1 A [Group] 1 [And] [Group] 2 [Not]
5> RAZIAL Fotl 2ITEZ R R H T SITE o

® i p <] vA{% JH [Locate] %42 1X.% [Enter] o 4] 4247 X 1 [Thro] 4 [Locate] » X &8 1 £ 4 4T
B~ Bk o

1 AND 2 AND 5 THRO 10

O LAPHMAIGES AESLCD RZLHBEAITEETMATH > AP TUME AR &[4t
HE—AMN o AR E[O|IBBERFHN °

® AND % > THRO EZF @ » 47k Lo & ddzst o

o Sde{tatl.lllt—inpﬂl:;éﬂ'!lﬂlemm
3.1.8 1 A& AR X & iFITR DT .
RARER P K ERBITAAE  RERB—AH LS Xns—7 [
BENTEITL ARG EERAEFIEBEITL > bl s 4 [N

XINY: X fixtures out of ¥
/|\ *T _,E\_ ° X.Y: X=Selected, Y=Gap

1> #iF—®iT L

2> %@ & “Al 442 (f 4t b & 4 69 5% 46 [Next Time] 4% 42 T 6942 &)
3> i Al restiadF— X AP R BEGERFEITE o

4> j G & “Next’ {242 » FHATBY T —MHBEAEKEX o

5> RBFRHROBEX > &G E“AVBAER X o
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Blie Rl P A2 R T 16 ZITAR B RBZF 4 ITEBBAHAGFHE - AP AE®HF16 LITHE

R Taa“Alz4 ~ a4 D([1ind] > AP 2FFAA L1599 F 13 4T Ak » K
WITER Y& R e[+1)4242 26~ 10 F» 14 ITER IR T UG D = T o Hix[+1]
R FORNITAERRE DR E -9 F > A3 A PR RCAINTE R -

& Mp Tl TN » MERFHELE D4 o 4o sy X2 [In] “6” o

319 NEMRDHEXNRELENTL
AR Mo 2 88 T AN AE 89 A R e A N 4FIT R o

LA CEHAEXREMBFITE > & [Channel]4Z » 1% 3 f842[Select If] » & & % F & 242 X X E#
o4t o

77T vA 42 [Select If] A 1% Fl @A [Throlz4% » B LK FRLMARKT » BFBHFLBIITE o
@X . ’LXEIT—,E]\‘X rL,F
@ThroX : ZEMEZEH 0 £ X;
@XThro : ZEITEZEd X £ 100% 7 /% ;
@XThroY : ZE/MTAEZE G X 2 Y;
@@ : TEITELORE
JT B % 2 7T s 0-9 2%, 00-99 #23E A P % B ¥ A » [Channel Levels Set In]i# 18 22 71X 5 & 3L °

3.1.10 B4 (IPCGBES-FX)
ATHREHNRE -2 BEAARAFTHIPCGBES » £ XK R A M4
I - Intensity 5t 4%%= & ( dimmer 77 3¢ ~ strobe shutter 7 47 )
P - Position 1= & ( pan /K -F ~ tilt & #)
C - Colour jfi &( colour wheel & % ~ CMY mixing /% 4")
G - Gobo & % ( gobo wheels & £ # ~ gobo rotate 2 45 & £ ~ gobo position & £ 6942 F)
B - Beam %4 (iris 5t B -~ focus #f £ ~ zoom % % - beam shaper 3 £ %)
E - Effects 2 R ( prism #x %%)
S - Special 4% 7] ( motor speeds I X i /)
FX- Shapes # ik, pixel mapper 1% % ik 44

BRELEF SRR EEIRBH AR REFANALEN > FH LS HA 1A “masking off”
/‘k’éi#]“#ﬂ%‘t—bﬁa'ﬁﬁﬁ °

TEEZMBELGEMERE > RIERAREAZFZEMARE  BeARAMEENEACEE
HERBEAN - BleBIGTZE ~CHRER SHRBUAEGH T HEER LN -
3.1.11 47 £ 28(Group)

R P T VAZE 5w, s T B 3 % ALIT(Group) kT 48 » 18 A 42 & T B 47 T 69 & & 342 2, 4 A (Group)
ST %5 o Blde A P THENRBGITERZ T —MTARFEE(£/A)TE A% %2 A o (Touch
Wing) i ZAH —ANF1ITAGT O LA P TN L iEindlig 3w LT Las -
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B % % %1 #T £ 48 (Auto Group)

BRESANTE  BHELAFHAMBEZITH o 2ARIEF LA 6447 L4 12 (4] 4o BT A & [All
Mac2000] 5% 4 — X & B 47 6 4[4 BB4]) » 4248 X 17 5k ) fiE /& [User Settings] # % 5 % % » %
#[Auto Groups| % [4] & 3 % #] o

4o R & I W(Group)JT 48 % @ » 4% T [View]4E ~ X # 32 [Groups|42 7 B ITHF 0 o

> %A% F # 5 (Group) kT 4869 W, As 4T B 3 ALAT o
2> ¥4t b A e9[Group| bt o
3> WAITA R T o

Groups

D.S. Tm
|

4> I 7 #£4%[B] [Record Group] - - -
o R Spots 10f3 Spots 20f3
5> =T #r A [User Number] & F % 5 =X, :
8 2
[Provide a legend] 1% & — /% Ak o AN Pixels odd pixcls

6> M EBEHEAF TR EIERITAT O R
6 kAR 4 > 3% 7T 4% 2 #e4£[C] [Store] &
BB H—WMpT o

7> z[Clear]| 44 2 R % IT4A5 4 o

® i {I[AVOldz4E A% 4 [Groupldzdt » THAE# ITA LK XL » RIEM
(Touch Wing)fik1% Z“Groups” TAF TG v » A% v N6 F —ixsd
ZRARTT BAEITE » % B —RIEE TR & Fa B+ AR P T3 AdT e
WhTRA I ERT o P RIBEITARGMHT R o

0 ERBHANEFFTAITITA  RERAE & Giate R ITAME R4

Yo fTHBRERER Gizdt L s AN E LA L FAMDU)IFF o F o

F P T AS NIT 4% 5 B T 48

1> 1% [Group|iz4t
2> MINITHA RS
3> 1% 3 ft 42 [A][Recall Group] B & 47 4L

® [Group|iz4Eit A A P #4E T (edit) 15 2 e (delete) M 1 4T 285 o) g o

3.1.12 ¥7 IR 5 Fe d7 B 484 By (Fixture Layout)

STEAAAZMGT I EGIRF > F AR ‘ShapeS’ﬁ‘ﬁ K~ ‘Fan’ g 7 th £ 4= ‘Overlap’ £ & 7 #E o
RAMRETAGMHITEG 2DALEA 5 > 6 TITEEIRE R R KB A R EALE o

R ITH AT B8GR5 -

1> 3% 3 fe 42 [Edit Times] ©
2> BHFRBRIFGITA o
3> ¥ 3 #t 42 |Fixture Order] °
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ITEG S R RITAR O ITLRGF %S -

R F BT RN o 15 ¥ [Auto Increment] B 55 3% 3% 4 ‘On’ I » K% SRR A R0 F 69 4T K
Aot REBERARITE  TRAIT—MXREITERRF I — 5 o

ABITENITEG A A

1> 3% 3 fe 42 [Edit Times] ©
2> BERRRBAITA o
3> 13 #e42[Edit Layout] % He R © R A RB R T o374 o

BANIT B —ATHE D c R TAA R R EARBHITETE > EH XL CINLE » RAZBIITE
R R AHILE » F3h JKIR RA M T AR EMAER T o

[Arrange Fixtures| RHEITE o4 > I P AT MAIT A O H -0 4 E @28 sRITEAE
BE—ANEHIRA o

3.1.13 BARAFFHFITR

T RFHFET —ACEGITER—MITA > EERGAIF T RBFIT LA E > TAE S 5 AR
CE A ITE s R E R RAFITH
e ¥ o) 464 A A 1 4x GO 442 5 89 AIVOdd/Even Hi Light 4% 4 i 3% o

1> FE—ANERERGITER—NIT4
2> [-1)An[H1 4242k F R B P Al — A RBE —ANITE(RER P B BFIT LR F T RK) -
3> ANz F AR EERATANE@ERT2HE%M T2 64454) -

® “HiLigh"s zH kR EEREEFNITL > FHEHAT—F -

3.1.14 % % # 4% 44 7 £ (High Lighting)

34 A2 4% Prev/Next/All F# 8 4F TR > TIAARER B L TR EITE - FEFA
PORE A BIILAEL BT KB IT R A KR R -
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® i HiLight 54 & 2 % A8 X » AT HiLight B4t % AS MK o 54 % AEXTH
FBMEA ST RAN R AR AN CARRAG RITATARERSEE - A
THETTHITERGRHE <)

& P TREBITEREE KR » BAE[AVO]4E & # 4% [Hi light] 42 » M 3% # 1% 4% [Store Highlight
State] 1% & %k A 5 [Store Lowlight State] fk 45 % %k & o

3.1.15 xf F47 £ (Align)
(Align) % 7 7 #6.7T DU — AT B89 B b 5 #1510 B — AT RAR A o RREFAR - 4o A P k2
RS BRI AR T — it AP TRE M E ML TR o

1> gIFR s FeIT R o
2> 1%[ML Menu]iz4& » X #% ¥z Align Fixtures] xf 747 £ 7 fE4¢ o

3> K E“mask” B G5 PR R H 6 R
(1% Rl 35 %] 6 A& 4 69 B PR 48 » A AR B NIk A5 T A B ) ©

4> PARIT BB HIR E > RImCEIFT K & st o

3.1.16 %1% (Flip)sh &

FBANMR BT @ES L E o - 8§ BT LA 3 W Bl kAL B A= 4% » (Flip) %
AT A P e R R e

1> #%#FZFlip)tgiT B o
2> 1%[ML Menu|4z4& » /X # 3 [Flip Pan and Tilt]$84 /T L 2 fede o

EE e RAT A 2H(Flip)2h 68 RA2AE R 0 1F € 3747 £ B M U (Prsonality) o

3.1.17 B @& (Fan)i &,

(Fan) i3 A2 X 7T B 3h oA 2635 56 Bl A 4T B 69 B PE 4l o 4w R AL H (pan) K -F A= (tilt) £ & Sdeh &
EITE 5 i rays” AR 0 B A RE—ADMITELIRANEERKR > FRITEZ ¥R
o> o AR 32 ) 5 B ST 45 B A R o

P A IT B89 R T RAT 2 %o (Fan) B T AR X 2 6% £ R R BCR o

(Fan) iy A2 X » BEAE R A KT RELG B > LT A FAMERT B o

1> #iF4E A (Fan)é) *T £ o

2> 4% (attribute bank) & P iz 4E o

3> Iz [Fan] % X 4% 4E o

4> ¢ Rz R 5L E mAAE o

5> AR 4% T [Fan]dz42 X M BB AL X o

\Y

\Y

\

\Y

® Al 7 T A4k [Fan|dg 4t 4 1% 36 [Curve] » 7 w0 % 71 Fl 4 3 % o & 4R T 4% -
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“Line” A4, » 48 &R “Pull Middle”#% +

“Arrow” 7 k

® AR T T RAF S » BFIT AL ILE[Fan]dz4E > REFREMAFF 0 &
BRI BRFEHTERK L TEHTT o

o B P RFGITEG S ANITAAR > TAGE L EH RARHB A RERLGGEER o Bl P A

RATAEAERSG L H3WF5844 AP A 2RNARH ORI ALERES L RI3AHH >

AR e AR AR o e fE[Fan)d242 T A VA T 4%

® [Ignore groups] 2620 - R S AEE—NITE s RRITEZ G2 RBEBRAIITR o
AR X o

® [Fan group as fixture| ST SEST AL R — BAMTARSEEANTEZRA BT o FlIT4

M BT A ST B AR R 4 4E o
® [Fan Within group| £ /T AR &2 A - KEITEAEAR > RHAEZAARALA ©

32 EFAE A FKAA

3.2.1 i#3iE 4 % 2 (Channel Grid)

(Channel Grid)% @ 5T WA § R & ANT L@ #E I » &AL E T [Channel Grid] & &4t %% &
[View]>[Show workspace window]=> [Channel Grid] ) #8427 B 2% 2 ©

Channel Grid

Number Dimmer Shutter Shutter Func  Pan Tit ColourFunc Colour CTC  CTO  Cyan Red

9 40.68 | Foed

39.77 | Fined

39.88 | Fixed

40.51 | Fixed

45.85 Foed

47.06  Fixed

17 | 4776 | Fverd
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BOTANAEYRERERFGEXNE T - BEXA :

® Playbacks - & =ERAZFITLGEANBE -

® Levels- L REMNBEEOHHIMAKEELAR -

® Palettes- ST AAM AKE T T 65T LB

® Shapes- £ REZZHTHBIRGITE o

® Output/Programmer - 3 & 5 B W B 69553 mE » A Al A RAEGENKE
([ J

Highlight off / changes - 4o %1% & % [nghllght changes]| X & T & &M% &%

® Narrow / Wide columns - £ X R % 7| % & °

T °

Rp Tt i EEADITELBRAFITE G RITEAE TR AL GITE S AL P o
AP Tl F R R EAT B R [Clear] 3 4 B MEAE (AR R ARIE I T —kkE %

A Btk) o

R P T A RF—ARE AP B R ATE 20 12 1 (Wheels) 4% 48 SRS 748 & £ —

# 1% Enter 42 o

33 RLR®BA

3.3.1 “ML Menu”iz4&

ANFTAE 0 R

6 H —/A“MLMenu” % % » # 45 F[ML[44EF 2 £ % » (Locate Fixture)4T &L £ 4% » (Lamp

On/Off) A/ % }7 8= (Reset) £ 4 » (Align Fixtures)}T £ 3t FF=(Flip)&14% o fe 5 & o

o R FH — AR E A IR 0 3% T [ML]4%4E 7T 41 4% 5 A1 % £ o 3 dx[Exit] 3428 © s % £ 8 » [ML]

AL R RIT R e o

332 FFE A EHRITRITE
1%%#as+h%‘|% AN A E o TIABATITIE ~ JOITE ~ B F ik o XAt

AR T

ﬁiﬂfa&la‘]h/@rﬁﬂﬁ% REATIRITAN » REE—NCEEEGRRL o 2GR X LR

fi}q_ﬂ. ¥ 2N R DRk IE 342 [macros] & R —AE) o

1> 4#42[AVO]4E » R4k [Exit]4E > BEBELX#E o

> HFMRAEHGITE » —BITEB R RE—AE R 2 HEk o
3> }[Fixture Tools] T & T B /[Menu Latch] 3 24 % » & é}}\ar:i*;iii‘?’}:” o
4> X # Z R TRGIT R A =iRE BRI LS LI aEAE o

® T HARLI G QST o T ARAT F 3K 30 A AT -
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4.1

% #t (Palettes)

AR P SRR E A AL E > AEFF - HnrEHNGIEAPHHFIERE > Bdiz

4?% iR B A EA 0 MAEFRE RSB o F A (palettes) ™ 51k £ & & izt R4t L o
XS TLMAER P 8 R BREM -

EIMBGRAERBELRELE > THRE AR AR E 2 ‘Colours’ il & ~ ‘Positions’ /% & F=‘Gobos’ B

ZR‘Beams’ %% > € AFNEM AR IgEFT L

5 _‘ 1 ﬂ; S2cvan S3
" c C

UESE

C G

11 12 13

TETEE s 73-MEERS 74 | ME 5 71 ;_1 iﬁs 72\ & Qs
C ::

o &% 8 7 “Colours’ il & ~ ‘Positions’ 4% & #2‘Gobos’ B € & ‘Beams’ = 5 T/F R 5 1 » I
[View]>[Open Workspace Window] 47 7t T4 X % @ ->[Groups and Palettes] 284 Z#4 5 © » =
MIAER & 9 REATH ©

el EHM

4.1.1 AL B M GESL B EM

EMTAEBITELEREHREE s AP THALE - JEPREEFN—NMEMAA > At
Rie BRI R EEFM » TAE R4 6 094%4F o (Palettes) Z 4t A& —NEB WA
ERGEMEL > A TRAEMNEEHERE] » ATAR P 7T R 9 7 F R 3 (Colour) i & ~ (Position){

X K

FEX N

(Touch Wing) x4 E A % 5 69 % 0 L & 1~ F| 8 % #+ (Position ~ Colour #= Gobo/Beam) ° 4= R T
REZAILFEEE g AP T L[ View]>[Open Workspace Window]=> [Position] 2% [Colour]
% [Gobo/Beam|F 2 A X% 1 o

ok o (Palettes) Z 41 7T vA1% & & (Shared) 3 3 2, (Normal).E & -

(Shared) T ZME A AT AR X AITEE A I HEGZXEA - Pl R T EMAEAH G Si%
T EA AL PT A MAC 2000 4T A8 ZAcir e T o

(Normal) EF ZMAE A S L EITEFERANF L EM o Bl BRI —RITENF 5 RFE
A2 & o
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4.1.2 B —/NEHM
ik B A0 F B

1> % [Clear]4Z 77 Fk % 42 %5 (programmer) © EIE

2> BPBFRRBEMOITE L ER O EMME - .

3> R B REAM ARG B AR M T O W5 [5]]0
BT R EERAREN - B Y

4> iz 1k &, [Palette]42 o

5> 1% il (Attribute Bank) 2 P42 473483645 % R0 R B o
B R T B AS X APTIF G E M @ L(palette <[
Mask) » & &4 69 £k 5 —#p £ A 69 B M (%) 4= Tilt/Pan) - 7
fe4Z D 4o E 4z 4] @A (Mask) 12 B (A T X) o

6> FTA RMEA R4S W BTN RALBEG R &4 i
1% (Touch Wing) Lt &) Ak 3% 3% K 4 A\ % 5 3% 7 fit. 42 [F] (Store)
fik 5 &AM o

0
1
3
4

Record Palette

® =464 A #h1% E 4 (Shared) & ¥ si(Normal)&i# Z M GA I ZIT LR B
,]i,i),rt BEREE 71:5] 5 ) ° Shared

Falette

& A BA” BirRTAHRE AP TR EE[CIL E “user” B iz B
T AR P ERE

® [SetMask|&Z @A » A WA PITEMNQAMERE - T Mizal &
# F i ¢ (Attribute Bank) B 4R AT 89 & G AR A RAL A T BILAILR
APy m)y iz Bami » 5B MEkRIREE4E LED T4

=
AT ©

FLorolites Pead Bdpert
Inlensity

WRGERGEEM IR G A RFZEZ(ET—F) - i
MEALBEHEE- LB REA P Hie R A C 4 Beams
6,3% IGBES © 4= % 17 1# F [Record Palette]i2. & £ 3z4% - NN BIII
FERFHRLEELCEMR B S oot
®  Set Mask (IPCGBES)#: 7 #t 4t 0 % @0 L R M » FT AT Bt 0
40 18] 69 6L & FnHER o

® [Record By...|3z #l 4o fTi% Al @ BAR 5 £ 41 » &0 A

Record by Channel in Programmer (#2 X% 11 % A i &
Btk B R A) 4ok Mask Rt %A > PTA LA X
IR A B B 6918 B ISR o

Record by Group in Programmer (42 X% 1+ % R % 48/%
FEMARAE) 4ok Mask ik € %4 > B 3h B M4 fEAE
FT—A B> AR IEB A PTA S A] B P AR5 (B 4o B 5 Pan Bp4g Tilt X485 > P/T
8 L AT FAE 5 AR Rl B AR A3) o

Record by Group in Mask 4o Mask A 3 & %40 > £ B M2 AL B 1k 2 Sk s 3h
ARk Mask Aia T /G » RELAATA BERBKRE
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Record by Mixed 4=k Mask A %t & %4 » F7A A2 X0 5 A 45 20t 6938 38 8 M 35 £k

B oo 4a R B2 PIT Bt 694t — B rEik B #h » PIT Bt 4 %5 A7 A A48 B B Ak R 5 o KL,

4o & Colour ~ CMY ~ RGB B W A1E— B Wik B 7 » 1% /B ML 4 % a] BT A 38 Bl it 4k R G o
® P Tt TR — A (legend) % £ » 4% i [Provide a legend] 45 4~ o & x4 &7 4& HUD %

Uittt s TA LT —AREANFHIPCGBES L 7 EM A &I £ 6 B o
® R FHIAELHMEN » RLAA M P IREZ A [Cancel BUE ~ [Replace] £ 3 5% [Merge] &

k4L B 45 B F A o [Replace] & 4% M| &5 5k 69 Tk % 5 37 & 41 0 [Merge] & % & T4 T
¥ EM S BRIz T [Palette] Z M x4 a shpiF &+ F 44 o

4.1.3 fk¥t & (Touch Wing)8y i A EH 4
%ﬁ@umﬁ*kk&% — AT EM e AR RBRCROREEEEE
— GRS TR G BRI — AT S o B P T A A — G AR A
Mask)@ L% B » AR TR — Mg ®s £+ o *

He i 4% 75 & A o) 635 A 75 (groups) B 48 ~ (workspaces) T4F X #=(playback) =l 7L & o °

EE %ﬁ#ﬂmm“ﬁgﬁﬁﬁﬂﬁﬁﬁi%?ﬁﬂ%iéﬁ;%kﬁ’%#&m@%ﬁi
FHGITHERME  IBEIRAEGRFTREGEE/ R G ER4ENG TR - (FHN
1L1A )

4.14 X E HEM LA

AR L EMATARELAR W REMGRA DR L LRE L TARFE
L FIEBEEM o

1> A TRE % %33 st 42[Set Legend] 1% & % R o
2> JARABR E L ARG B ARAE o
3> {% AAE AL AR o A

Time Tunnel Bubble Dots
4> 3z|Enter] T R % E o

No Gobo 1

I G I G

0 iAmiitlt LI rAILTEM%T -IPCGBES BHALE R~ALART® - Hl4iid &
METP REEMITCH - AL LALTEMNLEF &%mso

R P TAAFMAERR LA > B ;
4o KA & % B £ o #%[Set Legend] ..,
Fo E M i A4 0 R & 3% [Picture] B T
b BRBERWAT - i
o ERA AT HF > 55 _ N R
A (THREMANLF L) - ' ' -
Fo B PAE o £ AL T A% F Pen £
2 Ereaser # 4% 1 B 3 £/1% &
BRADZEME > Clear 7F A
& @ » Enter 3y N o £ E 7 Min 4
SRR P RT o
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Yo RARGHFT B BA4E » ARTANTR LR EEF LFERA
7545" 5(4%%5‘]#4?/’7ﬁﬂxi%@}%

4.1 & E#H (Playback)

421 AR —/EM &L
VAR E A R R

HIER PR ITE o (Shared) &t 3 £ A 46 1% B 248 B £ A4 6447 B > (Normal)-£ 38 %
ﬁ LRER E B ANA TR o

2> BTHRAEAAGREEMEE > FMBHREINRLHITALE -

R P T AL AT X (Cue) B8 A £ 4 0 5414 4.5.1 F

AP TERRFREEMANEM AT  IRBILTTERNGEM LA &ED
A4k [Apply Palette] £ )1 4 - e R P A NEM %5 TG & » &7 [Apply
Palette] 2 A4 Bl M E L 55 o

® [Apply Palette] h #8422 = T AM L4k > REMT I @R o

1> FF-LITH o

2> jz[Palette]4E o

> AKFREMANBIEMBRT o
4> }z[Enter]4Z 3k [Apply Palette] 25 4

® [Apply Palette] 642 L~ T M LAk » REMETE®WRA -
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422 MW

1% A 3% & #7428 % L6y [Page of Fixtures|dz4¢ » T&EM 7

iR EmRBEFEGEM GO TARERARRAFH LT  FERIL TR T oM EL4
BFELT/BBREMT -

® ApPTREMEMTEERNEMABT AR EM - KRB EYHTRE Y o

423 ZAHBBFITEL T REEM
WwRAP AT EMBENEABEITEGEFENT » ZME MR T2 AAMBIITE L » Z3L
iR EAM o Bl E—ANAAMAC2000 &9 & 54t » ERXARITEAGHERL T B THREX
4E o BT A 69 MAC 2000 2% & 203 &, o

424 % E EZHEITE

AP TAGEREMBFETOD R ECHF/3IT) o 48 A sboh 83 E & 3 E M 4E R K %% 5B 2] AP
© A AT 342 [swop] » AR IF R A E M4 0\t 4 A [swop| ® A AT R4 o

43 %RBEEH

43.1 EAFHBEM AL
# Palette ZH G O T AER EMO AL o @ a2 B EMAT ST LAl 69 B HMA -
#[View|E A4t » A FEAOEAMEE > MXEME oA o

Palette - Palette 76 [ )

Mumber Order Colour1Func Colouri CTO  Cyan Magenta Yellow Colour 2 Func Colour 2 CMY Maoo

113 0.0 0.0 0.0 0.0

114 0.0 0o 00 0.0

115 0.0 I 0.0 0.0

116 0.0 . 0.0 0.0

117 2 0.0 J 0.0 0.0

118 0.0 i 0.0 0.0
0.0 L 0.0 0.0

0.0

PR EMAE > MEREETOPGFEETAT c DML LAF BTEEARY » kA2
BIN— A FALAE T #5728 o

A [Delete] M ik dz4% » TEARM R B PEAE » IRAE ] [Off] 2 Ak AR ] o

432 AEEMAR
BB — %M Stixz[Update Palette] ¥ # Z#tdu4t » ¥ FTRBYEM (AL L A5 RFEA
AP EAM T R) » # 4T & &4 F % [Update Palette x]4%42 & Ttk 5 § & o
[Update Palette] & #7 & #4242 » T VAR AT E M L HRA% 5 o
RAPTABNEMB —RITE L SR ELBHACEZHTHDBRCEKLE > ARERE 2B
[Replace] % 4 fo [Merge| &+ £ M Hh GE4E 4 F P 64 o o R A P 3% [Merge] &3F » F& VAKX
A PR 0 By PEAR 0 R A de ity PSR ho 0 B AR & 1R A5 o
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® Pk B4l S 4 “Always Merge” % & & (12 %] 12 R 2 PR B FM B 7 XAREG)
1 A b oh 6815 = {E [AVO)4E A& 1% 3 [User Settings] | P 1% & 7 842 F= [Prompt For Merge or
Replace]#2 =i 356 KA o [EF % 2 4% £ 42 R & ki35 [Mergel + &6 5F -

® AP ARmAIGITRE s Fa%rhB EMILA GITE o flde > 1w R A £ 41 & Mac600 » 372 7
Jm Mac500 693 & 2| 3X £ M > RGBT 2 F il E M Aarie L E91E -

® T A% A [off] X M) o REM IR & M A 69 B bk - 3F tmik A B 6.3.4 12 R “Off” 2 B A% M 7 % B 1k

4.3.3 1 A ez e X § & &M

4.4

o RARE RA R BRI RR EHHEM o iR —MREGH T EATRENEZH > TH
MERKEE > LHMH LR EHDFER T EM -

1> a8 BB EF AT RERE B G TERE)
2> 4i: T [Record Cue] & #15% » % 42 3 42 [Update] -

3> TEHGHFREMEREAR B I T -

4> AR KA A B AR o

® MRITUA—REEFSANMEMEEEH > ABZX[ENTER[SEH A o

R ® ~ #sh Ao M i E A

4.4.1 B H/¥shFEH

% H [Copy| & #l 442 P =T A B | A% 3 A F M Bl #7169 4848 £ > 7T XA — RBAF B A A%
hEAFEM o AP RaeE A [Link] 48 £ 2 58 o R Hl/ M Haxt EREMNEGEFTAA o

1> i [Copyliz4E -
2> o) hE 4% 4% (Copy) £ #] s (Move)# 3 » & 3 [Copy| 442 7T tndk %57 o

3> T RAME > BEEHASHOOTER/EM/HF/ITFF)g4E o NP TARE
—ANEEAGTHRERNEIAT > ARELEAGE — kit ARELCEARK T
Azt (it g A F AT RERE) -

4> P A5 T RARR A R B /4 Hh K e i AAL E o

[ML]3%42 7T 4542 % £ > 1L F P ST LAk 4248 Bl B 4 /%% 50 /& %45 4 3= [Exit] i 4% o
[Retain Layout] & & # & 2 [Bunch Up] R i, —H » AR # —NEEEZME » fREIZE
ERAERRAE —ARLHE o

® & ##2 X > #iF[Copy Legends] & #] % #f » £ 4169 &4+ & 5 R k&£ 4148 Fl & A& - [Don’t copy
legends] % 44 B S BKINL AR H M -

® ##HH X > [Swap Items if Required| X #%7 B4 & » H3x4o 8 LA TR REFTHRT > &
WH R dsie g b o
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4.4.2 M Mk E A
R P 3 I & [Delete]iz4® » M RN B AR EREA XN A B4t 0 %0 BE LMk o
HACHM PR B 77 ik
® iz[Update Palette] & 37 % # %42 » & F M &% & & 7 it 4E[Delete] o

® i %k & [Palette]dz4t - M2 B M AEM BT » %G &3 f42[Palette Utilities] » Az & &3
it 4% [Delete] -

® ii:[Delete]d:4t » # A EM %5 o K1k 4z[Enter] o
45 & E EMEIR

4.5.1 %X B EHMHENEF
REEMEE > RRRT IR > B EM R T RILENE o

1> #HAF—ITH o
2> RAE M NE M ENBTR o

3> WIF RNty R & FM st/ EM B/ MANEM RS
A A7) HEAE[A] RENTER]# €

®  HRAE R LI REL A EH M NGENE ] 0 #4% F b3 fEde[Master Time] % & 4 0 o

© G AEM AL A T H I > T ML PR R T R A5 — A R R IR A
Ml LEMDETLREFDHAERA » 2RI o

452 BEEMEEAITEES
APTREEEMIITEAAGITEESE » ERGRAAFNAFTOHE—NEL > T2/
FHRBOTERET —RIRANKR o ik 4T L F & Fixture Overlap=100%7} F7 A 4T L & —
#2 &% o 4% % Fixture Overlap=0%/7 & & — B3 — B & % o

1> ARFREELMAZTENE -

2> 7 #t42[Set Overlap] -

3> b RFRFEAME o F AR o
4> EME B W R M o

0 HFRIEMIAELAEHMAEELNRE > wREFFAAE G ESE > 7% & [Master
Overlap] £ & & o £1% A ) 442 [Master Overlap] X & /4 100% o

4.5.3 &4 EAHMEH
st & bk &4k 42[Palette] % A1 £ £ > 348 7 484 E[Master Time] £ 8 5] » T X% § — M EKIA 8
FBEE o AR B EESRAAAEEMLE s RIERFHMA—NRRGE ML o AAINLGIR
e E R B AR o
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5. AW EA%R (Shapes)

REGRNEH BBFRNEZRGEARNEZXRORNARE s ESATEFPTFHATZAR; &R
Avolites ¥ £ ¢ 324 » %zt R 112 6 4 H — 1 shape generator(F Ik & 4 £—
MEZR) o RAEAFAE A A T AA L A A R bl BE L GITREAR - — 4R
BARAANTEAN—FZ S B EZA o f]de — AN circle(X] H)" 2R &2 AT KF
Fodr BB Sl RIT R ERRI B — AR o TTRARE R+ .0 & » B K]
Tt iR E - BHRIBEARETHOMLERNEAR - RERXRABTHBNET
L s 4] 4e colour(F &) ~ dimmer(i 5t)Fe focus(iR £) 5 5§ - A &M AR T A
4T Bl de focus(TA ) R B AR 0 87 A2 R 69 “focus pull” (7 £ 4% 3) &
RoOoA2ZITEWw REFRAEDROLTEA o B AN ITEFERA—-MAEXK
R FTARER —H R B R AHRGITEL, A AR HZ A 2] ENIT
£ AN EZRME CA1E4T » 4] B “wave” (IR 7R) R “ballyhoo” (dtA2 k1K)
89 R o Rk E 2R 69 spread(d#K) ©

50 RIZRERR

51.1 |2 A ERZRBK Furolites Pear Expert

Effects] 692 At dzdd » IMBEEZ LA TR RARE 2 o e

(Shape) \y & 2% 24% J & 1 48 IPCGBES 5% » A A P Wil 2405 16 ]7 12 o0 PSRt
R AR 5 R & P AF & AR S KR/ R AR B S
EREHEHIRK o

TRAPHBF-ARNELARN  F 22 RABTARLGITE
FE o

1> s3FIT R -
2> & I % # ¥ #%[Shapes and Effects] 2 4t 342 o
3> ix[Create] @] 2 — N3789 R B LR

4> 33 ReAE e FAE AR B M R £ A 5 3z [All shapes] £
THARNERRFSE -

5> A RAABE—MAR IMA—LF AR THFLHOABLR o
6> M EMRBZ MBI PTALBGITE L o

® R P4 A 6% (Touch Wing) sk 42
# > TA37 7 (Shapes) H B & £ TR
ISERIN- RSk s @ SR N NEE I ) B [ BlockShepe BlockShape Block Shape
and Effects]3z42 £ 5 A B A R) o g
(Shapes) T HF o A 2R 7 AP i
6y FT B AEAE Fl A B AR o R 6y &

Colour 1 Fiik Up Golour 1 Shake. ~ COOMTLSIED - o Step Upld

R Cyan Cyan 1 Magenta Cyan 1 Yellow
Mg TE 2L T RAMROAN R
R o ] 4o 35 [Dimmer] & B 7 AT A 18 4 e gt T g
REZLR

Dimmer Step _
D Dimmer Step Up
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NEARSRE G AITERE X ELFAR o

TP T LB A Bk R A (f9] b — A o o )8 i 43 A 42 o) 4 4 20 B b o T oA BB 52 P b
WAy A AR D RRE(LT—%) -

RPTUAR —BEE LR FHE BTEI -AERXRERAATREE o
1% [Shapes and Effects] ~ [Shape Generator]| A # 1% [Edit] T £ 7= R X RET

bo RARIE A A 2007 R oAa FI A B AR » B E £ R 2 BB RAREL E o AP TA 3
BB RAITEL TR T GRREFHAR(LT—F) -

® HEANREARRHARMAA-NMFZGENL  wRITEZRAMXEEARE  RPRF2E
BAEATOR o

& HENABRMRMA -—NERIAKRDFRERL -

2 & . %1% ] ‘Rainbow colour’s% $r il & M K2 0> & 2% F CMY 3% RGB & & P14 %4 50% »
ARG EHGREXR o

512 BEAABRRO KR IR E

BERNERXRKR N FREBRERE S - AR —PRNEZXRINITE wRXETF LB
TR AEIAL K /R E 0 545 5 42 [E][Adjust Speed and Size] 5k 32 VA B AR Fe ik B o

1> R ABEANABZRIRRE o
2> M A FREN A EARABER ] o
3> # 4 Ly LCD v W E BCR ALK I Aw ik B 2RAE -

iature
=0.0"

AT R IAA 5 AR RILBEK 1o i E 6 A

® WRMPARAMBE  ZHARHRKN/REERALE
LH R E - ,

® W RAPATE—AABHRAE 4R AR RLAEN L RLE R P T 0 [Edit
Shape] 9 i i # 4247 2 17 9 14 B R R 48 5 € 1169 % 3 o

® AEMRKIEEADLHEREE 5 HPRENHRARALL T AR KA R
4 o

513 BEEAMMTEAREZR I %

BAENBEARFARKGTHEZR s FRERRASANITE - iz HEH —LE K
“Spread(¥ #)" AL AR ERRAEITE P EA o

1> ¥ 3hfe4t E 3% [Adjust Phase and Spread] 8 48z fa " 4% o
2> 1% R K 5% 464z #1404 (phase) o i » AR A A4 HL B &4 o
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Phase=0 deg Phase=22.5 deg (Spread=16 fixture)

Lt %6 % k4 4045 a4 (phase) 2 A B 2T R AR o Blde 0 180°F 2 MITRE H 0 90°4
ANITRESR »60°K 6 MTEAERF o

L —AA LA BAREABITH » AR AV Pk BAK M EOAR  BRESR
4t E ¥ [Adjust Phase Offset| 2484243 4% o 4o » 4o RIREA BIT—ANF eAFEiR E
HR KRG ARSI E > R THBE RN KA > REF E 100%F0F 42 0%% T 2 F LR E
B U TART % B L F — A2 R 180°89 48 4% 47 #% (Phase Offset) » 4o £ & A A1 taF% » A A
AR BN BRI T AR — R ET 0 Taa R B R -

5.1.4 &) %1% %ok 4% 2% % (Pixel mapper)

(Pixel mapper){% % B 44 50 % R A AT L84 T 6 2 o 4T 48 28 % 7 sz 1% & (Fixture Layout)}T £ 7 5 5
B ARNRRERREGITELERGOLE  REAIITEA LA —/ 2D B4t 8 R o o1k
BT R A BRSO 3002 F e

EEAESATRHG T EME IR ERMGER -

HESERH T HL T

1> gaFkra o

2> TR 2 ¥ # 3t3%[Shapes and Effects]| 7 3k o 2 & » A 1% 3%t [Pixel Mapper]1% & B 41 o

3> i iF[Create effect] 2 3R o TA B EFRHABERZ G0 G LERITARHH B
RABMREGH R ZR -
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r y
Pixel Mapper Effect Editor (i fux

B N R > RF-ANAB ALK o

R FEFA"IR4 0 HFEF— N “Animation” ) & (L FRAH L EE wlT#%5)) c Hh@A KRB L
TAEZERTED -

Bk A MR G AR o AN IR S AP B REE KRGS TRE  BIRTRFRR -
mBAERXRBFETUE o

B REEDGH B LA RBHBHFHGT X o

Pixel Mapper Effect Editor i X
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14> 175 %% ~ #%[CLEAR] ~ & R 1817 ¥ 7 #2 47 7 [Pixel Mapper Preview] °

\Y

MARFER ZCEENRS ET o AR ETH B L > 5 09°Spawn Rate’ 3F % 1k #t
‘Pre-Spool’ » {18 B b~ AEF A M o
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6. 3= (Cues)

AFAZE: HTP = LTP i1 ; 24 @ﬁ%ﬁ,ﬁiékmmmﬁﬁ%,ﬁﬁ*A%%ﬁ+;
FRERN s RERFOENEEEE 5 B A FM Tk 7425 5 (Include) &,.45 3 #¢
ARG TALT 5 Coff” K A dndd mmmgﬁﬁﬁ,ﬁﬁﬁﬁrﬁmmﬁ&%

FREEATSIRARTE—NELGITHRES > MERARGRIEI MDA —EF 4 /7(Cue) »

PPémARBs PR A Bl O3 & © .

=6 H 600 4FH o560 T4 R 10 4 T F 7465 4 £ 5 42 /5 (Cue) E llﬂﬂﬂﬂﬂllﬂlﬂmmﬂﬂm 1

X % ¥ 42 /7 (Chase % 4 6’3% ) $HRRNFELAHTE o

1% Bl A7 F= flash & N 4E4z 4] £ 542 /5 (Cue = Chase) » 9 H R

MAAZEEXRIGEA - FRNXEN 10 M2 #EFH’%J — %o

+ %Iz & 7T AR & AL R ik /4 B 71 B 4f AT (preset faders)F= k4

# 69 % 74 % v (Playbacks window) ©

¥ FRF(Cue) it ZEFBRREY  ARTE—HINBETAR

)5 B Al fa iR Ao de T4 B o

6.1 4=

6.1.1 &R %Hi2

BRHBFE-ARENALERITEE B 2324 1B WBRBBERN - REM P TU4ER
i EMEBITERE » BT AR A ERXER o

BT RFTOITE—LEN > M2 & L FHRHEEH o

A CREBGITERBRERAGHEARBEEN  MEALXBFWRGERESZDELEEMH o 2
AP ZFF 2545 Cue)it » BAESHITAH THIELGMET X -

LRk [clear]iF R izit » A RBHRLEFTE - AP A AREEE ZiFRE4E AR TA
BN TR EFABARGITEFETELEE SFEKE -

&
A
3

L Swop | Fai  Swop | Hath  Swop | Fath  Swop | Fach . Swop
Roller 8 {12 3 g = P, T, ST % 7

TSI HUD & 0 R R4 7 B o A58 AT AU 060 B 4B 0
Trke -

Z4T(Cue) B 7T A FE 22 B M R B 4% (‘Include’ 62,4 3h fe 7T VATEAR AR BL » /5 4 6.3.3 F)

6.1.2 4l =x

1> #Z[Clear|iF = 4T EFemA2 5 T o
BHIT R RAL » HAEE R ARGBIGITEA &R EG -
3> 3 1 &.42[Record Cue] & %] 3% & o
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4> Feif At Loy I e “Swop 4 R ARIE P 09 E A AT N 69 kAR AR o
5> B [Clear| FZ X ERF K2 %H LS I+% o

ALK X QI3 F 0 e ) #E -
® PETAMEIEHET » AREFARFLG=DHRE O o

® [Record Mode Fixture] T B #4£ X » RGITEATH B
[Record Mode Channel] 3@ i& & % 42 X, » R ARG 15 269 & 1 ;
[Record Mode Stage] #% & F #I4L X, » BT A 4T LB M8 18 I RA 2k G s
[Record Mode Quick Build] iz Z 242 X » WA G HAE X EMH M E - 7
kBB XA T RAARNAZE S N R R o

® WRRFRZTH S AIFCue’ > TR E[MLIX £ 5 feddfe X £40 T - #&[Exit] & h 2
KPpFEX o

o AHEHABALFEADHET — h
N < . _— Chas Chas Chas
N SR N SR S NG A PRESS GO F!r.ll:-:;.??‘] n;.lhqu] F!r.ll:::[eﬁ]
”{i R 2% £ A % 5 —l’—/g AR & | /f{ %]- f‘g 0:10 L L% [ cCueRollerA CueRaollerA . | |
m e [4] [5]

79 EPM 7EPM S 18 EPM

@ LHMERED L TAENMNTRIEF
12 ;37{ T H— /’/‘Z“ BmAZ o 100.0% 46.9% 100.0% 100.0%

® ARHEUKERAEANTAMNTGLA NPT E AL B A Citlee % T [Set Legend]
BT LR R FEEHIE T L) &[Swop| S [Select]dzdt » AAERMANL AR > REE
[Enter]# & & % o

® AMBBEKIBEAMTRNEGD > 2R EFRT ALFoE B RANRE G TN -

6.1.3 ‘Quick Build’ iz 2 5 4 &

7% % [ Record Mode] 12 & 42 X, 4 [Quick Build] g # s X > fEB% MAA Y@ AR EME L
— A& o (R4 7T i Bl [Include] 6135 2h 4L LB 48 Bl 8912 AR R, ) o

% 23 [Quick Build] b 32 s 2 TR XK > ARBEMEDFLE > AAEHEKFHREE
LR HAEXREMELIF -

do RINFEAM RERIEANAF T OITE > F AR FITEARARBFEM R@AER - ZFEEH RE K
2 A& > % [OK][i2 % ©

614 ERAREXRIHZTL

B A A B ARAR T R B3 % (Cue) A ik 75 o P 7T sl — AR A ek A 32 08 4 B AR
BIPF o SANERRRBEATREA—ADTA o 5 XD FREA 5 > M IRALF
T/ B > H 5 63.5 T o

6.1.5 E 4% X (Blind mode)

ZGHBRXAR AL AARS LETOAEF > FRAEXZFFIRTHTHARITA
‘Visualiser’ /T AP B L » AP R ENIEFTAHA

Z%AFEPHEX > R {E[AVOlH% 42 42 [Blind] &7 > 1% 1& 7 M A [Active] A 4= [Inactive] & 2
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#IE o

VAR ART B —NE A LK 0 4& A [Playback Options] = 20 it 50 1 69 L 342 X, » AL & 442
FWERSERITARMEL  FomBEES -

6.2 PHFREA

otz 6 TR AR EARF > 2L AT 44T F 69425 » X L4 x4 HTP 4= LTP SR
6.2.1 HTP #= LTP i &

oA AT XA HAAE

® ik R KA K% A i R 3 4 ‘Highest Takes Precedence’ 5 5 4% % HTP o 4o % HTP i i 4
SATRERGDFFRE  MERHKFHFK WML - BHREEHF > HTP BE B
PEAZ S B A o

® L ihpr A EiE T4E/R 3 4 ‘Latest Takes Precedence’ & R 4% % LTP « S1R:% &3 % » LTP i@
BLRG BIEE » BEMRAT A4 -

6.2.2 =33 % (Cue)

1S F @ = (F ik Clear’ F i 45 A4 » AR AR BT E R G2 B MM RATAH
B AZAR A B B E ) o

® RITFERS AT

® TP ey) HTP (A b 44T 42 H] o 4] defRiedfiT4E 2] S0%E » AR HTP 1R 44 T % A2 0T 49 50%
{8 o

® o RZAXTIENEE o AT 5 0%LTP A E1E A AR T o (IR Cue HHEXEH
‘Mode 2°#% X, » H 4 ] 6.5 ¥ ‘B g o

® LA Run’ZATAE X A P 7T 3% & & Flash’ 348 4039 & o & 7T @ 3 4% & & ‘Swop’
BREAE -G F o PR XMEEERFGHF -

® 1 7 1% F ‘Preload’ Tl £ 7 A 1% & 5| &k & ‘Flash’f= £ & ‘Swop’#z42 £ » R A RETI1RITEL B
PR 3] 3% E ARAE AR R & b o i Preload il » 32 /% [AVO] 4% 42 A& # 3% [Edit Key Profile
BT AAE] > kARG R &R E e miECE SN 11.3.4 ) o LA RET o BB PT A AE
FlRMegdzdt L » AAANTARRBEREIHFZRTRFG > AP TAGERQ R —IERE
SARAE A o

6.2.3 ##HEH R

BFo@mAEFEELFOE N4 TEELRoller’’ 28R > BANEHAIR o

do FAR BT Cue’ £ TR B A > F %4 742K L ‘Pages of Fixtures buttons’¥7 B 7 4% 4% &
W o

® LRE[MATEDAIFAEMA » RO AyRAEMFEF LGHT 0 F RILMEAFIZT 2
0%fE > A AEEI A S W% o

MR A S oadeitarh i o

RPTAE AR BRAEN TN OFEL  GHRELTAEE S RGAFRPINE L TR Lo B4
FHE o 4% B T 425 % % [Set Legend] % & % & » X 4% ¥ [Page Legends] 7l % & » & 3L 3 £ &
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AR BERALRE AR R @Az & 6 %A o

6.2.4 BHIEIT P B
R P 7T A3 i3 ‘OFF & Release’ 7 68 & ] iE 72 32 /769 & A2 K, © 4% ik & 4242 |OFF & Release] » /&
#% AR TR AR A K @ Swop izt o 4o RABZPT A IE /2 35476942 X 3% [OFF & Release] %
4 > K144 9 Be4E[A] ‘Release all playbacks’# 34 BT A 1 34 ©

B AR XAE 2 AN FRBER » T LA $£ 37 F B Release Mask® 2 #3032k B % o
® il P AE R RIEAE L IARE AR 0 i [AVO]+E 5442 X [SWOP] 4% 42 -
® Uk F — /N [Mask]| @t o £ B B 3B 2@ iE o [Release Mask] % 7k @ 2% B 1515
HE 6.6.1 F o EFIHFILT » FTA B BHGRZALA ELREZGHGKRES -
6.3 mEPHE

6.3.1 EXEHRBIHF
FP TR A EGDFEM— DA RARR T ERLH DT o

1> #[Clear|F = IT EAn A2 B T H o

2> BITERBOF > BRRLGEAR A EHARXLNA) o
3> BHFZEFHGITE > FHATAZ E A o

4> 1% [MEMORY/CUE]#:42% o

5> Jz 463 % & & ‘Swop’ iz it o

6> #z[Merge| &7 (4P B &= 5 4% 7 E £ %4569 A

> EEKEGFRIBCGLAGY T > RIEAGBEREZE #A o

® WwRIEBAFTLEZLCue T £ LEFF 6 i bt 4 [Replace] %4 o {2 21242 1k JE1R 2 ik
3% [Record by Stage| %2 k % & 4Z X » T W& A EAT L E 64T B R ARG ©

® R o T AL B 4] 6 ‘Always Merge’ & % & Cue 7 ©
(3% AVO 4Eik“User Settings’ Al P % B Rz haest A 15 &) -

® P KRG F I B Swop st o 7 vl [Merge] & 5t it R (b ik 2h AR AR T T BR) ©

6.3.2 R ¥ Kk AL &9 KA A

B R E BB E N A RAEN BB RRRE—ARENHE - REROAE
Tt + [Update] & 41 2 f it R Hei B 41 2 3 &M AT -

PR AT Bk B AR R R AT AR R ) F

1> R — AN BIUTEGRBRGBME - (Hldeif &)
2> iz[Record Cue] 2 % ¥ & » A% % 9 rc42|Update] £ #7 o

3> {z[Enter] PP £ #7135 % WA » AN AL THZHEHOEMFE
T 4% R AH AR L A R AT o

4> o R 2T AL FERM > REZK[Enter| 425 K 7 A £ 37 o
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RPTALESRI SARBILTEMFEN  BELHEMOREBAEAR LA EM o

W RGEEHFITEBESR » RAZEFLHOREGEM » EHZRED T AR X EM 2KH
Ml g o

® WRGEEHFITELBIL  RACHARAOEMA > FH T 2WM R o

6.3.3 & €343 % (Cue) Playback View - Cue RollerA[4]

25 & %7 Cue B8] » F[View]4E &

BFEEAGY T E G Swop’ it 0 &

fik 5 Bt ) ‘Playbacks’ € 2L & © %48 X )

FREE - INEETELETH T W

IR ~ EANE B TS KR BN

Bo AP T B R ARBEA P AR B #

TR o

4o RAR # H R AR EKE 0 A [View]4E

KRR 5 A& F % ‘Playback View’ % o T

#¢‘Cue View’ 34 » 47/ % 0 “Cue View’ » T 7 3% %48 A 6947 L% & 6 18] 1% 20 K4 o

‘Cue View’ A Wt & A4 X1 /K-F‘Levels’ ~ & #f ‘Palettes’ ~ B |5 ‘Times’ ~ /] & 2% & ‘Shapes’ °

ook AN R A AR TR E D e TRARAZ 6 LT U R £ AFE X o

® ‘Level KFEEBRXME > LT H—AMNITELEG B MM o

® ‘Palettes’ £ £ A XME » L& A 69 FM TA o T LA > RT AL R
Yo 35 % M T B o

® ‘Times’B R ZAHEXANE » L T=Hw ZITEGAF| B F o {24 RZF T ‘global’ # 3}
AR AN LT EE o

® ‘Shapes’ AEXREAFBRANE > L-HEMITEBEOAREHLR o

"

Cue View -

Number | Order Dimm.u' Sh.ttc: P.'.m T|||: Colour Func Col\:u.r Gfa1 Ra‘:l Magmb Crcx".n Yollow Bluc CMY Maoo Cnbn 1 Func Gubo.l 1
CirSp 1200 1 100.00 gele=y] - 55.04 | Foed 0.0 0.0 9.6 - = = Index 0.0 |- i .
CirSp 1200 100.00 ' Closed 3. 57.04 | Foed 0.0 0.0 9.6 |- - = Index 0.0 |- = "m

Cirsp 1200 100.00 | Closed 57.48  Foed 0.0 0.0 9.6 - = = Index 0.0 |-

CirSp 1200 4 100.00 | Closed .33 54.11  Fxed 0.0 0.0 9.6 - = = Index 0.0 |-

CirSp 1200 100.00 0.0 0.0 |- = = Index0.0 |-

CirSp 1200 100.00 X 2.0 -

CeSn 1700 { ¥ G

RTS8 AR 0 H— 3 B 1 60 22 B © Bl 3 AR S da b s » 2L &% B
B0 R AAR SR TR 64 BIE 0 S04 HHAABUE o 47 T A4 1 [Delete] #e 4 Ml i it
TR A A o AT P S BP A

6.3.4 &4 “Include’s) %t
B A R R BN~ RS AEDH RS - (AEHLTRAFHRIET 047 LA
THEINRER) IRl T L LB A BRI AES  REGKBEAFHH T %
GANE| e W
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‘Include’ 2 48 A A A+ 42 X, » ‘Quick Include’ % 62,44 2 ‘Advanced Include’ 5 %% 6,45 o ik 6,45
MEREHMBEAN Y T SREOETABE B FTIT LG L LEHAEREINREE o Flhe
RAE—"PE > GE8ANITRNLE ~ fef B EEMMA 7T A% Al ‘Include’ 2 42 R w3k 4 A
TR & B A B RAR R » KRB A P Include’ o i 4T A2 & B A2 RAZE » A HILA
QI FTHBEL—ANFHGP T o

do R P2 o 8 A 5T (chase) 338 5T 5 7 (cue list) - i db B 7B L& B RS MGIA HE o TR
MBS 4 A SN T LI R o H, -

1> #%[Include] 1442 (I A e F42 8 L)
2> 1 3h A4t k3% [Quick Include] Bz ik 6,4% s [Advanced Include] & 2% 6,35 42 X, o
3> 1M 6935 I & [SwopléE o 4o F 4 [Quick Include] ¥ X, » 283 R E

4> 4o R 42 [Quick Include]#E X, » %% M 8 Fi A 4T B4 B sh ik b L » & 27 Lk b L ey
J:T‘)a\‘%%%iﬁiﬁ: ’ j?lé\){&@_td:Tva: LED J:T/ﬁ\%i ) &U%K%ﬁﬁﬂl%%ﬁj‘-ﬂ; ,
T 4% ST AR B AL o

5> {% A % % 6,45 £ X, A 60 [Set Mask] %,/ Pk 4 47 4 4t 5 B 4570 26 i 1 o 8, o (30
C[Set Mask to exclude all] 5 /] 5 # & 1+ » 2 f4¢ D[Set Mask include all] v 3 57 # &
/]i) o

6> ¥z[Enter]4E » kit 69 B M B 5] HAZE o

> FEEFHE2 T BEEITEERARE  REZ TR 1 wBLITH -

® PRigAHERXT » &HEHFA T AL Mask RS ANBERZE -

6.3.5 1 FAOFF et reip xR EN
‘OFF’ £ M b fe s £ M 589 F(Cue) B R P9 —NE M bR IR B A e FiT—4Ho

Bl 4a s BEMRIERT —ANET R REITAXL  RERARE - BEEZRATEAN
EAINEXEL  IRFEAONN XA A EFALX LR E o 47 A Off” X F 2h I L F
RXFHIERITE -

18 RO iest AR CEF—NBEEAR - CFRATERICEEME -

1> 4% A [Quick Include]t i 645 ) Ge(f2 AT — 7 $438) o he 8.3 AR BA5 289 B 1L B s A2

o2
a5 °

2> kT etyOFF 4 » - <OFF % #£ o
3> ‘Cue’ P E N ITE LRI » ho B RA BRI AT B > 45 0T B A2 BUE I o
4> 1% JF oy A AR T AR AR M| RN 2 B PE o

5> z[Memory/Cue]4Z » %X 1% 4% 7 it 42 & 3F [Replace] B 442 X 12 % » A% 8 £ #749°Cue’
WAz % & [SwopldxiE o

® RI A ‘OFF 7 &g » 18 Fl [merge] & H R X & H 2 IA H*x o
® R LE % OFF 4t » X EM oy Bk o
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® MrhBMIZLAHF—AF X M Cue View & 0 #1755 M 6.3.3 F)

6.4 ZEH ~¥esh ~ RBEEFM R

6.4.1 E #l/#&%h %% (Cue)fit 5L E
1% A [Copy] & #I/[Move]#% b /[LinK] 5% B Fe4& » T vA B I ILA 69 & 2442 X 0 & A 50 B — 9769
= A AEA 0 R E —MLink) X FEE AR X o AF—NMREETEA - BaHREXHKE S D RALX
(3% % cues ~ 3 )T chases X347 5 7| cue lists) °
(Move)# 3h | sk %32 % 4 & o (Link) T {213 & $ A~ @ L I F — /\@z‘iﬁzﬂ s AR AR AR AR o
(Link) = %4 69 © A2 X Z B 7 2 — A28 » CA1ARA A8 B 69 = 20 54} > 1248 T 1% 2 €A1 Bl 69 B Jq]
Fa W& FL LR o

1> % % & [Copyl4z -
2> % fe4t %, [Copyl4t » 4% (Copy) & %1/ (Move)#% 7 / (Link) % 3% 7 #¢ o
3> E R R A/ e/ KB AR X L & [Swop| itk o

4> R P T AR F— A B AL ST RE 0 L RAFEEE A S — A [Swop|dg sk - AR
B+ & & — 1~ [SWOP| 4% 4% -

5> AR % B 8 = [SWOP] % 4£ ©

® [Menu Latch] 3% 3 4 3 4% » =T ¥A4{ (Copy) & #|/(Move)# 5 /(Link) % Bk 25 At 3% % » £ & T L
% 42AE R 38 A L F Rz [Copyl 4k » dx[Exit]|sE 4 TR B X % o

® [Retain Layout] f% 4 ?ﬁ/% H[Bunch Up| R & —A » RE R H B HBGEDAFTHREGRA
09 2 AEAL B KK

® [Copy| & #|# X  » £ 7 [Copy Legends]/[Don’t copy legends] £ #] &, 7~ & £ #| & & » %
BZ R B LAR o

® 7 [Move|# 4 X P » % [Swap Items if Required] Z 327 B » % T & L 69 & 3035 35 i# 0 o
THHLFE RAEARALE

6.4.2 M %3 (Cue)
EAEM IR

1> % % & [Delete] 4% -
2> 1% E MR & 69 © AL X Ik & [Swop| x4k o
3> & & 4%k &[Swoplizat A A M 1R & o

1% [Menu Latch] 3 3 4 3 4% 7T SR BFSEM A5 4K A » 1 F £ & 3% I & [Delete] 42 » % [Exit] 44 A
TRBEE o

6.5 HFH I
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BETREN ST hEE o
651 ZEEENEEFE BN

FANG AT AR E — AR s FEAFodk 2 H3%E B aJa] o
SITEZ R H Tt R ETRE AP TR ZELE

‘Fixture Overlap’JTE Z & » xR IT L
ARy — (R B)RCR)B AR o
fi'F B+ IE }% £ 7 LTP 8938 18 S fT X T

% =#EH L5T HIP
i§ &K AR o

S EXNFR K B AR o

,»— —
18 4o T R - sk B A ) IT,Ji)ﬂﬁﬂﬁnéf /)\ﬂf\HT LTP i
5
o LTP values
o remain until
& changed by another
playback
(in mode 2, LTP values
fade out)
M Delay time [ade time Playback active !
100%
% Playback
5 lowered
5 to zero
0% 4
— s 1
: Delay time Fade time Playback active Fade out time’

Fixture overlap=75%

R A A

% 1 7 1
12 3 47|

fixtures in cue|

anjea 47

Fade time

Positionf

fade time=3sec

" Delay time

Attribute fade times

pd

Colour /

fade time=0.5sec

anjea 41

\

Beam

P Playback active |

fade time=5sec

Fade out time’

De'l'ay time Fade time

: Playback active &

" Fade out time

B A 1% B R XA

1> = E
2> w5 A2 X Ik & [Swop)dx 4k o
3> iz[Fade Mode x|
4> [Delay time] £ 1R

¥ % gy se42 A[Edit Times] % 2884 7] o

TR CE AR EE TR -
B R] s A AT A A2 1R AE AR B R B AT

o ] o
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5> 1% FFAE B Ao dr AT 89 0T 1) (RALAY) 5 A4 Enter 48 LR A o

6> [Fixture Overlap|#TE ¥ & » A TITEE &G 2 > T 0-100 - 100% Z kAT A T
A—#E 0% ERE—ITEZREANRE ZITEA T4 FH1E > 50% % —ITEH)
VEBAT—F 5 ZIT B A FH48 o4 o dT B89 )5 & AR 335 07 BBt 69 R 5 (AR =T 2L % 32
B > %M 6.52 %)

7> ¥ Exit 42R B E %

® {RIT T A% E Ik 569 IPCGBES ZHiR & A2k Btbat ja] » 54 M T —% o

[Fade Mode] & 74 X, 6% &
Mode # X 0— ©HAZ X BA EANK B HFE o

Mode # X 1- EWHAZXZE T KK B R o

® Mode # X 2- &1 F#HEFEHF DAL X E K BB o
® Mode #RX3- IHREAXRLXN » LCEABTHDRAEXNLRBITEA -
® &u%@zﬁzé& BAENEIZR REEX 1 2 ALt E > REEKX2ETFRE ML H1E

f}%"ﬁ/']k SRS e

6.5.2 1% iE ¥T B2 & (fixture order)

32 EIT B 6905 A AR AR AT BB 690k 7 0 42 7T 1A 38 i [Fixture order] 45 4~ 200 5 o

1> 3T 2 ¥ % 3 442 A[Edit Times] % 4364 1] o

2> 'ﬁ{' {'&‘fiél]@b'iﬁif\‘ﬁt é[SWOP]"J}#‘ﬁ\ Prezets |-30 PresetPashes |-30

Robe 1200 | Robe 1200 | Robe 1200 | Raobe 1200
3> 1% 3 fe4E|Fixture order]| )T B8 2R 5 4% o 1 5 3
4> iﬁj—%% 4—;% [A] = E. ﬁ'] 5 ° 1 0 . 1] (1]

5> 4o R 1748 B 33 )3 2] 5 0 1% & [Autoincrement] B b % 3% 4 ON’ A B o 4o 48—k
STEAARGF7 5 » F L% EAHOFF X H -

6> /57| 5 L3 HDU Ao 7 BALE b o mds Rt dr Bdgdl MR EAF I PO E o

4

CirSp 1200 ClrSp 1200 CirSp 1200 Cirsp 1200 CIrSp 12004
¥ ¥

| cirsp 1200 CirSp 1200 Cirsp 1200

7> 3 |Exit]:& & E # o

® RIAARBIUANNTEAAMFGFI 5 o LERF » Blde > BEMER > ARG FI 5 KA
F) — B 18] 5 R 4 69 S 4 o
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.82

® R LAIJF B P M 4 Sk X A HT R 0 3% [Autoincrement] B 3 3% 3% ‘OFF’ £ [ 4% T 47 B i3
BRR - ITEEAFISBE R X BRETERETHEE G5+ o

6.5.3 & EHFEMEENK BN

6.6

TTIAAFFANBED (i) MRZETENEERE o e RIFRZELT —AKE CLEBEET
g B Ja] o
% B — /B PE GG EGE R

1> 3% TR 2 % £ 7 4t42 A[Edit Times] % 38 04 7] ©
2> 1% F 15k 0 & 3 A2 X Ik & [Swop|dz 4k o
3> LEAM 6 B ARAT RARE BT Bt esd o
4> jz[Delay| 1% & % 3R B 8] 3% [Set fade] % & % N\ % B E] o

5> 1% B 3k T4 & i A F7 69 BF 18] 2K 4% 3 Enter 424% 77 € » 4% [Use Global] & il & &% & »
M 4 By N 89 2 PEEY TR 0 ) B OE A B ] o

6> 1% Enter 421k 5 H X152 o

RTAFBIA A T AL EITE B R EENEBTE c 3RFEATYOYFHK > REAF
ARIMEEBHLZ R BERETRAOITALE &[Swopldast » AR ERALIEZ6FHALE
PEESIR] e

L Cue 2EBUAL FABBOY N » TIAARITERB A BIZFILITE £ #I/T5HE o
¥ [ALL]#%42 %% Cue APT A IT A o
éﬁ’:/&’b‘kﬁ.}éj'iﬂﬁlﬂ ﬁ—‘ﬁﬂﬂ’ ’ "ﬁlﬁﬂl?éﬁh—ﬁ:j‘/ﬁ\ﬁﬁ%ﬁf{— o

2 % 3% R
I % % F #[Playback Options] = 73 » =T vA Bl k% & 1< F|] £ & ¢ = 342 X (CUE ~ CHASE #»
CUE LIST) » A& # 4% © 342 X 15 & [Swop| 4k # 47 & 2 i 4R 4F o

6.6.1 #&7% v &t (Release mask)

[Release Mask|# 7 @ JE » TR & A8 & B A B AT I AR A o =T XA A
By PEARAT 1248 B B HUR % B 4 0 BINR B & AT B o

EEEABERIETA MG > B e A A — s 89 91 ] 2R o 3% [Release Mask] 5 % 4 91
1] &, 1+ 4% (Titan Mobile 3= & L 97 1] B M 4% 4% £ [Intensity]) » 2072 © 5% A &9 37 11 B P B 2%
BLARN 6 R A AT T 90 I‘*]

1% PR B e B R SITAE X, 0 AR E B e [Mask] 42 5K # A 45 B P ds4E o

6.62 HIEAAEHAEZRRT/RE

R cue BEAERREX  AREBACTREARBRR M REATHETFHH -

6.6.3 2% (Curve)
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.83

(Curve)®h 2, & L& 5Bt » B E4e T TALEN o AP AR BLAAEAN 115 ¥ o

6.6.4 ¥ 2 W (Handle Paging)

W AT R AT AR 0 R E AR X G R HILE LB E AT L o 4o RARA — w4
XBEHE—TEAREREH EALAERET LHIE—T o

A EABEX T o ‘unlocked’ 4T 145 2 ~ ‘locked’E4F I 44 & #=“Transparent lock’ 4 47 7
FHPRE o e RETHEFRFH AR SHETNARLE LXAUDAEXESRFA ALK -
6.6.5 & 4L A (Priority)

£ LTP 895742 » R4 8 A 69 & 002 X 42 %1 & 3798 50,8 38 & 1% » 4o 71 & (colour) o & 4 A2 T
PLEE S ARAR, S A8 @ A K, AT I R P o

WRAR oA £ ¥ ¥ 1% 3% [playback options] » b 4%F 1% T 69 & 2 @ A 4 F1 4K oA 0 (Low) ik
(Normal)-%£ i@ ~ (High)& ~ (Very High)3E % & o
6.6.6 2Z 3% X (Blind mode)
5% W T VA R bk PR % B A (Blind mode) 23542 X, 0 A XA B R B R A5k
B (Visualiser)}T £ A2 E » R 2B FSE Lo IApGERARREFTAA o
6.6.7 4% & (Key Profile)
HF— AN T A B fk 6948 1% B A R AN M1% B @A s e 4E A o

1% 4% [playback options] 2t 5z 49 3 442 » 4% (Key Profile)42 1% & - LA % & LA B 05 =4
WA W AR L E LA o H1% B A ‘None’ By BRIAX E LHE R A o

7. 33¥T (Chases)

# A (Cue)3 % 89 2146 | #(Chases) 32 4T » [ fif A 70 W23 F RAE XN W4 G v ziE Lk o
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.84

(Chases) 32 )T AR B — R R AW & B B4T o 47T AL B 384T A 51 (Cue) 3 = E K B ] e
DR AREZEIT RN EFHREEN DT TIGOREA 441547 o

71 QIR

7.1.1 %% —/~3847(Chase)

#)7(Chase) % A2 » LA ARITNREZEANGF » AREEHREG - WITAEANDZTTAF S #H
STEAFAITHRAR » RICIA 69 (Cue)3py T Ao HALT o

1> 3% ik @ [Record Chase]iz 4k o

2> JdfEAF L oG K & Swop A2 AR B 69 A AL E A 69 Ak s o
3> LA FFHRELERAILA G(Cue)sp w0 BIWITADH T °
4> <7 4% A oh 454 B] & 2 [Step Number] /5 5

5> zife4F £ 69 I & ‘Swop’4E 3 3 7642 [C][Append Step] it e 7 o

6> z[Clear| F 2T EA R AR TH(IMERBEHEANIANARLAL) REETE TR
3o

7> % [Exit]42 4% %5 (Chase) X BT 4 & % & & 1 A2 o

® [Record Mode Fixture]i2 FITEE X, » kG IT LA B
[Record Mode Channel]iZ. % i@ 4 X, » 2R 515 f!( é’] Btk
[Record Mode Stage]i. sk # 6 X » AT A ITE B fﬂfifl‘/\f%ﬁr
[Quick Build] Big 2 542 X(FH A M T 7);
® RRRERAZHRCRESZNEEY TR o
® WwRRFH KETNH T > T vA¥[Menu Latch] £ £ 442 » RIFUEC KD T EE - %[Exit]
B BRERRK o

7.1.2 'Htii%iﬁéh(Quick Build)
BREIBEX > AFHRARIBINILA GEHAAEXfe Z M E—ADIIT ©

B4% R deh e 0 RAE L —F T E JH 46 A 4T(Chase) 5 /& ¥ #12 & 4% X 4% [Quick Build] -

BHHFEATEAAZ X RFM R B IEANBILIT—AF > 7T R B335 5 A E A2 XAF A 30789 £ 4 —
ﬁ- ]

TABBINE AR REM ABFAFCOITE » AFALFITEAKGHFD AR EM o

7.2 &3 (Playback)

7.2.1 B4 —A3IT

EATHNT 0 32 5 B 369 3 F (R4 7T vA4% A Flash / Swop #24%) o 4 R0 RAT B T S AT E4TH
FTEg R E AR o
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.85

33 BPM
IPCGBES I

Swop
Flash

® SITHY(HTP)EE 3R e A 324 » e RENK BT R A A2 o Lilﬂﬂ%ﬂ:ﬁ%ﬁ%é@ﬂ(
F oo (LTP)LJ\'ﬁﬁ%fﬂﬁlkﬁl‘f\’fi/\ BAT o ARAFT LA R Pk B X ¥ A% B(LTP)@ & A 3
AL T A &A4T ©

¥ )T e LCD B # L 7w FFFEmiz B o

BT A4 5% 46 B3 69 [Stop] 4% 42 4 815 L 38 4T ®I 31 4% [Go]
W BB o

RER GHATARE » AREHWITE RS X > HAAEGL
R L o

7.2.2 FEE—-ANBITE X E 4

EATHITAL X, 0 32 5 B 08 3 F (IR 47T vA{% ] Flash / Swop #242) o £/ 369 K AT B 7 & A1 E47
WITAE X TR -

L@ ABITR RN » £ %4 8 3Bk EF X UEAGE B 5] 4% 46 F0[Stop]/ [Go 542 42 4] » X 3k

AFTIB O E TR o wRIRA BT —ANIITAR XA D 0 77T vl 3% % 3 [Connect] 2 4% »

RBZFLF —ABITAEXEE REH

® iE 3 — /N ITAE X (Chase)ds 4]0 4d[Connect] 442 » X 1% 3 4R 48 3% 3 4% %) 69 3,47 42 X [Swop)]
b o

32 4% [Connect] 4% 42 7 71 ¥ 7 #2 X (Chase) 69 & 3 42 4] o

RIT AR PREXE B EFERITRX Pak o AL A F3h42 #l 4% [Connect] & #3472
Az H o
® ERWITAEXEZHE wREXTTECORERT LEANKBEE > HOXELAHKSG -
RAT AR EREQIITRZRXNRAZL L > £ PR E(AVO 48+ P B A% &2 fE
C[Connected View Sets Temporary Chase Speed] & 3% & & 32 T2 X B & B % & s e B 0 4o
RARABARAG AR5 2O e B 3R R R SUENK BB o ST 4% A [edit time] B 8] 2 £ B A ik
[Save Temporary Speed] % 74 I& Bf i & o
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.86

7.2.3 % B AT B A X LE N B (Crossfade)
ERBITHRRERA RS EP £554 > R B FALRF4F T FHEBPM)EY &7 o MRIE T AMAE
RPN Y 3 *faﬁi s ARG REBEAES ENRERML 2652 8HRE -
) % (cues) X 7] 89 5 UK NGK i ‘slope’ 3 B o & LK X% i (Crossfade) (1% F 0 B » 47 B 283 1|
HFNT =M% 12 % (Crossfade) % & 100 & > ;T A2 BT EA G ZTHEAAH#AANT —AFHx -
(Crossfade)fi 1% & 50 B » 3 F QITE BT A ER —F » 5—FagutE %4 o

Crossfade
Crossfade=0 ~~j»
Crossfade= 50--—-_*
Crossfade=75
Crossfade=10

anjea 3indino

Cue 1 Cue 2 Cue 3 Cue 4

BTERXXUEANEE R E S Fhe T

1> JATR 2 X % F& 2 fe 42 [Edit Times| % 5 04 18] » K 4% 4 & 1% B 6930 )72 X i & ‘Swop’42 o

2> 2% F T UK K H(Crossfade) » 4z [Xfade] A= 3 A 3 LE N A 0-100 > 0= H L
U 2 100=% K X LK R GeITH —F —F Rt ah) o
3> 2% B B 0 ¥ [Speed]| i N8k B AH R » A1k 4 ([Enter] o

A A A 4% 0 IR ASHAT B ] 3% 3% 6,45 4T B & & [Fixture Overlap] % & » A %3155 % 8.5.1
REE

TAABITRANEN T > RERRN A WA 5 ZAEZED R > 8405 583 T[Go]

AT —FH% o @BiL4¢ A @& % A (Playback View) 3% & 7 [Unfold] 2 ¢ » 7% % 8.3.1 ¥ & o

Tk BB B AZ(F) S & ¥ 38 BPM)o 45 [ AVO]+1¢ Al %1% & [User Settings]> % % & [Tempo
Units]*f » % & ¥A%r[Tempo Units Seconds] 2%, 7 44 [Tempo Units Beats Per Minute (BPM)] 4 & J4]

$4 o

7.2.4 FHEHEITY
Jo R I ITAR X5 1 B 42 46 3 69 [STOPE b4 bt » ) P A2 T a4 T A 4530 ITRE X » 2 T4 &
[GO] 42k B & 33 IT ©
W ITFE R G120 » T 2l4E F [—]-1 Fo[ -]+l 425 a8 FT— AR E—F o
& 7T VAAE A 424% B [Key Profile] 1% & & 7069 1k &, 4n & &34 » LW ITAZ X B & K48 o

1> %1% [AVO|4E 4= i% 7 fe 42 [Edit Current Key Profile] o
2> Ju RARAE R 69 R R E XHME R T R 5 » AR R TIRB I — 3 6948% E L
o

3> ®BEFH &G ITAE X(Chase) » K& % FE & Xk einid ks shie o
4> )N ek % > #IF# A[Go] K 4T .E[Stop] » K&k B K Al KEXIT]4ER & % % o
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.87

5> &[EXIT]42E 3 » 4% =% 6 o

7.2.5 B ERIBITENT G
[Connect]4z 4 5 1 ¢4 & &, [list -1]F=[Next Cue +1]4242 X B4 # 3| L —F X T — 14 » [Peview]F»
[Sap Next]3z42% & 7 @] ©

7.2.6 38JTF BkY
AR T VA B 3 3k B 4T 42 X (Chase) ] E  — /3 o 4%[Connect]42 » REMAPTE 0 F 3 » Rkl
[Enter] s %) £ 4Z[A] ©

13 BT

731 FHHITHRE
4% [Record Chase]4& » & # 4% 4 47 £ [SWOP|4%: 4 47 /- (Chase) » 377 1 & % A3 JT RAEATILA
B o TANIEITRY Aoy & » TARE % 0 R #lHITHRAF —HE 42 [SWOP4E » 25 R T A B4
2K o
R A IBIT NG G % AR A E A ) R [View S R 4% A X AT L[SWOP] 42 42 S % g it
B E(Playback) % O d24%) o A Z e EATRT AR EA T AL R R > RELLFTERNA X
T A BT 18] @ 2L o

Playback View - Chase "PRESS GO

Link View Cue

Global | After Previous

Global | After Previous

Global | After Previous

After Previous

After Previous

After Previous

7.3.2 A ‘Unfold’ /& F % & — />34 ¥T (Chase)
‘Unfold’ & 7+ 2y B3R Bt T 5B —#0 7 Xk % # 3 47 (Chase) A &) 37 % i 4] o

1> #[Unfold]4E » it % % % 69 32 47 (Chase) # 47 L &9 3k & [ Swop|iz4£ -
2> BWITRO T HEEANT20 ©ERHEFAF -

3> fAREHIE T HF LB CURAR B R ETIERAR) -

4> ‘Unfold’ & 7+ X £ A &AL R TR & HF > FH4T o

5> A k¥ T[Unfold]4E & ik & 4 X o
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.88

® 4%HEPYTANE: Z[CLEAN|FIA4E » A3y R @3t F » #4782 T » 4% [Record Step]4it
T AR#%E A FZG[SWOP) &4t o

0 LIHEN—NHFNGFTR I BHE—NHFH T > #&[Insert Step|dE N T4 0 KK HIFIE N F
A4 B 69 [SWOP) 4z 42 o

0 RAEANYFIRFTEAN—NHH T hE— NP % 0 Z[Insert Step]IE AN F 4 » AT 5
(42 1.5 A 2EANB 1 F02 FH) » AN T TR BFAB T XS FAHFRE -

® BT HMITHAGG TN o H[Edit Times] % 200 7] » A4 3% 78 3% % [SWOP] 4% 4 34 A
Y5 RBZENE o

® WRBITAMEFERS  —R@BIRAFFRTEMTRE > 7T AR 2 sesE[Previous
Page] £ — 71 #=[Next Page] T — 1 & & ©

74 R# >~ %3~ REAMR
7.4.1 R H\% 5 3% F 3847(Chase)if A1 B

SEITAR 7 "I B A Ah 24 2L A — A= AT » 61— A-(link copy) =1 3L X H Ak I - 33k T4
PP AR EH & o (link copy) @ A X B N > ZRM P BE S AT @ kRS HAKHKAE
J 7T A TS LB IR e & 2 60 o

iR T4 5(Cue)ta R o £ 6.3.1 F P HiEmiLA o

7.4.2 M M3 RT
1% [delete] M Fh4d » 335 F M MR ITA 5 » R 14 4% 9 Ae 42 (Confirm) 4 1A

7.4.3 38T (Chase) F #| 4 — /¥
M| & (Chase) #1142 5+ — M= ¢

1> iz [Delete]4% -
2> % FIITA T 69 [SWOP] %42 o

3> WITRFFHADF T EERFLI G > A A EMNEFZMRY
BITNY T M R o

4> iz 3 fg [Delete Cue X]4Z o
5> 1% 7 t4E(Confirm)# 1\ -

A oh o F P eI vA4% A [Unfold] & F+ 3 Ae Ml Ik 3 7 F o

7.5 &K EWITH A
7.5.1 38T &) %4k (Global)bf Jg]

S 0T 6 HARET ] 0 BE AR B R B ITRITETE 0 A EHEANY K EATH R TR A4 F 69 o 4o AR
1% HF A% 2478 E] > T Al (Playback View) % © 2 (Unfold) %) 8 # AT % B 1A A T — T ko

1> 3% 2 ¢ [Edit Times] 42 % 35 0% 18] » A& 4534742 /5 69 [SWOP[ Iz 4¢ o

FJ“‘“}%‘[*& (BIF=) E ARl F1iG - 852-2898 8666 & 2! : 852-2558 1282 F4F-: www.dnein.com  Fi[l : dne@dnein.com
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.89

2> 7% E [Crossfade] I L% N % & ~ [Speed]i& & ~ [Fixture Overlap]| 47 £ # & F=
[Attribute Overlap] & £ & & o 4= T A% EfhE

3> 4 [EXIT)42& & o

® % F ik % #z[Speed]dt 0 RZBIAFHTEYRE » ik [Enter]# £ o

® X E T LUENE L I [Xfade]dE > ARZ I AN 0 7R &-100 > & % 3 [Enter] # € o

® LCRUNWEATEXA » T[IAE B EERITAZF iR E » BT 5 #[TAP TEMPO] 442 o (3t.3)
R AR EEIITRFE » A S BI) o A P T 2A4E F ‘Key Profiles’ ) e 45 € I & R % &
%:42 % [TAP TEMPO) & & f42 & » 11.2.1 ¥ & 4 % a8 o

FAGHE LA P T NBITRFIRE A E S 69 TAE A o 37T XA 4] 3 A AU Ak 69 4L 50 2L

Re TRHIETT = ITERBEAETENR A

—1 Fixture overlap=50%o

/ mz_/-_\

fixtures in chase

onjeA 47

Cuel Cue 2 Cue 3 Cue 4
—] Attribute overlap

TR

Position Colour Beam
start=0% end=25% start=25% end=75% start=75% end=100%

anjeA 417

Cue 1l Cue 2 Cue 3 Cue 4

® }z[Fixture Overlap|/T L & & » K& A 0-100 X T35 AT L & & 444 > 100%(.E % &)
REFTAITE—AREDR - 0%REF—ITEZRECGEEHE TAMITEAALET &
NERIITEBA—FEFHG TR - 50%REPF —ITEZR—FHFEH ITEAR AL E

i7 o
® BITAWTITEIMG » driRBEIFCAT KT R L s A P T4 A [Unfold] & F 2 A8 2L T 4T K
R o

7.5.2 1% & #,47(Chase) A £ 43 & (Cue) & 7]

3¢ 4T (Chase) 1 £ />3 & (Cue) ) 32 47 B¢ 18] AR *T WA £ 3% 1% & » 4% i (Playback View window) & 3% &
# @ v (Unfold) & 7 7 #& ©

1% i (Playback View window)® 74 & & & o :
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P.90

1> % AR 3t Ol s dd X A% [View] 42 » K14 32 @ 44T 69 [SWOP 242 » W& &
Rk Rawt il
Playback View - Chase 'PRESS GO’

De.la}r Fade Fade Fincture:
begend In  Out  Overap

el =l After Previous

Link

Global | After Previous

Global | After Previous

Global = After Previous

Global | After Previous

After Previous

After Previous

2> E&#&q’ ’ ,ﬁ\%ﬁfgﬁr%ﬁﬂm o
3> {¢ Fl DhredE N & 2Bt R R F o
4> ﬁ’i*ﬂ%z FHRAECHGFRRELE o

@ APTUA—RIAXT—2INOPYF AAB T EERENERBREF LN ELAKAITRE -
1% A (Unfold) & # :

1> 3% [Unfold] & 742 » A 1% 4% & 2 AT 69 [SWOP)dx 42 3 17 4% 45 o

2> Jz[Edit Times] % 45 B 7] o 2K #& 3% & JF 89 3% % © 203 AT [SWOP| 4548 4% 4 o
3> B F Rk E N BR(ERLAL T @EE) o

4> Jz[Unfold]4E & F o

& PT A B 18 A ‘Global” B4R A8 » 4R =T ¥4 £ 2T A ‘Global’ 4% & B 18] © 3% 7 #.4¢[Use Global] = £
XA o
e RR B A VAT &0
® Delay %38 > Fade (in)i% X\ » Fade Out 7% i} » Fixture Overlap JTE & & >
Linking with previous step 5 £ —-F4%4% » Attribute times & M R (HFA T —7F)

% 3% 97 VA& E [Link After Previous|i% 3% 2 % — F (384T & A 32 17) & [Link Wait For Go|:i% % %
gm0 SIS 3BT 0 A BRI [Go A AT o

753 ZEHITRGHZFBEENE BEE

HANFIT N 69 3 5 B P 4B AR TR E K B ] o 4% B (Cue View window) ¥ & & & & O 2,
(Unfold) & 7 7 #& o

WE—ANBEAGE N B

FJ PR[% (B TRl PG 0 852-2898 8666 fEH! ©852-2558 1282 Pifik-: www.dnein.com  F1Hf : dne@dnein.com
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AVOLITES PEARL EXPERT TITAN V.5 % X 34k % % 5 # P91

1> z[View] & [Unfold] & 7 4% » A 1% 3% & AT 69 [SWOP| 3z 42 # AT %R 4 -

2> Jz|Edit Times] % 3501 8] » A& 5 &% 0 A 6935 =& %4 o H4¢ F [Unfold]
BTt o RtR IR R R AEAT[SWOP 242 3t AT % 4 o

3> Fx A8 45 P BB PE G R R A M B e AR A o
4> z[Delay]% & 3 18 i 3] 8% [Set fade] % & ¥ A% & & 8] o

5> ¢ A & FA4E LM A F 69 8T 18] » R 4% 4% [Enter] % 5 2,42 [Use Global]| = £ 7
X 69 E F B A o

6> 3z |Enter|#k 55 2% ©

7.6 JH%KBER
2% B — /A9 JT(Chase) » 3 £ ¥ % 7 4842 [Playback Options] & 70t 7 » A& 14 4% & 3047 49
[SWOP) 342 i 47 4 45 o A L35 5 3 & (Cue)teAa Bl (F 20 A& 6.6 7 ) 3 IT 2w % — L o
7.6.1 7 & # 493 % (Cue)i& E (Loop)& 3/(Stop)4% .k
o e AL R B % B BT A2 5 18 3R A& h (Loop) 315 1k (Stop) 2 & 4 69 3 & o

7.6.2 & 7] (Forwards)/ %) #% (backwards)/ & & (bounce)//£ & (random)
AN C R BWITAZF A FHF 6 o

7.6.3 3% = 8% % (Cue linking)
DAL AD RERITRFADFEDFIRNKATX c REWT ¢

® [Always Link Steps] - SaiTRFEZTE AHBE T —FH % -
BRAERY)F
® [Never Link Steps] - MITREFADTEHEIRLYE1Z L3R [GO|A#E T —F
FEEDF HF o
® [Link according to individual steps] — R & & A~ % & & s 1% & » 1& A (Playback
HRAE A5 3 & & e View window) & 74 & & % v = (Unfold) & 7 7
AR E o

% . B2 % (Chase)3 )T & (Unlinked) £ X KB » R ({AF R 2 BT E— M7 F > TS
B AR 0 AT MAREA » o RIITRRBIRGH 0 RELEF—AHF P& E [After
Previous| 5 L — 5453 c W RWITRBIAD R > A RAEDZ T Hm—ANEPHZT 0
A E B AR 0 £ > BB £F2 F — P& F(link) o

764 TXHEHRT
o #%.4% 1% 77 [Renumber cues| €2 FH 5 » ERHITAS N ED ZTHRSTOAE T 1 FF4) o

F‘,J“’“}*ﬁ["“& (BIF=) F L _F[J F1i5 © 852-2898 8666 (£ H! : 852-2558 1282  P»{fi-: www.dnein.com [T} : dne@dnein.com
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575 % (Cue List)

HEFINTUARARA R —F )= F Rz a e F— A9 FNRELENHETIUE
ST R FIRFEF c EETUAR AT FPZRENEL -

38,47 )5 7| (Cue list) 5 32 4T 42 /+ (chases) £ 3% = 4l 69 TALE 7 X KRB » 30ITAL )5 3 = Z A A #F
BT E  MIITF P R LRI TAL o

Bldo AR FHRFAIT 1 AT 1 A R[clear] » FHFAIT2 A& 20 AR > THFNIT3
A E3ohaRiXZ— NI SRERBITEAYEIN T AZ B ELEE Sw) zé )|
a3 HFEASHAFTAITI s o

A —H BAKITF 7 (Cuelis) %) T TR F LB ZF2HETRIT L RALA T RE
HEBXDT1EHT 200838 - WITFINAEXRLERTA D ZFOKERETRITL 253 —
AT o FTAS A P ZAITF N EREZEEN Y 7 LRG0 TA -

RAEWITF 7 691Fm N 5 > 7T 23 [ View]| 42 R & 12 & 3 EAF L4 (Swop) iz izt € ey &
BAERTHEE o

r

Playback View - Cue List Playbacks[7]

End of scene

Cue 2

Cue 5

Cue 6

[\

8.1 A|&ITHF P
8.1.1 3% 4338 ITH 5|

Y A2 384T /7 9] (Cue List) £ 41 & %] (Chase) ¥ 1T o

REBRBLERG LOENDF  REIGTHRMEIITFF] o 4o RABDLEF K HHE > T
Wik B 5 & FE i R R o

1> #z[Record Chase or List]%Z » X #% 3% 7 it 4 B[Create Cue list] &, & %
[Record Chase or List]42 6] 2 3,47 )5 7| o

2> {5 W@ AEAT £ 69 15 & [SWOPI4AE G 7 38 4T - 5] (AL =T A% € fik 75 72 ‘playbacks
windows’ &€ XA %) ©

3> wFEF st A[Record Mode] 12 & #2 X ‘Fixture’ /T £ ~ ‘Channel’ & & 3 ‘Stage’ 5% & o
‘Channel’if @ # X A2 FITEL G 2 AT B E o

4> #:3% E[Set Times|% & #7304 7] ~ [Delay times] £ R i 8| o 37 & 8 #hiE 4% - LXK B
FEEFE—NFOHFA o

5> %R —F x> THF# K& L [Include] &2 7 s KILA 49 3% % » AL A F[Shape
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Generator]| ] E A R /4 o

6> 4% C[Cue Legend]% & 3 % 1l B & & o X 4% T 1% A [Unfold] & 7t 2 [Set Legend]% &
LARNRER - (FRET—F)

7> JR ik A6k A E AR AT 69 1 & [SWOP] 4z 42 3 4% 7 it 42 D[Append Cue] » 73 % ¥ %
BITH P B EA o

8> FEFHOSXET—AHF - ARBEWF A T E4Z[Clear|42 » Ix IR B IRIZ AT
FKF o B EVEAT I AT A 3 EL RN RAAR G o o Rz [Clear] 42 » 4R 55 /1 A £ & 12 K AT
A IFE A RRAL o

9> BT A 3 R Ak TR 0 B [Exit] B A o

® [Record Mode]ic sk 42 X, » #& #%[Record by Fixture] Fwalites Pean Expert o
BITERZ(ITEMAGERER 2R AE) : ' e
[Record by Channel] s i 18 12 & (#f 4 }T B AL AT
% {4 % 49 /& 1) » [Record Stage]iz# &1 Z(FTA
JT BB M 8 AE R AR 2 R4 ) o [Quick Build] B
18 3 5 (T R AEAT I A 69 ©F AR X R & A Ao i
TEIT R » Rk E4E[OK]|RF) ©

® FTELAFHTREHITARITFINANMRE S
HEY o RS ARITF 7 AT O 514 69447
I o

® ARARNAEINFWEIHEY A
[Append cue] Fs 3 % o

]
-
o
=
L]
=
=
o
o
o

® ZRHFIITHIINILA MG EY » %3 42 B[Cue Number=|# X\ & 545 » # 47T H 69 &
K 0 Rk A% sE4ED[Update Cue x| & #7

® HAHHEFSESTET IR HEMRETIL2ZT -
® %% % ¥ A & G[Advanced Options] > ST A EH I A D FF T B R LK T o
® ITHFITEHFTRALERME

8.1.2 T AIBITHF 5| A& P& % AR

& 7T vA1% & (Cue List)# T 5 2| & /3% 5 F 69 (Legend) % AR » % iE47947 )5 7| & » LCD B & &
E o BRLARTBIRBIREITEAE o

1> A TR 2 % %35 4842 C[Set Legend] % & % #% » & 3% [Menu latch] 3 #£4 >
ek BLMRELME o

2> R F B IT T 7| Ik & [SWOP)424E -

3> BwFWHITFI TP F LA LED L R A RBETAHFF
& E o

4> F 3 e 4E C[Set Legend =x| & 242 & LIy AN % AR » K % 4% [Enter] -
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5> 7 &4 4% T [Exit] & & o

8.1.3 I & 5| A &9 H N\ F 2 (Autoload)

BT —ANEHITFIN TR T > BHBA—ARZAIAAEOEZAEX c EHAEXTAR—
M F S —ARITRAE S —ARITF I

(Autoload) T VAZ B A A mBERER > RTFH 0 RDAEZXBNBITF I A o
% B IIT)F D) A e 8w A X %

1> #[Record Chase or List]4£ » &% B[Create Cue list] » /X 1% & G[Advanced
Options] % % %" » & # 4% C[Autoload Live Playbacks] & ) /w # 31, 3% =
AR X 0 RAERON ©

2> BAT A B E AR o

3> xEladfEAr L6 1k & [SWOP|4E » 3 7 it 42 D[Append Cue] % 75 38 4T 75 7|
F o WMHRRNSABH MBI ZIRITFINFA o

BB FH R ALK BITF T I

1> £ TR E ¥ # ¥ 3 ft 42 B[Playback Options] & 74 7 ©

L

2> #:(Cue List)32 47 5 7] 9 & 33 4F I & [SWOP)4E & Ak o o~ o
’ﬁ’(‘% ° z Open
s [Firstrumber ]
3> I3 484¢ E[Autoload] & 7 # )\ o 4 Cue 4

4> #IT/F PN 8 %% Lk LED R L (R 45% A %
BRABANRH K

5> d% F N E A2 X 69 [SWOPLAE o 4 An £ 69 & 342 X,
LKL TAAERL

6> AR ABELE BN CFLXE L CF I P A > Kz [Exit]
Bt e

-
m
=
o
=
=]
I

100%  Wait For Go

L 30,47 5 5 Z 4T B Je 3%, B (Autoload) 89 & A2 X AR R @ » AEZRGFHE T —NFHFA
ik o e RIRTABA XL RAFILE R » FHET —NF 7] ¥ e fita B @ RALR o

BIDRETARER I T A EHAEX o

F‘,J*ﬁ:‘[*& (E=) L 'F[J F1i5 © 852-2898 8666 (£ H! : 852-2558 1282  P»{fi-: www.dnein.com [T} : dne@dnein.com
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Yo e #, % (Cue) & 3 A A — %47 » 3 4842 A[Remover this Autoload] M| f4 Ao 2% 69 3% % o

4o Je 3% 52 (Chase) 3 4T 42 &, 3 (Cue List) 5 7| » & 7 2 4842 A[Remover this Autoload]#| 4 e 2% 49
%% » A 7 it 4E B[Goto Target Cue] X B Az 3 & » £ 4R =T VAR & m £ 69 & 242 5 AR 3 7= F I+
45 T 2K o

8.1.4 $ITF 7| b & 47— A% >(Macro)

8.2

)‘ﬂ)f'fiﬂézh B P am— AR BT AEAR R — 2 B L ARAEIS A o Bl de A SR IT R 7)) 64
—F PRI ITIEAR A o

1> & TR B ¥ # 4% 3 e 4¢ B[Playback Options| & 4% 7 o

2> Fz(Cue List) 3 4T 5 7 69 © 53 47 I & [SWOP| 4 R Ak B 324 o
3> & F A ¥ E P [Macros] %’

4> EEHE D RFRER R FmEIR—F o

5> x ) fest A[Add] e » KRBT R FIF—N RS o

6> & ©HE v (Macros)?| & £ RAR AT A w69 R 4 AR

® P TUMBARIRE R 454 BFHBITH I REBREMKG R LR Rk
) 642 A[Remove Link]#% & & 4 o

E 238 HT 5 5

8.2.1 ZATIITF 7
BT E P M T 0 T (Gold42 24T F —ANF 29 % o $8IT R 7] 4+ 235 (Touch Wing) k4
ERFZERIFBE TSI METHZFTARECRBEL =~ KA R H*f;mﬂ?—l:"/\%%g #  -LEDR &L R
TAEE C BT P A 3 S A A T — AN E/ B o

T
Cue 1
Cue 2
100 %
In 12s

Connected Cue List

IPCGBES
Swop
Hash

® TR IZ 43 IT 5 7] ) T HTP(Z &) 4 K F o

® Y &[STOP|4E({Z7[Gol4E L) T A& 12 5 A3 » 3 [Go] H Rk & o

o R AR AT R 7| PAEAT & - 1% F 45 55 A% (List —-1Next Cue+1& &42)k 5% » R#%
Z[GOV4E3 )T )7 2| 4 3k B % 3 & 54T o

® I &[connect]if s (1L 45464 @) o A £4% T [connect]4& fe iy N B BLE 893 % 55 » &
#% 3z [Enter] T A AZEBREB AN & c KEAMEDREL PN F T » R I [connect]
H—HEABRE IR o

@ Y &[Snap Back]Hik &k B 42 (24 [Gol4E A @) » TAE B X AP & ©
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® R A% Al (Key Profiles)s2 14 E kX T ke fe R &l » R C A TR A RR R > 645
Go ~ Stop ~ Connect ~ Next Cue ~ Prev Cue ~ Cut Next Cue To Livef=Snap Back °

o LARMAKILITA P69 44Tt » HTP(R L)@ M I4 3k o (25T F S0 RIBAERA » Tl —
VR F @A B R TE LB ERS ©
o 1% A (Timecode)& 18] A% =T v B #h & 3 34T 5 7] (3% % 18.6.5%F ) o

8.2.2 4L EATPEIEITRF F)

LY IT R D) G e BT F BRI E[AVO4E s R4 T 3475 2 4F L6 i AT & & [SWOP]
4 o

A P 4L 4% R [Playback Options] & 7% 3% 21 o) fg & 2R & 0 A8 BIT /5 2] AT 400k 35 Rt B #h &4
ik o 1% ¥ B ; 4t [Playback Options] 3 4642 » K14 i F 94T /5 56 & & [SWOP)42 » %k A &
Ak R % % % 4% 3% 3 4t 4¢B[Fader Mode Intensity Kill At 0] o

8.3 LHBWITH I
8.3.1 A ‘Unfold’ & — 384T 7| % 55

‘Unfold’ & A h 4 T H T )5 5] P REANF A B @A L @R P T RI G EETRBEAN S
TP o

1> % 3 & [Unfold] & A4z 42 » B %3 R % 5093017 /F 7 69 & 24 AT B
[SWOP)4# -

2> B0 NN BEEOREFL STRAERH T FTH LR
3> EAMIMEAFIEZHETHFRAECTARAZR B EAITE) o

4> ‘Unfold’ & 7T 9 #E4- L & AP LA » 5 A T @IF -

5> % % [Unfold] & 7 & A 42 X ©

0 4%HEPFTANE : Z[Clear|iz4F = mAZE » f JH W XIEAF 4 E 724 3T hE
A[Record Step]i2 & ¥ ¥ » A% FD L & 1%42[SWOP| 4 %= o

® ¥ xitiE s Z[Edit Times| % 2 0F 18] » #®iFH s » KRB ZXENNE - GFAHIKY
HEEZET) o

® AT BLREILI-ANHFYE » HhacsE Blinsert StepldE A F ¥ 0 B F R A IR 4E
RN #FHPx %ﬁ@x@ﬁﬁ%?amm@&@ﬁ&%swﬁﬁﬁ% 1P 2 2.5) o

®  FZMr— A o fz[Delete] M Fhdt » B ikiF EM Ik % 69 [SWOP| 24t » &% Fie—Rix
AEHRIN o
F A& 4 AR > 3%[Set Step Legend] % B F % Ak » KRR GFACEARF & T o
W RBITHF N RO FRT—NEOREFHE > AP TAEIREFAAFGRT @
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8.3.2 ZHIITH I ¥ T4 KB 7

tilﬁ"ﬁﬂ-uﬁﬁﬁéﬁ Folh s RBFMEOGD FHMA > wRIRBXERE > BEZRINITE I
B F A BRKE -

F A M AFHINETORITFR T HFTY » FREMMWEN T F L3 -

1> BATRITF IR BB FHE RO FF > BRI ERRTAE o
2> #[Record Cue|4%, 1% 7 ft4Z[Update] £ %7 o

3> JNB ERATIAE » RIBEF R RFITEAMEE N T £ L4 -

4> }z|Enter| 7 m, & 37 o

8&3%ﬁfr¢%%hﬁﬂ
R B T VAEAT ST 5 7] Bt 4% B ‘Unfold’ B A 86 B8 A 249 % -

1> i AT )5 5] 44T

2> 1¢ 338 A B [—]-1 [+ 4B ZEH T o

3> #z[Clear]| F AR BAZ T =8 o

4> s FG P T FHAITRE K o

5> jxRec.Step & %] F ¥ » A& L3F & 2R A 7 X 0 32 it 42 [Replace] 2
~ [Merge] & 5+ 2 [Insert After]3& A\ L 4% o

6> ¥ & & fAt[—]|-1fe [+ iFET —F o

{% H [Live Time]#=[Next Time] % 4 — /4~ 3% & 0f 7] :

1> BITRREQGHITF T -
2> & R 4658 A S [—]-1 Fo[o]+] =42k FEH*x o

3> [Live Time] 52 it & 5] 42 > % & % 7] 89 3% % F 3% [Next Time]42& € T
*4%%ﬁ°§ﬁ%T*A% T S EREEETRALEE T o

4> 1R AR RE  ERFEEFFNEREOHA 751 #HR) > R EE
[Link to next step] ## 3 FT—F %A A O0On> M T—FH2F ReEFiE
GO x4 F 4T ©

5> 4 & At [—]-1Ae [+ 4E T — % o

® [NEXT TIME]4%42 43R X E T — A F 0 R » @ RB LIREATE ©
® [Review]iz4Z =T VAN X & A71& & 693 = 0F 5
® R4 2A4& Al [Unfold] & /2 fit1% & B ] » £ ‘Unfold’ & 7 85 — ¥ A 14 3& o
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8.3.4 % I8ITHF 7| B B2

% 7 (Cue Llst)% BT/ 3 %2 > AR AR B 455 furclites Pearl Expert -
(Cue)% pd L ' Fixture

Cue Number = 2

1> #: %) 642 [Cue Number=x] > i A\H &K% 5 °
2> S TRAARE BN T T R E ST o e e
3> 3 % 315 % #4742 > %42 [Edit Cue x Times] %% g0

5 B0 o

4> %t 4%|Update Cue x| R & £ 7K o

Update Cue 2

&
-
o
E)
(]
=
o
o
o
1

Edit Cue 2 Times=s
® X ¥ N[Cue Number| RAEX T % ¥ %5 L5414
ﬁ: ‘Hilg EJE @J % - /l\iZ] '% ﬁ— J&’Iﬁ' % !FET- ° -g‘ 5'6\ fi }% % “L/F' ?/fv?a = L Shape Generator

% 1% 1% il [Advanced Options] & % #% 7 - - -

Advanced Options

84 EH ~#Hzh - xBEfML
8.4.1 X #|/#% 3 36.¥7 F 7| (Cue List)f} &1L &

ST A 9] T VLS A5 3 B 51— A= AR AT > 5413 — A(link copy) BT % B4 L 5 s BT 4%
M P E 4l 4 o (link copy) S X B N > FAEA P B E S AT @ HA RS » A XHEA
B T AR TR R I A e A R o

R T A 5(Cue)ta ] » & 6.4.1 F A Fmil 8 o

8.4.2 M FR38 )T F )
Y [delete] M Fh4E » % F M RIBITAR S » R E4E(Confirm)# A o

8.4.3 JAHITF 5| (Cue List) F B sk — A% &
# F4(Cue List) 32475 2| F — N & ¢

1> #[Delete]4# o
2> HIFHITF 5] 69 [SWOP] 4542 o

3> WITHFI P A F T 2ERFLI G > A AW RFLMERY
I 5 MR o

4> iz 3 fg [Delete Cue X]4Z o
5> 1% 1) at4E(Confirm)# 1L o

A 9h o A P o7 A% A [Unfold] & 7 2 Ge M 1A 30 4T /5 21 N 89 3 = F o

F;J FE% (BF) L fil  F1ic :852-2898 8666 ¢ ¥ :852-2558 1282 i www.dnein.com FT[[ : dne@dnein.com
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8.5 ‘L&ﬁﬁ@h}? 7| & Jq]
8.5.1 % BHITHF 5] EAK it

(Cue list) 34T 5 5| N &4 % 09 B 4% B & 4% 269 o 4% 3 642 A[Edit Time] » A 44 F 4 35 A,
DA ED T RE > LR L RREAGZ AN T o

5651 FFTS2F AR S EEFHT

B R) 69 A o

1> #[Edit Times] % # & 2] » R 4% 3% & % 8 69 3247 /7 7| & 24 AT [SWOP iz 48 4 417 %

i -

2> sk A K 4n ) iE42[Cue Number| i A% %% 5 » B2 RBYH T Kk

[Enter] -

852 BEHZERERRY

W4k 40 A R ARdE Z[Playback] G v L#EHRF LAY 7 0 THEFE-NELEG Y FT—F
it s TEARST AR —BY 1) 2L
[Delay In] 3£ 38 3% N » % & 3E R EBFTH ] o

[Fade In]:% A » 4% % HTP #= LTP &4 3@ i % A\ B 7] o

[Fade Out] ;% & » % & HIP A= LTP &8 18 % & 4] o

R EFHOHBNE > AFREDEFTAHETERIT—AHEFEER - SHEFS R
BEEAEE ARG TEEN o

A8 T o

(Cue list)3e2 4T 5 5| N 3 % T iR R LI 4ade » B 389 B 8 )7 7] o

1% M P Re AR B

® |Link Wait For Go] % ¥ % &

: %?%#%[Go]fiﬂ'ﬁib’i% FIEAT o BBRAGWER -

® [Link After Previous Cue| Af £ ¥ % &3 : 7 AR T L RFE AR » T—AMH x4 2
fE R o TARE —NEFERG > Ryt ﬁ(@%k o A% E T AR AV 4T R B 4 Ak

A FENE BB E o

® [Link With Previous Cue]FlaT % % &4 : ST 7T AP RINAEL o TURERE—F

&R As > N3 7 EAT A 69
R o Ap A BT A4 RE 9

T ESCT LR

3R g 3K B R TR IR AE AR AR
BTGP > fde

® inT[GoléE ITE 1 T RA4 K
AAB T 20 AP o
O 10#AHZITE2ITHRAL ENAL

FI54 -
A IT R IT R B E S A o
AT BRI B Sk 3 A o

Link After Previous Cue

y —

anjea 417

Cue 1 Link Offset Cue 2
“Delayin """ Fadein ¥ "™ Delay in Fade in '

Link With Previous Cue

anjen 417
-
5
=
(o]
3
z
13
q.
-
=
=
=
-
=
=
=
=

I

Cue 1

“Delay in 71 *Fade in

Cue 2

™ Delay in Fade in *

FJ_}}%[*&(BIB"_{)?JF«:‘U—}?‘J FTi5 : 852-2898 8666 & !
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PR VA A2

® HE1- ITE 1@100% » % A 20 £ » % & [Link Wait For Go] % 4% % 4% -

® % 2- ITHE 2w100% > % A 15 #) » 1% & [Link With Previous Cue] Bl 7] ¥ % % # » #4%
RA% 10 5 o

® = 3- ITE1FITE 2W0% > % & 3 4 » & & [Link After Previous Cue] 7] #% 3% = & # >
A 54 o

EE A AR AR AR R AR X ZL R 4 8 ‘cue overlap’ 3y & € & » 34 52 1¢ H [Link With Previous Cue]
Rk BEEBRASE R E 9L BERS 100%FAHFTEE 0%

8.5.3 HIT/F 7| B PR OGE Bt
T 0% 4 4~ IPCGBES f b 4034 B Ak s M £ A TR > Bl BQ RAE 224 5 {270
GO BT E 104 o ML TR EHA B PR R R F 6B B A -

RREBRBMAGEE » B kL F[Eit times] 1% T B A R £ AR EREOH T LR > KAz
) fe4E G[Next->] % 5% = R 69 %7 o

1> #: 3 fe4E[Attribute times] 2 P B 7] o

2> A E A AITEIG R LBI > o RAR B TAR AT LA ud ] » BLABE ®FE
mofTu&&%ﬁéﬁé%%m%ﬁh 2.4 Shift+ALL 3% 4 BUH i B 4 2%
JTE o

3> AT RS EGBEY -

4> 3 A[Delay]& & 3 R 0 F] » %4% B[Fade]:% & % A\ 3% it 8] o 3 [Use global| M 4
By PR B o B B OE A9 2E R SR K Y R] o

® =T ul4¢ ) [Individual Attributes] % 5% & 1t > X H B M40 ) 3 — B PEBT ] o 5] 4o i B B PE A A
#‘Pan’ » £ 7T 4% | ‘Cue View window’ %= &A% 0 » X ENF B a9 ATIR o

8.5.4 JTE & & ‘Overlap’

B ADFHRATARENELESL c RETHEMFERARND T > EAHTHEMTEGTMNL
A—FFEHEAR o FEKS O RARET e — L5 H AR -

® i[Fixture Overlap )T A& & (AP F A XL FE T L) A& A4S i 0-100 % &
Yol TR T FITEEE c 100% R EAZHFAITE—RER(EFEL) » 0%REZH—ITHL
TRFE BB T —NITEA BT 50%REZE S —ITERZR—F R B » &= IT AR
45 3B 4T o

® }z[Set Fixture Order] 7x % 4T BLIR )5 » KR 5 — - . —
AL S T LB HT A 9 B E%®7“@a“@ ey
& F 3 A A G IT B )5 o 3% [Step Number]}T (R
By REEANTE BT » BFRBERLRF
é’J JTE o )l he % B ST F » 4251 ARt
KRG — % ZFR)FHRFITEIEE » o RIRIUANT
AARNKT » TARXECIMEA AT - mfiz
JTRAEARR > TEGE 2R & E T XTI FHKAITE o &Em]&h%%f

8.5.5 BATIHITF 5 A6t Iﬁlﬁﬂg(Tlmecode)
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8.6

4 G A g B R AL 5T B B BATHITF F) o S8IT 5 7| B — F AT 48 T B 1A 247 » & &4 A AR B
By B 1) R ABRAEGY B R o
B J8) A ST AN A 2T B 1) R 1% BR A& %5 B 4% ~ MIDI 8%, Winamp o

1> T/ P % BRI R AL e F £ P o

2> 7 I ¥ % 3[Timecode] i 7] 55 o

3> I aesE A LAFRTF GG R A A o

4> jz[Record]4£12 % °

5> B iR 2D > he R AL A BE AT A D > dz[Play|#§ 2k B #h o
6> & T 4 &[Golét » BATIRBE FHEHFF o

7> #z[Record]4Z 7 12 & ©

£ 3% 7% (timecoded) i 3] 22 64 (Cue List)$2 47 3 7] 4% [Connected Cue Lists] % 33247 )5 71| » £ 4%
BAE AT B > KAk e [Timer ...] > 45 At 5D o

L 2 Fh ot A AL IR (2R de A% A A 3R 0 A A 4% [Play]) » BT A %) & ARIE R AT G BT ] @ Ak R o
T AME R 4540 A 345 ) % kA5 2Bt A AL o diz Enter R & 4N F769 3 Bt 1A A o

R4 B TAREFES NP RmBE > 18R R4 s N —/ME R KT AR %63 ut
B (R#% ~ B — A B 698 8] R F— B 2B R o

AR AAT I — A0 18 A B = B 2 8 5 R 4% 89 B 8] AL — 4%z ) 4842 [Open Workspace Window] 47
IR G v Rtk o desE[Timecode] B 3] 75 o

Timecode =

Timecode [elsii——RYT

00:00:00.24
00:09:00.00
00:12:00.00
00:25:00.24

[23:59:59.29

23:59:59.24

Disabled

= B R
30T 5 3 & 4% 3% 0 72 ‘Playback Options’ 3% 206 2 % £ A » AR A@ i E £ AT T 78 1E -

1> 7 ¥ ¥# 3% 3 st 4E[Playback Options] = 7% ¥ 7 °
2> X ENRBREGZAAATHE R -

8.6.1 £ 144 & (Release mask)

[Release Mask|#2t4 % » 48 T BN LB o & Mz E AL B EFERE KA XEZLTR
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RE A AEAT By T

8.6.2 FE N\ ik 4% X (Fader mode)

sbik Rk B 30T 5 5 AT 69 B 4T X

[Fader Mode Intensity Kill With Off] X 4] = B A X » #AF LB HTA HTP @ s b 25 > &
WHIBRBZZE RN KRR G a i AEHRE -

[Fader Mode Intensity Kill At 01X % B 4742 &, » fAFEALE] KB » BT HIP @38 B 25 2
Ko B PAEBITFF] o

[Manual Crossfader| 5 & XA X, » B EAFHER| IR Fe R HIBITF A ZF 5 F 4
RXFENE BB o

8.6.3 A EA N4 T

sbit % E 4 E © 2 3EAF o [Lock] 4 T & 244 7T £ P A © A T @k kB > [Transparent Lock]
FERH 0 e R AR TARAML B R E A2 X TRFTHIRS -

8.6.4 HE XL
ATHRATARXEABITHFNFTEANA R =T RN AL REARGERE LMD =
W5 A o

’Iﬂmﬂﬁﬁ—Wﬁ%ﬁ*A%%Wﬁiﬁﬂ%&A&&®%ﬁ%%M%Wﬁﬂﬁ%%%
B Z 18 38 N3] F 8] 3R e b 0 AR R xz)sk%ié' | Zak ) o 23 fe 4 B[Curve] » A& b 4F—
W &R }é}ﬁarﬁvz&ﬁ%@wﬁi‘tlﬂ 115 %

® [Link]:%3: - 1% & [Link Wait For Go] ~ [Link With Previous Cue] 5% [Link After Previous
Cue] > HA % 852 % o

[Preload] 7 £ — T Sehe s T — 3% %69 LTP A 4o 4T BAL F) o
[Legend] & ¥ — % EI4T)7 7| A& L AR o
[Notes=]|&ix — A3 (RERER D T AT EREZ) o

8.6.5 B 31 A\ (Autoload)
IR AR B e BIEHH R /IT 0 ES I 8.1.3 ¥k o

8.6.6 % i 3£(Macro Links)
ITH PN BN T T AT AEE -G E » F45 M 814 TRE o

8.6.7 4% & (Key Profile)

FADHAEX Loginsd (L &/ R @it A TAS R E TR » 2 2724 T A E 69 (Key
Profile) % # » A P 40 7T XL hm — 437 99 (Key Profile) » (Key Profile) 3z % 7] 7] i I & 4o & & 44t
W B F 69 T e o
o R % B I efe & G I24E ) ‘None’ » 34t &= & 2] Bk A ‘global’ -

8.6.8 3% F(Shape) X /|M/i& B
TR XERITHFINEXD T TN BREFRDFRE o AP THFELXBFEHILEEH
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8.6.9 1Bz (Tracking)
BIREX(RBAD T T REMEBTZR) » L off LA LA -
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9. =E47% & (Running the show)

AENBEHNGEBITETOH® -

9.1 FE&&E#

9.1.1 &4 & X HF
LARBAR R A RBRE R IMAITEN S TAAEUSB EXANBRERITGESLM 1.4 ¥4
BLEA) o

912 #&#E#H &
EATE BT AR SRR E Rwitdr 6 LT REA — 8 FH o T8 Al [Legend] 4 % 2 &
HEREER X BRGNS XA EFRF LT o

9.1.3 # 44 X (Run mode)
W RFERY AL AR RBBERENEH > T BTEK o ZAEXT UG EE
AR T EHE LORAR > (2R KT ARFIT LA BB M o

9.1.4 ‘Flash’#= ‘swop’ #:4¢
A7 L Flash’fe ‘swop’ 442 =T Bl A AT B 8] » Bl A= 4] 9 2 Ae 847 3 & KI8T 9 &8 o ‘Flash’
B ssm BB ES > ‘sSwop' iz Xk M ATA EAm B R REfFE X -

R P T A E #74-Bedz #1 & L Flash’4= ‘swop’ #4269 2 & » 1% Ml 4&:% B ‘Key Profile’ 2y 4t (5 A 11.2
F)o HF —Am R &H R rE(Preload) i 8 » TR B HAZ X AT A IT LB AR A4 E(EA
FATE B — AN EHAL X IT B R A T) o &7 vhy-Be A (Go) A= (Stop) 7 fit » &2 A #4(Chases)
36,07 4= (Cue list) 3847 /7 7] o 341 [AVO] & 4= 7 e 4&[Edit Key Profile] » 4t i 4% 3% ‘Key Profile’
SAF o

HFANE ek & 3R T4 R T AT % % A 7 (Touch Wing)
FR it E B LARA B4R X A o

9.1.5 & FAx(Priority)
YRR A BAF G IT RAERR @4 X LA €4 T 0% B @24 (High Priority) &5 % o
Bl ff A ZARKBIT » AT R TR R EeEDHEX > AR ETEIL Y AN HEXA G
KB AR LEHED AR T (FAK 6.65F) -

9.1.6 Z 34 X (Blind mode)
7+ B £33 X (Blind mode)# » AT A © 2 A2 K 4k A & & w540 visualiser T AR S & o » 121
¥Rt R ML AmE RS EaEX -

9.1.7 % d 4% A ¥ £ 4% (“busking”)

LARE IR T A B AN e — R F M AR I AEAR A (Mbusking”) o &3k 89 3% & T LA4E
R sbzh e 2 e i S N B M AR T AL o
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> ®BF-—LEAES EREAGITALE -

2> 4E 4R L AE O 2 (SATATHE ] » VAP 4 #43) o
> B%FF Rt EAM AR o

4> RIBGIT R E 2% » XA BRWGEM o

02 BRI THOGIMAER

oy E ’7/%%_1—_7»1 % & T F#g‘workspace’ % € TAER & O 0 % Ui G4L B T 46 45 5 A )
X ER > XA P TARREAN LT ARG 2L E o

921 &%& %% (View)
Hviewli#t AN EEE L AR ERTAXEREEZIZILI TR LT -
® [Window Options] L% & » X T & 942 F ~ BMER I RFZIRHFH o
® [Open Workspace Window]47#+ % € TR G0 » st A F XA E O -

93 LSBT E
L ARITA R EARAL » 26 MR BT aEA R4 » 18 A [Move] s 48 T A B3 A By o

9.3.1 1 A # 3 2 f&‘Move’
1 2 W A% 3 (fixtures) T £ ~ (palettes) & A ~ (groups)*T 48 4= & 7042 X, ©

1> #%[AVO)4E + [Copy]st it B ‘Move’ I #g ©
2> R R FHGAE o
3> RMBILHG R EILE -

9.4 MIDI s DMX iz #2/4k &
EHETAZRE G aEME » —SECHBAEABIEFTAA -

941 ERZIBEMBERR

EHE—/MIDI B2 iz446 LG MIDI o (X2 MR EGHEL - BEABEETA I B £ LA
98P 1-1 » 2-2 #= 3-3) o
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P.106

942 GZaimiEARE
PR G AR X Csystem’ 4R [Trigoers] iz X £ » 3T A A R H

Triggers | i x

T a8 A MR pE— AR R 7] & 0 “classic Pearl’ 22 A2 X R BARR B o HAMARR B AR T v

A A 5% 69 ‘mapping’ Bk 440 R 2t 4 ARt e SRR o

1> 32 T A+ 4t » Rdtegegt » ARMA—NLAR o
2> J A& T A6+ 4t o R 4E[Add trigger] s ARde—AMERA E o

3> 4% zh a4 [Trigger Typelak X % A [Hardware] 58 #F » K # 4 T (@ %42 X /4T £/
EM/ )R )R HIEAT 0 RAR RS L o

4> BT OB REROETRRMA o A LE o TG EH L7 TARA > 230
B AR & » ARFT Ak 4F 1 Fl 69 #84F - 42 F 7 A A& [Action]4E o

5> & 7t 4E[OK] » AAEH GITH L AWM R EMIKE o

6> MAMRE R ZRENFMASE > BHFEMA XA DMX & MIDI - % & X DMX 35 0
& & 3 [DMX Port] -

7> AR 6% & 7 A (Bl et MIDL &4 0 KAT4 DMX @ 8) 6 i & o iza%[Learn]ii
FAREA On> =66 2 8 3hAE N Ak LR B> RARTT AE R 2 48 #NEAE
b A o

8> & DMX fik & % *T A it 48 ik & 89 ¥ 3k o £ MIDI fik & % T4 %43 MIDI i@ i ~MIDI
o~ MEFFR(ERE)GRE o

9> % [Add] A mfik & & 5| & o

10> & v TR AR AR BOR AN AR 69 B AF o

R T VLR 225 o B fl i R 25 69 B 4 o
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Triggers (ki | x|

Stimubis
MIDI: 90 00 Menu.InjectValueChangelnput{”PlaybackFader™, "RollerA”™, 0, Jevel, 0)
MIDI: 90 01 Menu.InjectValueChangelnput{"PlaybackFader”, "Rollerd”, 1, level,0)
MIDI: 90 02 Menu.InjectValueChangelnput{”PlaybackFader”, "RollerA”™, 2 level,0)
MIDI: 90 03 Menu.InjectValueChangeInput{~PlaybackFader”, "Rollera”, 3, level,0)
MIDI: 90 04 Menu.InjectValueChangelnput{”PlaybackFader”, "RollerA” 4, level,0)
MIDI: 90 05 Menu.InjectValueChangeInput{”PlaybackFader”, "RollerA”, 5,leved,0)
MIDI: 90 06 Menu.InjectValueChangelnput{™PlaybackFades™, "Rollera”,6,level,0)
MIDI: 90 07 Menu.InjectValueChangelnput{"PlaybackFader”, "RollerA”, 7 level,0)

MIDI: 90 08 Menu.InjectValueChangelnput{”PlaybackiFader”, "RollerA”™ 8 level,0)

MIDI: 90 09 Menu.InjectValueChangelnput{"Playbaddrader”, "RollerA”, 8, level, 0)
MIDI: 90 0A Menu.InjectValueChangeInput{"PlaybackFader”, "Roller8”, 0, Jevel,0)

MIDI: 90 0B Menu.InjectValueChangelnput{”PlaybackFader”, "RollerB", 1, level,0)

MIDI: 90 0C Menu.InjectValueChangelnput{”PlaybackFader”, "RollerB", 2 Jevel,0)

B P — B A AR > R PR T ®BFC 0 KRB 09 ILIBAR BAE
RM PR — AT EG RS RFCIHIRT AR 0K ILRAREAE o

9.43 Z#3 2 MIDI AR X

B RS RIRAFEE MIDI B4k & » A MIDI k& ®1 34 o

R EBHFAT  TAF(SCn XX)
i 1 2 3 4 5 28 29 30
XX $00 $01 $02 $03 $04 . $1B $1C $1D

Example $Cn $02  #&4# 3% 3 7

FrA = HHESON pp )

HHE:(pp) = @5 %k > M 0—14(+ 2 %)

s B (D) = IEOKFLF] 0 K 0-127(+ 2 4]) - 127 = 4

%] 4= $9n$03%40 w1 51 ifEAF 4 £ 509% 69 K -F 2% 7] o

(FHE: 2 AT FONE T4 > FTANEH 6 L6 MIDI 5% 5 & 2k D)= -

R XAA@ R KFELs A elocity =0 89— ANFFF o

12 %) & R AL MIDI & 75 ($8N) 44 % 145 4 o

P2 b /B AT/3 AT A X F ¢ AR ($AN pp ce) ik o

ME:(pp) = W3k > M 0—-219(+ 2 4%) -

Ak #% fA (cC) = 2 4 ARAG ¢

$00 EirE A ITAE X

$01 @A ITAZ X,

$02 MNEF1FRBIHEXK

$03 T —HAE A mARG) ENGE B TR 3K R

$04 HABEHRINT—F
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10. @424z %] (Remote Control)

R WIi-Fi % s ZBEM X & > R ETAZAZES o« ZIAEFTEH» SITHL
MK Aozt E B s ARETIAEZEFTER » FMEARITEAELEAL - BRI B
A& 0 AE ARG FH X EAM T ] 0BT EBRAE o

10.1 B2 ZAEEH

HEZRITEBEINEHNEB RO —AMBERENE c AT E LWL >
FHIHEBOMEELR > AR CRBOFTHLZELEMSL -

10.1.1 MBEE

BRERBZESHEERITEEGOLAMNBEN L NGB EIAMGR o AATHFF > KA1
{# A 7 iPod touch #% #h Z Bx M 1% & » LA R AL69 % & -T A48 B 4E A o

7> % EH AL P » de 192.168.0.1 - p——
8> ’Eﬁj {%%gi Fa«] égi)'ft%j(] 'ﬂ-g ° Wi-Fi [Lon,|

9> j &) & W % 49(SSID) % A% S
10> el AMeSERIITRE Y@M MEED o Other..

Ask to Join Networks

11> BT &9 1P Mk 13 B & 448 X > 53 [Network Settings] | .
M %1% & 0 ix[Local Area Connection] K% 3% » K% = T[IP
Address]f= & 2 IP 34k % 192.168.0.2 » % 1% 4% [Save Settings] 4% 4

RE o
12> A#H#HEgELE s A WIFIi 28 XMEEE o TR
13> HREZFABEELZEAFS - -
14> MFIR T EFHRZEG R AN B LA - —_— P
15> HBHERMBLHAETRZNEGRE » BFEFE IP A > 3 | pasen oo
192.168.0.3 #= F W #4544 255.255.255.0 £ & » & % & ,»J: nE o Subnet M 2525 550

Router

16> MRABARXRERGCOLEEZINEHNEG  ANITESLEITFFT | o
[Command Prompt]4 T B 42 o 42 A “ping192.168.0.3” » A% 4% | sesrcn vomaine
[return]i2 & o 4o R 8 =“192.168.0.37¢9 = B K & MKk 2y o oo

1012 &% E
RERFRRENES > ARCEEINTAERE  XRETHEEMAZEEZERSE o

4> 3 3| 2 At X A dz o) ik 42 [AvoTalk Securlty] » 9K 1% ¥z [Remotes]i& 4z £ - &3 4t
A“Allow All Remotes” %, ¥ BT A &9 i% 3% %

5> WX &EHEF S BT WA A K EF i A ik http://192.168.0.2/Remote/
(3 $<192.168.0.2” Z4R £ AT X B69ITIE S IP M3k ) o

> fFE-AMPp LA KA RGO -
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> IESEEETHAPLL > BB RRRERNER S RARBEERGEFTEALTFR
EEAZER -

8> ix# Aéﬁ%ﬁwﬂ\ 544kt %A > X FEARMAE iPod EiZEAN - F 3445
FTHRAFEATEREES D EEHR » BREEMAN Al A HER -

> ZAEMALCERES > RITABRAEITEEG LREGITAT o

Remotes Disabled i?ilﬂ BIEE - T BT ZAZE R FR o

Allow Paired Remotes 7 # S B st 69i& 42 X - R AFMALA R A T B S » Lok E

EHRFR-
® Allow New Remotes &, % #769i& 42 £ - AF LAGx69Ed £ F L1368 P #F Ro
® AllowAll Remotes £ AT A 4425 -BAEZE BRAR » XA KREA ZA IR o
Lk &g 2 Naksn“Allow New / Allow All Remotes” » 2 & fef2 5 X Bt iE LKA 22 5 ©
FEE BB RAR 1A 3R B 2 30 “Allow Paired Remotes” » VA& 4 & A AE4T T 3£, o
TREEEF—ANERNGERZIN A BHFEEZ LERFYTTERNZEZIINR LT R -

(]
([

10.2 % % A2 4= %l

HEEIEHEG ATHOR TR BSFAMAITH G609 IP A » wRZET L@ATRGFIKIP
33§ & http://192.168.0.2/Remote/

BEELRFEFZNIREEZLTERLEF TR -

10.2.1 #1342 &

BB TR 2R % LIT AR T Legi54d o iTEAT R/ B
RIEX o AIrEFRRTMAILS o

STER P %5 B H > e 3 547 BA7 418 58 50% o ARAR &2 48
3@5

B AITER P %5 1-10 2598 58 80% » /MR A 1 Thrul0 @ 8 -
o RAPE K 100% » AR EHRT@HRA > #l42 1 Thrul0 @ @

24 % ANITE SR E o ] de kT B 1-10 A% Fe 20-30 A5 37 18 58 60% » ARAR
AN 1Thrul0And 20 Thru30 @ 6 -

F LA T AR — T AT ey T A AR o Blaedr FRES » R AR
FIF KL E » AR 2% A 1 Thru 10 More On o
AAE 1-10 AL 4T B 5 1% » /2 R 61,35 Pan #= Tilt 1= &

[Macro] % 4242 » 1E4R4%4E 4T B [Reset] & & ~ [Lamp On]A 78 4=[Lamp Off] £ T8 -

F:J“‘“?f:‘[*& (BEF=) "EJFEL,""?'F[J F1i5 :852-2898 8666 (£ H! :852-2558 1282  pi1F-: www.dnein.com  F1il : dne@dnein.com


jinni_lai
D&E
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#AEeG[Macrol 2 oh &8 » AFATF G IT R > ARk Ix[Move] » Biz[Macrol £ » £ 454
b2 e Ak ST
1) 4e & B 1-10 %7 ELARAR & % A 1 Thru 10 More Macro Reset o

1022 STEBE % o T ”

A ~DMX M hkFe 4 # o %Mﬁ\ﬁjéka%“Actlon”'Féuixmai/wﬂiéiﬁa o R -

5] “Action” T3 X % £ kB Locate’ 12454 » k9T EL & % $
15> 3 FRBAMAITE » STEAMXMOALEEFH 0%) °

_Fiii‘(‘%"ﬁ‘A”’ﬂ‘yj\li;}%ﬁﬁ;ﬁéﬁ J:T—'E]\- ’ ékﬁ%%li;']ﬁq? é{’ J:T‘/E]\‘liﬂl ° 1 AL S00 37 Cenirepec
%’m'iﬁ]‘All"M%ﬁﬁﬁinHé P IREREOK T 24T 4 o o pecen b b

BT AR TIAE I R G o 518 XA ST [
Tﬁl(w BAEDGA P BT BRI Bk & i IE T o
ARRHNTANECREE S RETHNARFAREE R |l

lon@7s. R |
T DA% R “Fiilter’ {RAE 4T B 4 AR FHIT R o Blaesiocdrum™ 5 8 [
= 14 F2 13 IT B o

< e -
JTEGI T X EL > THEITELGEE > WwBA PR o

10.23 &4 B % O ook i B

BHAZET  OBEAAGEHEEP LA —ATERRLEERA [ e
& 3469 45 A (1] 4= 18 S8 K -F 100% 3%, 50% F= ‘Off" X) o 45 4 — B4k & '
¥ H iW’fkT%@ﬁifLﬁ/’%AE\'P 4T o

TR H DA 0 B AP A GHEEFIN 5 Fe F k= AL X o
‘Back’F» G0’ Jz 42 F 74 Rk 69 A B AR LB R AgdE A o

10.2.4 R #HR%& T
BT BB AR ARk b GRS KT e i R o vier: T 620

User Settings

103 &Fﬁj—éﬁ . . EEC) BN OV

Yo RARK B ZAZ BILFA » 5 Z XA T F I

J& 42 4] 4 ‘Windows Explorer’ | 7 ] % 2 3bhk 3

“http://localhost/remote” 2 % % L& B = &A2 & FIRE ©

:}Tﬂ-‘Command Prompt’ 4 442 = 2y 1P 3ok 3] %% 75 1% &> 42 10.1.1
WO AL PTE ©

A # #1% % £ &) cookies fr 4k f o

34 4 LM & 7 2 (System > AvoTalk > Security > Remotes) o A

¥ # 1% “Restart Titan Remote” £ #1 2 #h 12 A2 E I 5 o
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11. A P& & e LA ik R
BRHEARETOEA  HAPXEATERGES 7 X o BRE[AVO]8z4t » ¥ et
[User Settings] | % & » TR EF AR o AR F Y T A o7 FF R IRAF 69 1F 0 AT o

11.1 %% % & T4 R % v (Workspace)

MBI ELITRIZIFTRR 2N TAE TS FAANATIHERGET T o THERFILET
ARG B — ik difedt L > B TRIPTE IERE T -

1111 #7 % € T4 R & v (Workspace windows)
& E % F 4% ) se42[Open Workspace Window] sk 4z [View] 4z 4 o i # L&A A5 TR & o 7
Jo dmAE o

N12 3 IR EFokERRE
PHBPINREORL GAEAIMBREAFLEGALGEE o E A% 04 kAR H 4R
MBETHFOFoEHEE AP ITAXTE oL ERKR ] o

— B TR KL B de TR o

‘Double height’ st 4% & & ‘Maximised’ & X 1t

IHRG O TAEINE D= BB R A3 #[Vies]|>[Window Options]#iL % i il > [Move
Screen]#% #h & @ » R 4%[AVO]4= ikt E L+ #4[Size and Position] K s fo 4% & 454 o

1% F At Z [Closeldz 42 T X il TAFR & v » i@ i34 T 3= & [AVO]+[Close] & [Close All] 7 g 4&
TR IAFRE T o

113 A EIERERE 0

R P T ARG R BAF69 TAF Rk TAER A B o 4 [View]4E & 1% 3% 7 7 42[Record Workspace]
WRIMFR o RAMBEZME LT 2 OMBRLLTIEZIERA A o

ATHFREL—ANTIHERA A BREARENA P AR ZEITE LE - —LEHEPAEREX -

1> 2 [Exit]i& & 2] 4R 3% % > R 1% 4% 3 de42[Open Workspace Window]4t 7+ TR & o o
2> 7% % b k% gh ae s [Fixtures] ST £ o
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> RO ARRLEREE LA E » 42[Size & Position]4t »

HE GOk A LAEE - po——e
4> 7 4[Open Workspace Window]41#F T/ R 5 v » %427 s P e s
[Positions]4z & » #%[Size & Position] X s fo iz B4 - X AT H

4L E o

5> & & A k¥ B A7 A[Attribute Control] & P4 4z %) f=[Shapes] A &
RAXIERE T o

6> Fz[View]4 5k 14 1 o st 42[Record Workspace] 12 & TAF R » %,
¥ 42 [AVOT+[Viewl4E » 5 A TAF R A5 By % Ak o 45T {2 A Beik 32
F A% AL B “Workspace’ TAE R 1 &) = AAL Bk 5 4 By o

® [Record Visible/All Windows]i2 & T /A &G @ » RE TAER A A A > ZFE ESEMTE
BELLE O TEGE 2 o

® [Remove/Leave other windows on recall|#l %/ B2 @ %G a i 5 » %2 3 & H B &5 L
BU XA -

® Mk IAER A At > B[View]>[Delete]> 4% £ iF 1Rt i B4 o

11.1.4 ##% T/ R % v %4 (Compatibility view)
[Compatibility view]4z 4 4% 7> ik 4% Z 69 £ 6 “Workspace’ /] » #& FAT A &% Ao TR A &
1,42 ‘Fixtures and playbacks’#=‘Palettes and groups’ & o » X % o A £ iz & @ik Lo k42 fe ik
R o o BT A £ A & IL[Move to workspace]dz4 0 © 8 hRE AR AT A ST B - ®W AR X -
EMAITH A NG FHECNG LR IFRE O o

1115 BENES TR
IHREORAP TAAERNEG ELREMMZEERALT M EEFRMER AR LK LT
‘disabled’ 491z & o
R MM L7 R 0 o4 2] "System mode’ A 4Lt X, 0 JF &4 7 st 4 [Display Setup] & =& 0 A
#% 4% [External Display Disconnected]®7 7+ & 4% 69 /b 38 & &= » 334 2 T s [External Display
Connected] /MR & =X & » WA S THAAB A o
WwRAPELERILTROHERLE > 2HAE LM [Tools] = £ » #4%[Control Panel]
% %] @ Az D[External Monitor]sh 3 &7 > REBBFELSHWE TG HE o

A TSRS RAEREER > FRAGFEAGIRERE -

0.“} Control Panel

@1 Touch Screen Setup  1024&00 x 600 32bpp 60z

__JI' Folders
l'% Switch Task

@ Ush Expert Console 1024 x 768
13

1 Mo 1152 x 864

o

E Additional Programs

I HE R
do RIREAEAT A EFR A BEME T > o — A bl > RS HFAT  RTZEW
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ARG FRLE o FREZINMMEE (IFEPCH ) » BFX Mgt o

Ctrl+Shift+Alt+Esc & E sM 2 27 £ » 5| 17 k% B (1024 x 768 99 &)
Ctri+Shift+Alt+F1(4h 88 £ = % 4 600 x 800 4~9% %)

Ctrl+Shift+Alt+F2(sh 38 £ 7 £ 4 1024 x 768 %-#% &)

Ctri+Shift+Alt+F3(s} 38 8 7= £ %4 1280 x 1024 4% %)

Ctrl+Shift+Alt+F4(sh3f 2 = £ %4 1600 x 1200 9% %)

ERATA BRI E R AR R o AR Rk 0 B WL R AR L

B RTREMEERL AR BREIME o — M T RV > BB EHRB AT
BH S

4o Rz B G R E A2 EAT 0 A P 7T eAdi4d & [ESCI M Ik X AT 69 12 4F o

o R B R RIEALAS T RE MR R LA 0 R E AR KB RAAEX

1. B st F8 4= 8 Al VGA B X (1 A sh 42 & » iz & Zoom/Focus/Iris & M 4x4E) o

2. f‘Tools’ T B> ‘Folder Options’ L # & &> View £ & - B A 7 IEBR L HF L& o

3. & ‘Control panel’#z %] & #& = ‘System’ % 4. ‘Hardware’ 52 £+ ‘Device Manager’ ¥ & & 32
5 = ‘Hardware’ 2 #+->‘Display Adapters’ & = /A~d F » & & K A4 & H R HE XA
‘945GME’ -

4, #FRFGORHAEZX A K C: \WINDOWS\INR\iegd.inf” o

11.2 4&% & (Key Profile)
BH G AT P EHEE @RS 0 AE ARG BIES K o felie B4R G 4R
E (Key Profile) o 4t 2t "R 69 A P T A F R R 6B E XA RF T AR GEHE » AR HR4E -
29K I 64 % E U > ‘Run mode’ 32 1742 X » ‘Takeover Run mode’ # & 12 4742 X A=
‘Program mode’ 2 XAZ X, » X AR FE R E X Rk o B P 8 ST A B4 E U > AP
W # T ARATRE o

HEMEETOBZET AR 2R TARFLOERIRER -
Go Swop
Preload Hash

1121 @ Fets 242 R B

B R B B AL E UH » Wik B ‘System’ A A2 X, 0 KR4k 3% [Key Profiles]42% B o A #1%
REEERE X2 [View]E A& ~ [Edit]4 4 ~ [Add] 7 ~ [Delete] #] 4 2%, [Rename] & #7 4 % B &
A o

AP TRgEFE—NIA QR E A RH o ki — 3709481 & UHF o

ST A% A B3k 4 R 4R AR B UM > i it 312 [AVO]4E A # % 3% [Edit Current Key Profile] % 48 % 77
R E I o mREAMGHEEZE I Z—DNERF LALLM » 2R T HFI— NGB E LA
RBLF—MNILA 4R E IR o

% 5784 [blue] & & » [grey] & & A=[touch] ik 3425 B 8 74 B 569 £ 4 o
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BTARE AT : EEAKERIN
TR MG o RAEFo 6 T LA
B RAE TRARAETRE -

‘Fixtures’ ST & @ ¥ & ~ & & R A4 34 » T A% & ‘Disabled’42 A ~ ‘Select’ ¥ #% ~ ‘Flash’ = 17 -
‘Swop’ Z_ 4 f=‘Latch’4i & » ‘Latch’ 4 & o f6 2 3% T &4 ¥ i~ e i T4 7% 100% »
Fririesdit 8= 0% o

‘Palettes’ 4t : & & & M 342 > T vA4& & ‘Disabled’4% F #=“Select’ #t 4% o 4= F 1% & ‘Select’ 55 4¢ »
B4R X BT M A Flash’ » 26 S AR EEH -

‘Groups’#T 48 : & & ¥T 43k 4% » T A% & ‘Disabled’ 4% f #= ‘Select’ %t 4% o 4o R 1% & ‘Select’ 7 £ »
SRR B R E T T Flash’ » 32 & S LA EITHA o

‘Cues’s & : I &~ &k & Rk 4E» 7T vA& B ‘Disabled’4% A ~ ‘Flash’# 7 ~ ‘Swop’ Z 4% ~ ‘Latch’
4% 15 A= ‘Preload’ 1 £ o

‘Chases’se 4742 X @ % & %, & & 4242 7T vA1& F ‘Disabled’4% A ~ ‘Flash’ & 14 ~ ‘Swop’ Z# ~ ‘Latch’
4 ~ ‘Go’ % ~ ‘Stop’4% ~ ‘Preload’# # ~ ‘Connect’ i 3% 4= ‘Tap Tempo’ ¥ % o

‘Cue Lists" s 4T 5 7| : 1 &, %, & & 34% > =T vA1% F ‘Disabled’ 4% A ~ ‘Flash’ & |4 ~ ‘Swop’ Z#: ~ ‘G0’
* ~ ‘Go Back’ & & ~ ‘Stop’4% ~ ‘Preload’# # ~ ‘Connect’ i # ~ ‘Next Cue
+ T =A% ~ ‘Next Cue —" L —4 % ~ ‘Review Live Cue’ & & %
7 ~ ‘Cut Next Cue To Live’ 3% = ¥1 81 T —4~3% = #=‘Snap Back’5# & o

‘Macros’ % : =T vA1% & ‘Disabled’ 4% F #=“Select’ # #% o 4= F 1% & ‘Select’ sy &8 » % rb E A f84K &
K32 o

‘Quick Record’ B 12 % : T vA1% & ‘Disabled’4# i ©

11.2.2 #%#FEREE
7 ‘Run mode’ & 4742 X, » i i& o) A4 [B]A= 2 & F k4% AT 69 421% B L - & ‘Program mode’
AL X 0 R{E[AVO]4E A 1% 4 [Select Key Profile] izt 4% 42% 5 U o
11.2.3 @ik 2424 &
A C IR T A B R Rl 6 Dh 68 » 12 8 P 7T 8 © @Ak o 1% Al [Playback Options] &l 34 i *f >
#FAE X >[Key Profile]4212 & o 4o R @iz L% E A ‘None’ » 2 =2 & %L 5 LA -
11.3 A4 % #(System Menu)
A XA X B][System] A% A B AARE AUEEPARSEZHE L REBLAN o wRAETR
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o EHRE > HARATAANRE » BAATTAT ERradzdl 6 6EEsr X o

/iﬁ: . é’!ir. 7%’?132 % Q}Ej% & E’Ziin% 2 Tﬁ él]ir. %"%%ijﬁ‘ég%[s °

11.3.1 % %424 (Avotalk)

BB AR BT E LM B R EHE > wRAEEZSEH S HATARL - A XBERZGTH >
HAE 101§ o

1132 W %i&ﬁ(Network Setting)
HREEHEHEMBEOARR) S e

11.3.3 A p % & (User Setting)
P& 3k % AT PN ‘Program mode’ % A2 4 X i N 32 (E[AVO]4E » % 1% % [User Setting]
RApxE - BERERIFGAAREME > HHRAFGRER @
® [Grand Master...] "% & &4 F 2 A 2

® [Prompt for Merge or Replace JRTAH R 0 et Ok AR A TR B AR =
[Always Merge] & & &3 » %4 8 s 4 5 o [Palettes Always Merge] & # & & & 5% -

® [Warn before parking fixtures...]47 B45 24 Z AT % 4 » B E 47 A0t B % L 4u)T L4 DMX i@
WL o BE® A[Always] & & (24 6 2% E4R) » [Never] R & (=4 6% R & &1k 8 s ke
4T B 4 ‘parked’ 4% k) o

[Tempo Units...]46 F #4% » 1% & & 38 /& 49 £ 12 » [Beats per Minute] -4+ 2 [Seconds]#) -

[Connected View ... Chase Speed]:i£ 4 & A #ITAZ X » SR AT EBE P HHITA X EEH o
[Connected View Sets Temporary Chase Speed]if 3 & & ¥ 742 Xl it B » 324 6% R 4%
BBk g » MITRX T —RET 293 L %AEar8912 & o [Connected View Sets
Chase Speed]i# % & A3 ITAZ XNRE » 45 6 K RAE R T wIT£2 X85k B

® [Auto Connect...] & #h#% 4% » % E 547 °Chase’ 2%,‘Cue List’ b & G % 4 B 45 40 L 34F o
# [Off] % i ~ [Chase] &} 42 X % 3% | 4% 4¢ ~ [Lists] s 47 5 7] & 4% 3] 4% 46 4=[Chase and Llsts]
¥ T AR X T 5| A7 % e Bl 45 46 o

® [Channel Levels...]i# 18 /K F » 1% 4y A FF 8975 X o 4e1k[Channel Levels Set In Tens] » 17
%J)\—*/\éﬁi% XA (] 4= 5=50% ) ° 4=i%[Channel Levels Set in Units] 44 4 A\ — />89 4
XA (f] 4 50=509) o

[Preload Time] i 864 7] » X B IT AT R B & 352 XA BoFE » —fLA 24 o

[Quick Palettes] #i& % #f » [enables] & Al sk [disables]Z A st &8 » 5 14 4.2.3 F o

[Press and Hold Fan]iz T A= {X s » ST B0 4 s fe > R et 4 TAF 8 R &I B o
[Key Profiles]42i% & » & & 7T &4& FI[AvO] btz 42 B b4k B 52 > 5 112 % o

[LED Levels]LED & -F » % & LED 69t #F #2420 T4 » A RERAASL %KL R o
[Timecode] &t jal 25 » stk ZE A P % E 4% A MIDI B 8] A5 55 2% ~ 3B Fe S48 T o

[Wheel sensitivity]45 46 2 805 » % B34 A B 89 R HUE o

[Add New Palette Channels to Playbacks] % m#7 69 £ M @B 5| @ % B L T A FH 9 EME
BR S o BB B © AR A o
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® [Auto Groups] B #hfE4T4 » X E SR EFITAN T F AN EITA o

® [Handle Buttons]df4F4=4& » X B # = F A Aedt £ Eagdesg X > T [Small]2m ~ [Normal]
3@ ~ [Large] X f=[Super Size]# %& K -

® [TextSize]##h K RER APt I LG F Ko

11.3.4 4&-% & (Key Profiles)
G — et hae » 50 112 % o

11.3.5 F = 4742 & (Wipe)
[WipeliF 4k % 7% & % » 5 [Disk] 3 £ 6 >l [New Show] ) 448 F] o
[Wipe Visualiser Patch]i& ie T B3 B EAT AT R > R & ¥oa S alE B T4 -

11.3.6 & =% & (Display Setup)

ik FAE R P T VA 4% ‘Eabled’ B A 4= ‘Disabled™ 15 M 52 L 7 bt o m RIRAH ER L 75 0 4
% & A ‘Disabled’4# F A3 5 3z 4] 6 £ A€ - ‘Titan Mobile’ & A L% 7 -

11.4 DMX #y b ) 2%

BHER S FREEITE B4 S LANXLREEH E v » RiEHEE B4E AKX Ao £ Bbt
FITH o

11.4.1 % DMX # &
03 5] ‘System’ £ 4L X 0 £3F[DMX Settings] % & o # A 5 3 87 7T A 6 DMX 43k ¥ & 7
R(EAMERTAEBI4EH£G DMX £ 8) £ 23K 12 AT ¢ DMX #5 ik & %0 (32 4 6 P77~
Al
FNDMX & T AK LB R ZEBEM—AREANEE » £ F—A DMX #ir B &89 % B3] 694
B &AL E Y o
HEEMENSDMX B & T o HEHIA B E LT RKINZE DMX i & 14 £33 4 6
E& A-D @/~ XLR 3§ )& o

DMX Settings ==X

R P T AR 47 Sk kazsd f o R B K E > SR A A5 kdzdddeta Bl R G T A K B 5 BB
W& Loflde g Bow > DMX fir i & 84241 6 69 F @ w A~ XLR 4y 846 & L & & ‘ExpertDMX’
5| &9 48 5 B iz 4 o
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Art-Met

Broadcast:Universe 1

ZE

iR L 3

k38 kg bt

LR DMX S hXE - A RELOHK(REARRALT) AR L HERA SR
DMX 4y ih % »

JKDMX 4y b M — AR E > Ad X4 o wREAMBMBER LA AGEE > A HMRAE

D Outpat A (ExpertDim)

11.5 ¢ £ (Curves)

AARBET AR BERAME o Do —HARFORE > KA ERRREAFRE > AR
H o & A R o

255

Output

Li

Input

20h

Output

Rel

lay off > 50%

255

Input

T

2]

Iutput

Always on

255

Output

Inpuk

Square

255

Input

255

255

Output

2A M) Az 4

AN Mt g

==

elay on > 50%

255

Output

Input 255

Logarithmic

Inpt 255

FIPRI (BIF) YRS P
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255 255)
Output Lineawl"imens DOutput Alt Linear
1] 1]
i} Input 255 a InpLt 255
205 255
Output S-Clirve 2 Dutput Cubic 1
0 1]
i] Inpuk 255 0 Input 255
255 255)
Output Triangle Output Bounce
[u] a
i} Imput 255 a InpLt 255
205
Output 80% Li
0
1] Inpuk 2558

255]
Olutput S-Glrve 1
1]
Input 255
255
Olutput Cukjc 2
[u]
Inpt 255
265
Output 90% ldinear
o
Input 2558
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11. Personality Builder %1 & 4 %, & Hei& X745 &

ABEAEREBRR AN L APRELRALECNITE

ST L

A5 o £ “File” AR X #33F “New” 3 .

1. ##FEFMEHK AL “Fixture 17 -
2. AHMHERETAE NI AR
a. “Manufacturer” #y X\ 4T B 5%
b. “Name” 4y A 471 B 4 AR
c. “Display Name” # Az 4 & &

SITRLAR(R L MRRKFEA
10 MF4)

RE A RELAR WwREH
kT LS g AR Rl L AR 0 26
e 3% “patch” 47 £ B & i 3
ER—SMEERA -

Fhpzic zl

Personality Builder - Avo 1200 Wazh *
File Edit

Yiew Tools Help

=lojx|

Athibukes

Madzz
; M acos
g Paktes

Attributes Functbns| Crcctcd.d\ttlbulcsl Currznt Functions  Histoy IHodcsI e 4 I 4
Created § Edted g Checked
Tested
e
V- A
Bl Fisture
Dizplay Hame [5] 1200 Wash
t anufacturs Avo
Mame 1200 Wash
MName

Name of thiz fuire

¥R R

Properties | DWValuesl Charn:lsl \'-fhsclhllapp'rgl Lucdc\"alucsl

Ak
A BATT AT A IT Bt

1. SHuE & F 4% B 1 Attributes’ 5
Ao A BMHEHINEAARIUTE G4
By Vs o

2. WEMRE R B HIE L HmE B
P Attributes’ i B A (k42 /8 146 2] 2R
HA)-

3. WMEHF/NBIEE B R KRNI F kR
‘Attributes’ il B 1 &4 AR 0 Rk
HhME B A& T AF R K9 9F % ‘Maximum
Resolution’ JAF 4% 3% £ 2% 598 X %
A o

Personality Builder - Avo 1200 Wash ™

Fle Edt Wiew Tocls Hep

B 7§ 1200 Wash
& History

[ Manual

Physzic:l
LS N rmer

B4 Modes

b Macroz
& Palattsg

I [m .5

Atiibutes | Functiors | Crested Atrbutes | Cuerert Functoes | History | bodes | b <[ ¥
4 Genenc 4 Reszrved nDin’mcr -
i, Pan o Tik B8 Shutter @
0 Cotonr J Calaur 1 J Colowr 2
€ Gebo & GoboRot & Giabe
€5 Gebo 1 Rat & Goba2 & Gobo 2Rt
<o iz % Focuz b Frost
o8 Zoom 4 Pram o Piern Rt
o Effact 2 Eflest Rt + Speed
+ PT Speed 4 Cariral BCpan
I Magenta [ W Yellow | WR=d
Qoo WOl BTN ﬂ
= Attribute Propertes
Attribute Gioup Intensity
Attribute 1D Dimmer
Desciption
M asirurn Rezolution g Bif =1
‘wheel Mame Dimmer
E Diamond 4 Wheel M appng
Altribute B ank Intensity
D4 wheel
Wheel Page Page 1

M aximum Rezolution

Sets the selected attibute ta Maone, 8 bit [1 DM channel] or 16 bit[2 DM channels).

Praperties | DM Valu&cl Ehanr'elsl Whes| Mappingl Locate\u’aluesl
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7 B PR 89 T AR

1.

WA A A8 VLIS AR 2 69 R 0 KB TR R 43k
e IE B FAEAE A -

S R T A 8 ) REAR SAL A e 0 AR T 2Ak & DMX
1 o 3545 M B A& R0 69 ‘DMX Values' 1z 2 K %
N R R F (T A K TR £ i
‘View’=>‘DMX Values’) -

BB C S I 645 R A 0 LA R AR R4
M ‘Properties’ iz 2 (3, 7T /& 3k T ¥ % #£4%
‘View’->‘Properties’) -

AR AR PT R A 69 B P AT B AR B A 1% ) e e s
T B DMX 12 & -

Personality Builder - Avo 1200 Wash *
File Edt Wew Tools Help

B

S 1200 ash
g Histors

2] Marual
A Prpsical
0B nibutes

=101

Atvibutes Functions | Crested Atrbeics | Cunnt Fursions | Histor | Modes | Mt | »]
Irkonsity ] PandTill | Cobw | Gobo | Beam | Efiect | Spesial|
Fraw DM 5, Raw DML TEb Sy Bt Chmmer
160 Dromer 4, Doen iy Closed
Stiobe Hz Fange 4 Stobe % Aange 4 Pulss Aarge
Upen Fuiss Fiznge 4 Dlove Pulse Range 4 R ardom Strobe Fange

Geneic Perentage Range

B Attribute Properties

Abrbute Group Intensity
Alrbute D ‘Shutter
D escripion
Magimum Rezalubion B Eit
Whasl M ame Shutter

] Diamond 4 WheelMapping
Alirbue B ark, Intensity
D4 \Wheet Wheel 1
‘wheel Page Page 1

L

MasamumHesolution

Sets the celectad altnbuie to Mane, 8 bt (1 DM channel] ar 16 bit [2 DM channeks)

Properies DM><VaIues| Eharrets]%eelmawm anaev.alues|

Personality Builder - Avo 1200 Wash B = | O 5[
Eile Edit Yiew Tools Help
=1 1200Wazh
& Histow Stait ALDMR Valie [0 Pad text taline |
Marus! ErdAtDMAVAe [255
Physical
BB Attibutes I ssignOnevake  AumAssgn | ErdiomStn | StethomEne
- E8 Dimmer
B-E3 Shutter

1] Closed
2]0pen
¢ 3]Stobe %

T
|l Colowr
& Gobo
4 Contral
G f Modes
oo B Macras

&7 Palett=s

OO

| Start At DM | End &k DM | Wheel Display |
a El Cloged

10 19 Open
20 244 Strobe
265 Open

% B AL

B EREFBE  RITROSNT AR T ABRMELFLEE

HRAE DT REARERALMEE o BaF R Locate’ » AR iEFR
P 5 B 0%~Other & 42424A o

Delete

[1] & Modes
~ b Macros
e g? Palette
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R X
1. S E &+ #4542 X ‘Modes’ -

2. KB BT EEF— MR R g LB

# X ‘Modes’ 7] & F o

AR VME E ek T8 B A B —

BRI B T o

RAEFEEAFNRZYEX 4 DMX & #

1. ASMEHKTHRBFELIGES o

2. TP E A JRER 6997 18 ‘Channels’ iz & 5%,
3k TR E # 2k 3% View’ > ‘Channels’ -

3. BARANAT@AFHAAT DMX # i@ itk {2
AR 4,77 &£ ‘Channel Offs’ £ +F 4 45 DMX i i
&9 7 B o

— A
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